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Welcome to Caterease
Important Caterease Concepts

Single Source
Using a database software like Caterease is not like using Microsoft Word or Excel. If you want to edit a print,
you don't actually edit the print itself. Instead, you change the details of the event in Event Manager, and every
single print, report, and query that reference that party will be updated instantly!

Custom Event Prints
Don't pay too much attention to the titles of any event prints you see in your program. You have a Print
Designer that lets you create and modify custom event prints - deciding what goes on them and what titles
they will have. You can change a "contract" to a "proposal" or an "invoice" or even a back-of-house print
quickly and easily.

Custom Screen Displays
Virtually every screen in Caterease can be customized to suit your needs. You can remove fields, rearrange
fields, rename some existing fields, and even create your own user-defined fields.

Quick, Easy Data-Entry
Edit information on any screen in the program by simply typing and pressing your [Enter] or [Tab] key to move
from field to field. Most fields offer a custom quickpick list of options. You can modify these lists and either use
your mouse to choose from them or simply begin typing into the field and you will be scrolled to a match for
what you type.

Consistent Tools
The following buttons exist throughout the program to help you perform important functions:

Add Record
Use this button to add any record - an event, client, menu item, etc., - to the program.
Delete Record
Use this button to delete any record - an event, client, menu item, etc., - from the program.
Select
Use this button to select records - menu items, site locations, etc., - from a pre-existing list.
Show Details
Use this button to display the details of a particular record.
Quick Column Customizing
Use this button to choose which columns of details are shown in a detail grid.
View Conflicts
Use this button to view additional information (usually conflicts) about records listed in a grid.
Save Changes
Use this button to save the changes you have made to any record.
Cancel Changes
Use this button to cancel changes and revert a record back to its previously saved state.





Unit 1: Introducing Event Manager

In this section, you will learn:

Entering General Event Information
Searching for Existing Parties

Reviewing and Editing Sub-Event (Meal) Information
Selecting Event Menu Items from Default Menus





Unit 1: Introducing Event Manager

Entering General Event Information
Whether adding a new event or editing an existing one, the data-entry process is simple. The details below will
help you enter data in the Event display of Event Manager.

Filling Out General Event Information

1. Click the Event Manager button from the Main sidebar group.

2. On the Event Manager screen, click into the first field on the General tab or Miscellaneous tab.
Note: This screen can be completely redesigned to suit your needs and preferences.

3. Edit each field by following the guidelines below, pressing the [Enter] key to move from one field to
the next:

l For fields such as Party Name or guest number fields, simply click into each field and type.
Note: Your Guaranteed guest count might default to a certain percent of your Planned number, and
you can optionally make the Guaranteed number take priority if it is higher than the Actual. (These
are both settings you can modify on theManagers tab of your program's Global Settings.)

l For fields with associated drop-down quickpick lists (Sales Rep, Theme, Reference, Status, etc.), click
the down arrow at the right of each field, then choose an option from the list.
 As an alternative to clicking the down arrow, simply begin typing into a quickpick field. The quick-
pick list will automatically scroll to match what you type. For date fields, type a date or click the
down arrow at the right of the field to access the drop-down calendar.
Note: Date fields in the Caterease Professional version offer Smart Date Editing, allowing you to
type words such as "today," "tomorrow," "Monday," "EOM" (end of month), even "EOM+1," etc., dir-
ectly into the field. For financial fields (such as Cancellation Charge), simply type a dollar amount or
click the down arrow at the right of the field to access the drop-down calculator.
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Unit 1: Introducing Event Manager

l If you did not select a default contact person when you created the event, you can retrieve one
now by clicking the down arrow next to the Booking Contact or Site Contact field and then clicking

the Select Contact from File button .
Note: If the name you want is not available in this window, you can type it directly into your Event
Manager screen and then add it for future use to the list of contacts associated to the current

account by clicking the Add Contact to File button .

3. [Optional] Enter general notes pertaining to the event into the Notes text block at the bottom of the dis-
play.

4. [Optional] Add specific meal information (meal, venue, times) using the Sub-Event feature.
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Unit 1: Introducing Event Manager

Searching for Events
You can find existing events based on virtually any detail. A special locator tool lets you search specifically by
date, while the Event Finder tool lets you use basically any event detail or combination of details to locate the
party you need.

Searching by Event Date

For fast date searches (today, this month, etc.), follow these steps:

1. Click the Event Manager button on the Main sidebar to open the Event Manager.

2. Click the Go To button , located towards the upper right-hand side of your screen.
Result: A drop-down list of options appears.

3. Choose to go to the first event taking place today, this month, next month, last month, or next fiscal
quarter.

Searching by a Specific Date
Tip: Events in Event
Manager are sorted
by event date, and
you are placed on
the first record for
your chosen date.
Note: If you wish to
scroll forward
through the records
on that date, use the
navigation toolbar at
the top left of your
screen.

1. Next to the Go To button at the top of your Event Manager screen, click the
down arrow to the right of the current date field.
Result: A drop-down calendar opens.

2. Click the left-and-right arrows on the drop-down calendar to scroll backward or
forward one month, respectively, OR hold your left mouse button down on the
month's name and drag up or down to choose another month.

3. Click on a date to select it.
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Using the Event Finder
1. Click the Find button (binoculars), located in the Home ribbon tab at the top of your Caterease screen.

Result: The Event Finder window opens.

2. In the Search By Fields area, type the text you would like to search for.
Note: You may search by more than one field. Many fields, such as Status, Category, Theme, etc., have a
corresponding drop-down list to the right of the field.

3. In the Search Rules area, select the appropriate rule.
Note: Confirm that Ignore Case is selected if you want to ignore capitalization when you enter your
text.

l Starts With - The field you chose in the Search By Fields area starts with the words or letter you
typed.

l Exact Match - The field you chose in the Search By Fields area contains exactly the words you
typed (and nothing else).

l Anywhere in Field - The words or letters you typed appear anywhere in the field you chose in the
Search By Fields area.

l Sounds Like - The words or letters you typed match phonetically to the words in the field you chose
in the Search By Fields area.
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Unit 1: Introducing Event Manager

4. [Optional] Click the radio button next to And or Or, within the Multiple Field Operator section, if you
are searching by multiple search criteria.

5. [Optional] Click into the Include Prefixes checkbox and then type the prefix (A, An, The) into the fields
within the Search Prefixes section to include prefixes in your search.

6. Click the Find Records button, located at the bottom of the window.
Note: Confirm that Auto Complete Key Numbers is selected if searching by numeric fields, such as
Event #, to ensure the correct search format is in place.

7. [Optional] Click the Show Results/Hide Results button at the top right of the Finder to display a list
of all records your search has found thus far.
Note: Click once on a "found record" in the list to move to that account; double-click a record to move
to it AND close the Finder tool down.

8. [Optional] If you accidentally skip over the record you want, click the arrows on either side of the Find
Records button to move forward or backward.

9. Once your record is located, click Close.
Result: The Finder window closes and you are placed on the record you sought.
Note: Click the Clear Criteria button after you have run a search, to clear all results and begin again.
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Reviewing and Editing Sub-Event (Meal) Information
The Sub-Event display in Event Manager is where you enter and manage the specific "meal information" about
a party: its menu, venue, and times.

Editing Sub-Event Information

1. In Event Manager, click the Sub-Event button on the left-hand side of the window.

2. In the sub-event details area on the left side of the window, click into any field to edit.

3. [Optional] Click the Show Details button to open the sub-event in a separate pop-up window for
more detailed editing.

Retrieving Menu Items

1. Click the Select Menus button , located on the right-hand side of the Sub-Event display.

2. In the menu selection window that appears, click on any title in the left pane.

3. Retrieve menu items into the party by double-clicking individual items, dragging and dropping multiple
items, or by selecting items and then clicking the Select or OK button.
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Unit 2: Booking a New Event with the Event Wizard

In this section, you will learn:

Selecting a Client for the New Event
Entering Basic Event Details

Selecting Menu Items for the New Event
Emailing an Event Print





Unit 2: Booking a New Event with the EventWizard

Event Wizard, Step 1: Selecting a Client
When booking an event using the EventWizard, the first step is choosing or adding the customer. You can
quickly search through your existing customers by name, or use a Finder tool to search based on any client
detail. Or you can optionally add a brand-new client.

Searching for an Existing Client by Name

1. Click the Tools sidebar group, located on the left-hand side of your screen.

2. Click the Event Wizard button.
Result: The EventWizard tool opens on the Step 1: Select An Account & Contact window.

Note: You can also access the Event Wizard button from the upper left-hand corner of your
screen.

3. Click into the Search For tool at the top left of the window and begin typing the name of your desired
account.
Result: You are scrolled to a match as you type.
Note: You can use the Account Finder tool to search for clients by any detail, or choose to add a new cli-
ent.

4. [Optional] Select a default contact person for the new event from the drop-down list under the Client
name.
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Unit 2: Booking a New Event with the EventWizard

5. When finished, click Next at the bottom right of the Wizard tool to move to move to the next window,
Step 2 of your default Wizard, or click the down arrow to the right of the button to select from one of
your custom Wizards.

Using the Account Finder Tool

1. Click the Search Records button , located in the ribbon tab at the top of the Step 1: Select An
Account & Contact window.
Result: The Account Finder window opens.

2. In the Search By Fields area, type the text you would like to search for.
Note: You may search by more than one field. Many fields, such as Category, Reference, Description,
etc., have a corresponding drop-down list to the right of the field.

3. In the Search Rules area, select the appropriate rule.
Note: Confirm that Ignore Case is selected if you want to ignore capitalization when you enter your
text.

l Starts With - The field you chose in the Search By Fields area starts with the words or letter you
typed.
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Unit 2: Booking a New Event with the EventWizard

l Exact Match - The field you chose in the Search By Fields area contains exactly the words you
typed (and nothing else.)

l Anywhere in Field - The words or letters you typed appear anywhere in the field you chose in the
Search By Fields area.

l Sounds Like - The words or letters you typed match phonetically to the words in the field you chose
in the Search By Fields area.

4. [Optional] Click the radio button next to And or Or, within the Multiple Field Operator section, if you
are searching by multiple search criteria.

5. [Optional] Click into the Include Prefixes checkbox and then type the prefix (A, An, The) into the fields
within the Search Prefixes section to include prefixes in your search.

6. Click the Find Records button, located at the bottom left-hand side of the window.

7. [Optional] Click the Show Results/Hide Results button at the top right of the Account Finder win-
dow to display a list of all records your search has found thus far.
Note: Click once on a "found record" in the list to move to that account; double-click a record to move
to it AND close the Finder tool down.

8. [Optional] If you accidentally skip over the record you want, click the arrows on either side of the Find
Records button to move forward or backward.

9. Once your record is located, click Close.
Result: The Finder window closes, and you are positioned on the record you sought.

10. [Optional] Click the expand button to the left of the Client name and select a default contact person for
the new event.

Tip: Click the Auto
Expand Contacts
button, located in
the toolbar at the top
of the Select An
Account window, to
automatically display
the account's con-
tacts.

11. Click Next at the bottom right of the Wizard tool to move to move to the next
window, Step 2 of your default Wizard, or click the down arrow to the right of
the button to select from one of your custom Wizards.

Adding A New Account for the New Event (Optional)

1. Click the Add New Account button , located in the ribbon tab at the top of
the Step 1: Select An Account & Contact window.
Result: A confirmation prompt appears.

2. Click Yes to confirm.
Result: The Account Details window opens.
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Unit 2: Booking a New Event with the EventWizard

3. Enter a name into the Client/Organization field, and press your [Enter] key.
Result: Your cursor moves to the next field.

4. Fill in additional account information as desired by typing into each field and pressing [Enter] to move
from field to field.
Note: Information on theMiscellaneous tab ("Category," "Reference," etc.), can be used to track this
customer.

5. [Optional] Click the Add A New Contact button , located at the middle right of the window, to add
a new contact person for your new client.

6. When finished entering details for the new client, click OK at the bottom of the Account Details win-
dow.
Result: You are taken back to the account selection screen, with the new account you added high-
lighted.

7. Click Next at the bottom right of the Wizard tool to move to move to the next window, Step 2 of your
default Wizard, or click the down arrow to the right of the button to select from one of your custom
Wizards.
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Unit 2: Booking a New Event with the EventWizard

Event Wizard, Step 2: Entering Event Details
The second step of the EventWizard has you filling out the basic details of your new event. This entire window
can be customized to suit your preferences, with fields being added, removed, or rearranged. You can even
create multiple custom Wizards for each type of event you book at your company.

Entering General Details

1. Enter Event and Sub-Event details into simple text fields such as Party Name, guest fields, etc., by
simply typing into the fields as desired.
Note: The Party Name can be set to default as the name of the client, and the Guaranteed guest field can
be set to default to a certain percentage of the Planned number (see "Managers Tab" under Editing
Global Settings).

2. Click the down arrow to the right of various fields to use available drop-down lists ("quickpicks"), when
applicable.
Note: You can customize quickpick lists to suit your needs, and optionally assign default values for
these fields.

3. Enter an event date by either typing into the Date field or by accessing the drop-down calendar to
make a selection.
Note: Professional version users can enter words such as "Tomorrow," "Monday," or even "EOM" ("End
of Month") or "EOM+1" in lieu of dates.
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Unit 2: Booking a New Event with the EventWizard

4. Enter times for the new event either by typing directly into the Start and End time fields, or by clicking
the Time Wizard button and dragging and dropping times into position.
Note: Time field names can be customized in your program's Global Settings.

Important Note: Setup and Tear Down time fields are entered as hours and minutes, not as actual
times. The total time of a party will be calculated as its "Start" time minus any "Setup," untill its "End"
time plus any "Tear Down."

5. [Optional] For on-premise parties, select a Setup Style and Room for the event by clicking the down
arrow to the right of each field and choosing an option.
Note: The list of Banquet Rooms will show the maximum guest capacity for each room based on your
chosen setup style. Any room highlighted in red does not use the selected setup style. As an option, click
the Room Selection button to the right of the Room field to have Caterease determine the best room
for the event. (Available with the Banquet Rooms add-in module.)

Tip: The time and
banquet room
details you are
adding here are for
the first sub-event
(or meal) of your
new party. If the
party will have mul-
tiple sub-events,
you can create addi-
tional ones once the
Wizard bring you
into Event Manager.

6. [Optional] For off-premise parties, click the Site Location tab, located to the
right of the Sub-Event Information tab in the middle of the window, and enter
your site location details into the available fields, including Name, Address, etc.,
or click the Select Site Location button to select from your list of commonly
used locations.

Note: You can also click the Copy from Client button to select the client's
address as the site.

7. Enter site location directions by typing into the Directions text box, located in
the bottom pane, optionally formatting text by highlighting, clicking your right
mouse button, and choosing Font.
Note: You can insert images or current date and time by right-clicking within a
text box and choosing Insert.

8. When finished, click OK.
Result: Your new event is created and opened in Event Manager, and you are prompted to move on to
selecting menu items.
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Unit 2: Booking a New Event with the EventWizard

Event Wizard, Step 3: Entering Menu Details
Once you have entered basic event information into the EventWizard, Caterease creates your new event and
opens it in Event Manager. It then asks if you'd like to select menu items for the party. The steps below walk
you through the menu-selection process.

Selecting Menu Items for the New Event

1. After completing Step 2 of the EventWizard, click Yes on the informational message which prompts
you to select your menu items for your new event.
Result: The Select Menu Items For Current Event window opens.

Note: If the message is no longer visible, click the Select Menus button , located on the right-hand
side of the Sub-Event display, on the Food/Service tab.

2. Click on a menu title in the left pane of the Select Menu Items For Current Event window.
Result: Items in the selected menu are displayed in the main (right-hand) pane of the window.

3. Highlight the food/service items you want to add to your event, and retrieve them in one of the fol-
lowing ways:

l Double-click on a single item in the Select Menu Items For Current Event window.
Result: The selected item is inserted at the bottom of your event's Food/Service grid, and the Select
Menu Items For Current Event window remains open.

l Hold your mouse button down on one individual item (without moving) and drag that item from the
Select Menu Items For Current Event window onto your Food/Service grid.
Result: The selected item is inserted at the bottom of your event's Food/Service grid, and the Select
Menu Items For Current Event window remains open.
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Unit 2: Booking a New Event with the EventWizard

l Hold your left mouse button down on a group of selected items and drag and drop them onto the
Food/Service grid.
Result: The selected items are inserted at the bottom of your event's Food/Service grid, and the
Select Menu Items For Current Event window remains open.
Note: Select a group of items by dragging your mouse over them or by holding the [Shift] or [Ctrl]
key down on your keyboard as you click.

l Click the Select button at the top left of the Select Menu Items For Current Event window.
Result: Any highlighted menu items are inserted at the bottom of your event's Food/Service grid,
and the Select Menu Items For Current Event window remains open.

l Click OK.
Result: Any highlighted menu items are inserted at the bottom of your event's Food/Service grid,
and the Select Menu Items For Current Event window closes.

l Click the Insert Mode button to retrieve menu items in specific positions on the Food/Service
grid of your event.
Result: Once clicked, the feature is enabled, and all subsequently selected menu items are auto-
matically placed above the currently highlighted item on the Food/Service grid (rather than always
at the bottom); when dragging and dropping, Insert Mode allows items to be dropped anywhere at
all on the Food/Service grid.
Note: Items can also be dragged and dropped up and down in the menu on the event's Food/Ser-
vice grid, as well, regardless of the Insert Mode feature. Insert Mode can be enabled as a default

by clicking it once and then clicking the Save Window Settings button .
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E-mailing an Event Print
You can quickly e-mail a print directly from any Print Preview screen.

Tip: E-mail from
Caterease is auto-
matically sent via
your regular e-mail
Outbox. Therefore,
all return cor-
respondence will be
sent to your normal
work e-mail
address.

E-mailing an Event Print

1. From an event in Event Manager, click the Home ribbon tab and then click the
bottom half of the Prints button.
Note: The Prints button is a split button. (Click the top half to select prints from
a floating window.)

2. Choose from among General, Event Contracts/Invoices, or Event Subprints.

3. Click on the name of the desired print.
Result: A Print Preview screen displays.

4. Click the Email button, located at the top of the Print Preview screen.
Result: Notice that the print is automatically attached as a PDF at the bottom of the e-mail window.
You can change the format of this attachment by clicking on it with your right mouse button and select-
ing Change Type To and choosing a different type.

5. The To field will automatically populate default e-mail addresses (although this feature can be disabled,
if desired).

6. [Optional] Enter additional e-mail addresses into the Cc and Bcc fields, separating each address by semi-
colons.
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7. Type a subject for the e-mail into the Subject field, or click the down arrow at the right of the field to
access the customizable quickpick list.
Note: This quickpick is customized in Setup > Quickpicks > General > Email Subject.

8. Click into the large white text box of the e-mail window and type the body of your e-mail, or optionally
insert a custom merge letter.

9. [Optional] Format the body of the e-mail by using the formatting tools at the top of your screen. Altern-
atively, highlight any text within the body of the e-mail, click your right mouse button, and choose Font.

10. When finished, click the Send button, located at the top left-hand side of the window, to send the e-
mail.
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In this section, you will learn:

Viewing Events in the Scheduler
Grouping the Scheduler by Sales Rep, Etc.

Filtering the Event Scheduler
Using the Calendar Grid

Adding a Note to the Calendar
Viewing Events in a Venue Graph

Adding a New Event from the Scheduler
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Using the Scheduler
The Scheduler is your calendar of events in Caterease. You can view events in a day-at-a-glance, week-at-a-
glance, month-at-a-glance, or even year-at-a-glance format, and you can even group events onto separate cal-
endars based on details such as Sales Rep, Business Type, Theme, etc.

Viewing Events in the Scheduler

1. Click the Main sidebar group on the left-hand side of your Caterease screen (if it is not already selec-
ted).

2. Click the Scheduler button.
Result: The Scheduler window opens.

3. Click the Day,Week,Month, or Year button at the top left of the Scheduler window to switch among
those views.
Note: When you switch to Year view, the Scheduler places you on January 1 of the current year (as a
default). To avoid confusion, you may want to click on the current date in the Scheduler before switch-
ing to another view.

4. [Optional] Adjust various options available at the top of the Scheduler in each View, according to the
list below:

Day View Options

Field Description
Show As >
Day View

This is the default view, and shows events in bars vertically down the screen with times
of day along the left side.

Show As >
Time View

This view shows events in bars horizontally across the screen with times across the top.

Options The choices here vary, depending on whether you are showing Day View or Time View
(above):
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Field Description

Day View Options:

l Time Ruler Minutes
Alternatively shows or removes any time increments along the left side of the cal-
endar other than the hour. (See "Time Unit," below.)

l Day Header
Alternatively shows or removes the header showing day and date above the
event information on the Scheduler.

l Work Times Only
Toggles between showing all times of day or only the hours designated as your
work time.

Time View Options:

l Work Times Only
View only your established Work Times.

l Show Event Detail
Alternatively shows or hides the details of each event in the horizontal bars on
the screen.

Time Unit Choose a time increment for this view from the options listed, or use the "Time Zoom In"
and "Time Zoom Out" buttons to the right.

Week View Options

Field Description
Show As >
Full Week

This is the default view, and shows events in a standard week layout, with six boxes, one of
which combines the two weekend days.

Show As >
Work
Week

This view shows whatever days you have designated as your "work week" as columns
across the screen - with events displayed vertically down the screen and times along the
left side.

Options The choices here vary, depending on whether you are showing Full Week or Work Week
view (above):

Full Week View Options:

l Single Column Display
Switches between showing the six day "boxes," described above, in one column or
in two.

l Hide Weekend
Alternatively hides or shows the weekend days in the calendar.

l Show Time As Clock
Alternatively hides or shows the small clock icons indicating Start and End times to
the left of each event.

Work Week Options:

l Time Ruler Minutes
Alternatively shows or removes any time increments along the left side of the cal-
endar other than the hour. (See "Time Unit," below.)

l Day Header
Alternatively shows or removes the header showing day and date above the event
information on the Scheduler.
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Field Description
l Work Times Only
Toggles between showing all times of day or only the hours designated as your work
time.

Time Unit Choose a time increment for this view from the options listed, or use the "Time Zoom In" and
"Time Zoom Out" buttons to the right.

Month View Options

Field Description
Options > Compress
Weekends

Optionally combines Saturdays and Sundays into one box and column in the
calendar display.

Options > Hide Week-
end

Alternatively hides or shows the weekend days in the calendar.

Options > Show Time
As Clock

Alternatively hides or shows the small clock icons indicating Start and End
times to the left of each event.

Year View Option

Field Description
Options > Event
Counts Only

Toggles between showing a number in each date, indicating the number of events,
or showing actual event details in each date.
Note: Since "Year" view shows 365 days, it may be difficult to see many event
details on smaller monitor displays.

5. [Optional] Click into the checkbox labeled Holidays (right-hand side of the Scheduler) to show holidays
on the calendar.

6. [Optional] Retrieve an event into Event Manager for editing or review by double-clicking or by right-
clicking and choosing Select.
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Creating Separate Calendars for Sales Reps, Business
Types, Etc.

1. With your Scheduler open, click the down arrow to the right of Group By in the Home ribbon tab at the
top of your screen.

2. Choose Sales Rep or other option to group events by.
Result: Your calendar is separated into groups based on the detail you've chosen.
Note: The name of each group is shown at the top of each calendar.

3. [Optional] Click the Day,Week,Month, or Year button at the top left of the Scheduler window to
change the view for your calendars.

4. [Optional] Click the small plus or minus sign button at the bottom left of the window to see more or
fewer groups, respectively.
Note: Not available in Year view.

5. [Optional] Click the Active Group button in the Home ribbon tab at the top of your screen, and use the
list to toggle among your various separate calendars.
Note: Not available in Year view.
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Creating Filters in the Scheduler
You are able to set as many custom filter options as you want (Standard and Professional Versions), allowing
you to select only the view of data that you desire when the Scheduler first loads.

1. Access your Scheduler (Main sidebar > Scheduler).

2. Click the Filters button, located on the upper left-hand side of your screen, > Show Current Filter to
view your current filter status.

3. Edit your filter by clicking the Customize button, located on the bottom right-hand side of Custom Fil-
ters window.

4. Click OK to run the filter.
Result: The Scheduler instantly updates, and the current filter displays on the bottom left-hand side of
the Scheduler window.

5. To add the new filter as a saved filter, click the Filters button, located at the top left-hand side of your
Scheduler window.

6. Click Customize.
Result: The Custom Filters window opens.

7. Click the Add Filter button to add a new filter.
Result: A new line, titled "New Filter," is added to the bottom of the list.
Note: If you want to share the filter with other users in your network, click the Shared button, located
at the bottom of the Custom Filters window.

8. Type the filter name into the field provided, and then click the Save Current Filter button to save
the filter.
Result: From this point on, the newly created filter will be visible in the Filters drop-down list, accessed
in Step 2, above.
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Tip: Click the Save
Current Window
Settings button to
save an active filter
as your default view
when you first open
your Scheduler.
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Using the Calendar Grid
The detail grid located at the bottom of the Scheduler window lists details of all events on any day or group of
days highlighted in the calendar. In the Event display, the grid lets you choose details to review about events,
and then a secondary grid allows you to see specific sub-event details. In the Sub-Event display, the main grid
defaults to reflect sub-event information.

Note: The grid should be visible at the bottom of the Scheduler, by default. If it is not, hover your mouse along

the bottom frame of the Scheduler to view the thin expansion tool .
Click the expansion tool to open the grid area, or drag the tool and frame edge to stretch the grid area out.

Viewing and Customizing the Detail Grid
Tip: Details in this
grid can be sorted,
grouped, printed,
and exported.

1. Open the Scheduler in the Event or Sub-Event Display.
Note: Click the Display button in the Home ribbon tab to switch among dis-
plays.

2. Click on a day in the calendar to select it, or hold your mouse cursor down and
drag over several days.
Results: Details of events on that day are displayed in the grid at the bottom of the Scheduler.

3. [Optional] Click the expand button to the left of any event in the grid to display a secondary grid con-
taining sub-event details for that event.

4. Choose columns to display by clicking the Quick Column Customizing button at the top left of the grid
(or secondary grid) and clicking into the checkbox of any field.
Result: Details with checks will appear in the grid.

5. [Optional] Click on any column heading to sort records in the grid by that detail in ascending order;
click again to sort in descending order.

6. [Optional] Color-code the grid as desired by right-clicking within the grid, choosing Color Grid By, and
selecting an option.

7. Click the Save Window Settings button at the top right of the Scheduler window to save the
changes you've made for future use.
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Adding a "Note" to a Calendar Date
You can create a "note," attached to any date on your Caterease calendar (Scheduler), to hold a date or oth-
erwise indicate important information that needs to be shared.

Creating a Calendar Note

1. From the Scheduler (Main sidebar > Scheduler), click into the Notes checkbox, located along the right-
hand side of the window, if it is not already selected.
Note: To have this option remain selected by default on your personal Scheduler, click the Save Win-

dow Settings button at the top right of the window. To make these the default settings for all
Caterease users on your network, click the Settings button, located in the Home ribbon tab at the top of
your screen, and choose Shared > Save > Current Window.

2. Click your right mouse button into a date on the calendar where you would like your note to appear.

3. Choose New Note.
Result: The Scheduler Notes window opens.

4. Type a caption for your new note into the Caption field, or choose one from your custom quickpick list .

5. [Optional] Change the Start Time or End Time of the note, if desired, by clicking the up-and-down
arrows to adjust the time or by typing directly into the fields.
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6. [Optional] Assign a category to the new note, for future tracking, by clicking the down arrow to the
right of the Category field and selecting a quickpick item (or you may type directly into the field).

7. [Optional] Change the user name for the note by clicking the down arrow to the right of the User field
and selecting an option.
Note: This indicates the user who created the note. Notes will be visible to all users who have the Notes
checkbox selected (Step 1, above).

8. Click into the Notes text box and type details of your note, using the formatting tools above the box to
change font style, size, color, or to make the text bold, italic, or underlined.

9. [Optional] Click the down arrow next to the color icon to choose a different color for your
note.
Note: You can also click theMore Colors button to create a custom color.

10. When finished, click OK.

Tip: Note Caption
quickpicks are estab-
lished here: Setup
> Quickpicks >
Scheduler > Note
Caption. Note Cat-
egory Quickpicks are
established here:
Setup> Quick-
picks > Scheduler
> Note Category.
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Using a Venue Graph
The Scheduler tool allows you to view your various parties in a graph format, grouped by banquet room, site
location, or a variety of other details. You are even able to edit the parties by dragging and dropping from one
group to another, stretching or shrinking start/end times, setting display fields, etc.

Viewing Events Graphed by Room, Site Location, Etc.
Tip: You can drag
and drop event bars
from one "room" (or
"site name," etc.), to
another - or hold
your left mouse but-
ton down on the top
or bottom edge and
stretch and shrink
bars to change start
and end times. You
can even hold your
[Ctrl] key down on
your keyboard and
select multiple dates
to view sim-
ultaneously, then
drag and drop
parties from one
date to another.
These changes
affect events every-
where throughout
the program, and
can be "disallowed"
for all users through
Advanced Settings.

1. With your Scheduler open, click the Home ribbon tab at the top of your screen
(if not already selected).

2. Click Display > Sub-Events.
Result: The Scheduler changes to Sub-Event view, which (by default) is dis-
played as a rooms graph for the current day (columns with room names across
the top and times down the left).
Note: In this Day View display, you can choose Show As > Time View to show
bars horizontally across the page, rather than vertically.

3. [Optional] Click the down arrow next to Group By, in the Home ribbon tab at the top of your screen,
and choose Site Name, Business Type,or a detail other than Room to group your events.

4. [Optional] Change the view of this calendar toWeek or Month view by clicking the respective buttons
at the top left of the window.

5. [Optional] Click the small plus or minus sign button at the bottom left of the Scheduler window to see
more or fewer groups (rooms, etc.), respectively.
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Adding an Event From the Scheduler
1. With your Scheduler open, group your Sub-Events calendar as described in "Viewing Events Graphed

by Room, Site Location, Etc.," above.

2. Find a specific time and date that you would like to hold your new event.

3. In the appropriate group for your new event, hold your left mouse button down on the Scheduler
screen at the time you want your new event to start.

4. Drag your left mouse button down until you reach your desired end time, and then release your mouse
button.

5. Click your right mouse button and choose New Event.
Result: A confirmation message appears.

6. Click Yes.
Result: The EventWizard opens, on Step 1.

7. Select a customer for your new event in Step 1 of the EventWizard.

8. Click Next at the bottom right of the EventWizard to move to the default Step 2 of the EventWizard, or
click the down arrow to the right of the Next button and choose an alternative Wizard for this party.
Result: Step 2: Select Event Fields opens, with information you highlighted (date, optional times and/or
venue), filled in by default.

9. Continue to fill out other details in the Wizard as desired.
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In this section, you will learn:

Adding a Custom Menu Item to an Event
Retrieving Menu Item Packages

Modifying Menu Item Descriptions
Including Menu Item Modifications on Prints

Separating Menu Items Based on Type
Using the Quick Item Insert Feature

Incrementally Searching for Menu Items
Managing Event Required Items
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Adding a CustomMenu Item to an Event
1. Confirm the Food/Service tab is currently selected at the bottom of your Sub-Event display in Event

Manager.

2. Click the Add A New Food/Service Item button , located on the right-hand side of the Food/Ser-
vice tab.
Result: A blank line is added to the bottom of your Food/Service grid.

Note: As an alternative, you can click the Insert a New Food/Service Item button at the right-
hand side of the Food/Service tab to insert a new blank line ABOVE the menu item currently selected in
the grid.

3. Click into the Item Name column and type a name for the new menu item.

4. Press your [Tab] or [Enter] key.
Result: Your information is stored and your cursor moves to the next column, the Price column.

5. Type a price for the item, and press [Tab] or [Enter].
Result: Your cursor moves to the next column, theQty column.
Note: Rather than typing a price, you can click the down arrow at the right of the Price column to
access the drop-down calculator.

6. Type, into the Qty field, the appropriate quantity for the menu item.
Note: A drop-down calculator is available for this field, as well.
Note: If, when you clicked the Add A New Food/Service Item button in Step 2, above, you had a menu
item highlighted whose quantity was linked to the party's guest count, your new item will default to
being linked as well. Right-click on the item and choose Special Editing > Link/Unlink Qty to Guest
Count to unlink it.

7. Click into the column with the small image on the far right-hand side of the grid, and click the down
arrow to choose the appropriate Type for the new item.
Note: The Item Type of new items defaults to the Item Type of whatever item was highlighted when you
clicked the Add Record button in Step 2, above. "Item Type" is from a hard-coded list; however, "Cat-
egory" is a custom list that can be used to further classify items.

8. [Optional] Hold your left mouse button down on the new item you have added and drag it up or down
into a different position in the list.
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Note: You cannot drag and drop an item if the Food/Service column has been sorted; you will be
prompted to clear column sorting.

9. [Optional] Create a detailed "Description" for the new item as described under "Modifying an Item's
Default Description, Instructions, Label, and Other Details," below.
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Retrieving Menu Item Packages
Tip: Clicking your
right mouse button
on the Select Menu
window gives you
the options of
Select All Records
and Clear Selected
Records. If Menu
Packaging is enabled
on the menu selec-
tion screen, and if
your cursor is on a
top-level menu item
(i.e., not the sub-
items included in a
menu package),
then Select All
Records will high-
light all top-level
items and also any
related sub-items. If
Menu Packaging is
not enabled, only the
top-level items (and
not the sub-items)
will be selected. Like-
wise, if you have a
sub-item in a menu
package high-
lighted, the Select
All Records option
will highlight all
sub-items in that
package only,
regardless of
whether or not Menu
Packaging is enabled
on the menu selec-
tion screen.

1. From the Sub-Event display, Food/Service grid in Event Manager, click the Dis-

play Menus button , located on the right-hand side of the window.
Result: The Select Menu Items For Current Event window opens.

2. Select a menu title on the left-hand side of the Select Menu Items For Current
Event window.
Result: The items on that menu are listed in the right pane of the Select Menu
Items For Current Event window.
Note: Menu packages are indicated by an expand button to the left of the item
name, and can be set up in Menu Manager. You can click this expand button
to view "sub-items" within the package.

3. Click the Menu Packaging button , found at the top of the Select Menu
Items For Current Event window.
Note: This button is a toggle; click it again and the feature is disabled.

4. [Optional] Click the expand button to the left of the menu package item to review sub-items, and hold
your [Ctrl] key down and click any sub-items to de-select them.
Result: The sub-items you click are no longer highlighted, and thus will not be retrieved into the event.
Note: If you click on a sub-item without holding your[Ctrl]key down, it will become the only highlighted
sub-item in that package.

5. Double-click any menu package item (indicated by the presence of an expand button to the left of an
item name) to select it.
Result:The item and all of its sub-items are deposited on your event's Food/Service tab. Prices, costs,
and other details are only retrieved for each "sub-item" if the package is set up that way in your default
menus.
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Note: You can also drag and drop multiple menu package items, use the Select Items or OK buttons,
and any other selection technique described in the topic above.
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Modifying an Item's Default Description, Instructions,
or Other Details

Tip: If you're not
happy with your
modifications and
want to change your
edits back to the
menu item's default,
right-click inside the
text block and
choose Reset.

1. Select any menu item on the Food/Service tab.

2. Click either the Description, Instructions, Label, Notes, or Modifications tabs.
Result: The selected tab is displayed.

3. Click into the text box and start typing, or press your [Backspace] key to edit.
Result:  The background of the text block changes to white, and the text will reflect your changes.
Note: You can also click your right mouse button in the text box and selectModify. See the topic below
about noting modifications to kitchen and other staff.

Tip: Click theModi-
fications tab and
make a note of the
changes you've
made to pass along
to your staff on a
back-of-house print.
Note: See topic
below about includ-
ing this detail on a
print.

4. Format text by highlighting and using the Basic Text Editing tools .
Note: The Format toolbar will not be enabled unless you have begun editing
the text as described in Step 3, above.

5. Click on the Picture tab to optionally add or modify a digital image of your
menu item.
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Including ItemModifications on Prints
Tip: Menu Item Modi-
fications can be
included in Mar-
keting Tools merge
documents, as well,
using the Food/Ser-
vice Merge Table
option.

1. Click the Setup sidebar group on the left-hand side of your Caterease screen.

2. Click the Print Designer button.
Result: The Print Designer window opens.

3. On the left-hand side of the window, click the title of the print you want to add
item Modifications to.

4. In the Food/Service Items section of the print, click the down arrow next to Format.
Result: A drop-down list of options appears.

5. Click into the checkbox next toModifications.
Note: Any option with a check in the box will appear on the print.

6. When finished, close Print Designer and save your changes.
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Separating Event Menu Items Based on Type
Tip: Item types are
set in Admin-
istration > Gen-
eral >
Food/Service
Item Types. Here
you are able to add
one additional Item
Type to the seven
existing Item Types.

1. Click the Settings button from the Food/Service tab and select Show Item Type
Tabs.
Result: A series of tabs, one for each established item type, displays at the top of
the window (although you may change the alignment to bottom, right, or left).
Note: If you retrieve additional items into the event, you will be automatically
placed on the All Items tab that lists all items for the event.

2. [Optional] From the All Items view (the default view) click on the Food Items

tab to view types that have been designated Food.

3. [Optional] Click on the other item tabs (Beverage Items; Liquor Items; Equipment Items; Labor Items;
Room Items; Other Items) to filter each item separately.

- 57 -



Unit 4: Advanced Menu Management

Using the Quick Item Insert Feature (Professional Version)

Tip: This feature is
available on Menu
Items, Recipe, and
Required Items
areas of Menu Man-
ager (as well as here
in Event Manager),
on the Food/Service
tab and the New
Food/Service win-
dow.

1. Click on the bottom item in the grid on the event's Food/Service tab.

2. Press the [Down Arrow] key on your keyboard.
Result: A new blank line is added to the Food/Service tab, and your cursor is
positioned in the Search Menu Items field.

3. Type an item name as desired.
Result:  A drop-down grid appears, scrolling to a match as you type.
Note: Enable the Quick Item Insert Feature in Global Settings > Managers tab
> Enable Quick Item Insert.

4. When you find your match, press the [Enter] key on your keyboard.
Result: The item and all of its details are retrieved into the event.
Note: If no match is found, type the name of the new item and its details ("Price," etc.) and it will be
added as a custom item to this event.

5. Enter a quantity for the item in the Qty column.

6. Edit other details as desired.
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Incrementally Searching Using the All Menus Search
Feature

1. On the Sub-Event display in Event Manager, click the Display Menus button , located at the right-
hand side of the Food/Service grid.
Result: The Select Menu Items window opens.

2. Click the down arrow to the right of the All Menus Search field to access a fully customizable Search
Menu Items selection window.
Note: All Menus Search is only available in Menu Tree mode; it is not available in the All Menus mode.

3. Begin typing the name of the item you would like to search for into the field, and you will be taken to all
highlighted menu items in the appropriate menu or sub-menu.

Note: This tool searches within each visible field, so you will want to click the Quick Column Cus-

tomizing button , located to the left of the Item Name field, to enable additional columns, if neces-
sary.

4. [Optional] Click the All Menus button to view your entire list of menu items.
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Viewing and Editing Item Usage When Building Event
Menus
Sometimes it is easier for your chef to simply make more of a menu item he is already making than to create a
whole new menu item from scratch. The Professional Version of Caterease lets you view how many of each
menu item have been ordered during the day(s) surrounding a particular party.

Viewing Menu Item Usage

1. Click the Sub-Event tab from an event in Event Manager.

2. Click the Select Menus button , located on the right-hand side of the window.
Result: The Select Menu Items For Current Event window opens, displaying your default menus and
default menu items.

3. Click the Settings button , located on the upper right-hand side of the window, and choose Show
Item Usage.
Result: The Usage column displays on the window, indicating the menu item usage in the day or days
surrounding this event.

4. [Optional] Click on a menu item in the grid, then click the Booked Menu Items button , located on
the right-hand side of the window.
Result: The Booked Menu Items window opens, where you can view which other parties are calling for
the selected item.
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5. [Optional] Click on a menu item in the grid, then click the Select button, located on the upper left-hand
side of the window, to go to the event.
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Establishing Usage Variance
1. Click the Setup sidebar and choose MenuManager.

2. From your Menu Manager main screen, click the Quick Column Customizing button to add the Usage
Var column to your grid.

Note: Click the Save Current Window Settings button if you would like to retain this column in
your default view.

3. Type the variance into the Usage Var field.
Note: To arrive at the Usage Variance number, look at the number of days either side of an event
(before or after) you would like to account for. For example, type the number 1 into the Usage Variance
field if you want to account for events one day before the current event's date and one day after the cur-
rent event's date. The Usage Variance field is used to calculate your Usage Date Range.Enter "0' if you
only want to track menu item usage on the specific day of the party.

Tip: An item's Usage
is the number of the
particular item that
was booked in any
active event (not
"Cancelled," and
with an "Included"
sub-event within
your established
Usage Date Range).

4. To create a Usage Variance for all items in the list, you can highlight all items,
right-click, and select Special Editing > Batch Processing.
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Using Item Hiding
Menu item hiding is basically a technique for you to pass notes to your kitchen or other back-of-house staff. For
example, imagine a customer requests “no garlic” on a particular menu item. In addition to removing garlic
from that item’s Description or Ingredients List, you may want to make an obvious note that the chef is sure to
see. However, that type of note would probably look tacky on a customer’s contract. So, you can create the
note as you want— perhaps big, bold letters that read NO GARLIC — and then hide it on one print and include
it on the other.

Establishing an Item as Hidden in an Event
Tip: You can estab-
lish menu items to
be hidden as a
default. For
example, you can
create a menu called
"Modifiers" and pop-
ulate it with such
instructions as "No
Onions," "Extra
gravy," etc., each of
which is hidden auto-
matically when you
pull it into an event.

1. Open an event in Event Manager.

2. Click the Sub-Event button to view the Sub-Event display.

3. Right-click the item on the Food/Service tab that you want to hide.
Result: A pop-up menu appears.

4. Select Special Editing > Hide/Unhide Item(s) in Prints.
Result: The item becomes italicized to indicate that it will be hidden on any
prints that allow item hiding (see "Setting Up a Print to Hide Items," above).

Setting Up a Print to Hide Items

1. On any print in your Print Designer, click into the checkbox labeled Allow Food/Service Item Hiding, loc-
ated midway down the print, on the right.
Result: Any menu item designated as “hidden” in an event will not appear on this print.
Note: To see the label of a checkbox, float your mouse pointer over it without clicking.
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2. Remove the check from the checkbox to have hidden items appear on the print.
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Managing Event Required Items
Caterease handles "required items" - serving utensils, equipment, etc., that is required to hold an event - in a
couple of different ways. First, you can attach these items (things such as chafing dishes, dinner plates, wet-
naps, claw crackers, etc.), to a menu item, so they are retrieved and even quantified automatically when that
menu item is selected for an event. In addition, you can select "event required items," which are things not
associated with any one specific menu item (for example, tables, tablecloths, etc.), using the steps outlined
below.

1. In Event Manager, click the Required Items button , located in the toolbar at the bottom of your
screen.
Result: The Required Items window opens, defaulting to Summary view.
Note: The Required Items button can also be accessed from your Toolsmenu.

2. Required Items that have been associated with a menu item in Menu Manager display in the Summary
view.

3. To add required items at the Event level, click the Details button.
Result: The Details view displays.

4. Click the Select Items button , located on the upper right-hand side of the Details view window.
Result: The Select Required Items window opens.
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5. [Optional] Click on a title in the left pane of the window to choose a specific list of ingredients or
required items.

6. [Optional] Click on a column heading in the grid (e.g., "Description") to sort items by that column, and
then type into the Search For field at the top of the window to find an item.

7. Retrieve items in any of the following ways:

l Double-click a single item to retrieve it.

l Drag your mouse over several items to select them all, or hold the [Shift] or [Ctrl] key down on
your keyboard as you click.

l Drag and drop highlighted items from the Select Items window into the list you are currently edit-
ing.

l Click the Drop Items button at the top left of the window to retrieve the currently highlighted item
(s) and leave the window open.

l Click the OK button at the bottom right of the window to retrieve the currently highlighted item(s)
and close the window.

8. Click into the Qty column for the new item(s) and enter the appropriate quantities.

9. [Optional] Click the Print button, located on the upper left-hand side of the window, to print the
Required Items List.
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In this section, you will learn:

Reviewing Event Manager Fields
Customizing Quickpick Lists

Renaming Fields
Creating User Defined Fields
Making Fields Required

Establishing NewBooking Defaults
Adding/Changing Contact People

Adding a Sub-Event (Meal)
Using the TimeWizard

Using theMapping Interface
Managing Multiple Events Simultaneously
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Reviewing Event Manager Fields
A multitude of fields are available to help you keep track of your events - and additional User-Defined Fields
can be made up by you. These fields exist in Event Manager on either the Event or Sub-Event display. Below is
a list:

Event Fields

Field Description
Party Name Used to identify an event; especially helpful when one client has multiple events.
Sales Rep Shows the sales representative responsible for the event.
Theme Allows you to track events by theme; (e.g. “Wedding Reception,” “Christmas Party,” “Sem-

inar”).
Reference Lets you track your company’s various marketing strategies; shows why the client booked

this event (how they heard of you).
Category Gives you an extra field for categorizing and tracking events; can be renamed to suit your

specific business needs.
Booking/Site
First

Identifies the first name of the booking and site contact people for the event; usually these
names are directly associated with the client, and can be selected instead of repetitively
typed.

Booking/Site
Last

Identifies the last name of the booking and site contact people for the event.

Booking/Site
Email

Identifies the booking/site contact's e-mail address.

Booking/Site
Tel

Identifies the booking/site contact's telephone number.

Coordinator Allows you to identify an event coordinator.
Primary Site
Name

Identifies the first active sub-event's Site Location.

Primary Room Identifies the first active sub-event's Room.
Event # Offers a unique identifier for the event; this number is automatically assigned by the pro-

gram.
Status Indicates the status of the event: Prospective, Definite, Tentative, Can-celled, or Closed.
Cancel
Type/Date

Lets you track why and when you lost business; available as sub-fields as the Status field.

Event Date Indicates the date on which this event will (or did) take place.
Booked/Revised
Date

Allows you to track the date on which this event was booked, and when it was last revised;
available as sub-fields of the Event Date field.

Guests Does not allow data-entry; displays the Actual guest count if one exists, and the Planned or
Guaranteed count if one does not.

Planned Indicates the number of guests the customer is planning for the event.
Actual Indicates the actual number of guests who attended (or will be attending) the event.
Guaranteed Indicates the minimum number of guests the customer is guaranteeing for the event; can

be an automatic percentage of the Planned guest count.
Business Type* Allows you to categorize events based on differing business models or if your company does

business as more than one enterprise.
Subtotal Identifies the subtotal for the entire event.
Gratuity Identifies the total gratuity for the entire event.
Service Charge Identifies the total service charge for the entire event.
Tax Identifies the total tax for the event.
Total Identifies the event total, including tax and service charge.
Cost Identifies the total cost (to you) of the event; includes cumulative costs of menu items, as

well as staffing and any miscellaneous cost adjustments.
Profit Identifies the total profit for an event.
Paid Identifies the total amount paid for an event.
Balance Identifies the currently outstanding balance for the event.
Total Markup Identifies the total markup of an event, automatically calculated by multiplying cost by a

markup rate you identify.
Operation* Allows you to separate events based on DBA's, or different businesses or locations you
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Field Description
might be running.

Pay Method* Identifies how the customer will pay (or paid) for the event.
Cancel Charge* Indicates the amount the customer will be charged if the event is cancelled.
Members/Non-
Mem-bers*

Used by private clubs to distinguish between guest types; can be renamed to suit your
needs (e.g. “Adults,” “Children”).

PO Number* Identifies a purchase order associated with the event.
Folio Number† Identifies a folio number associated with the event.
Closed† Lets you track a closed date for the event; optionally allows you to lock users out of closed

events.
User Defined
Fields†

Allows you to create any additional fields you want to suit the specific needs of your com-
pany.

* Displayed on Miscellaneous tab by default
† Not displayed by default

Sub-Event Fields

Field Description
Description Merges in the description of the event’s first sub-event; e.g., “Dinner Buffet,” “Meeting,”

“Break-fast,” etc.
Type Merges in the type of the event’s first sub-event, e.g., "On Premise," Off Premise," etc.
Time: Start Merges in the start time of the event’s first sub-event.
Time: End Merges in the end time of the event’s first sub-event.
Time: Delivery Merges in the delivery time of the event’s first sub-event.
Time: Serving Merges in the serving time of the event’s first sub-event. Note: You can rename this field in

Administration > General > Customize Names > Times.
Time: Bar Merges in the bar time of the event’s first sub-event. Note: You can rename this field in

Administration > General > Customize Names > Times
Time: Arrival Merges in the arrival time of the event’s first sub-event. Note: You can rename this field in

Administration > General > Customize Names > Times
Time: Depar-
ture

Merges in the departure time of the event’s first sub-event. Note: You can rename this field
in Administration > General > Customize Names > Times.

Time: NA These two fields represent two extra time fields that you can make up yourself. They will
each merge in the respective time information from the event’s first sub-event.

Time: Staff In Merges in the staff arrival time of the event's first sub-event. Note: You can rename this field
in Administration > General > Customize Names > Times.

Time: Setup Merges in the setup time of the event’s first sub-event. Note: This field, which displays as
Hours and Minutes (not as a time), is set up in Administration > New Booking Defaults >
Sub-Events.

Time: Tear
Down

Merges in the tear down time of the event’s first sub-event. Note: This field, which is set up
in Administration > New Booking Defaults > Sub-Events, displays as Hours and
Minutes, not as a time.

Date Merges in the date of the event’s first sub-event.
Room Merges in the name of the room of the event’s first sub-event.
Room Chg Merges in the room charge of the event’s first sub-event.
Room Cat-
egory

Merges in the room category of the event's first sub-event.

Setup Style Merges in the setup style of the event’s first sub-event.
Site Name Merges in the name of the off-premise site location of the event’s first sub-event.
Site Address Merges in the address of the off-premise site location of the event’s first sub-event.
Site City Merges in the city of the off-premise site location of the event’s first sub-event.
Site St/Prov Merges in the state or province of the off-premise site location of the event’s first sub-event.
Site Postal Merges in the postal/ZIP code of the off-premise site location of the event’s first sub-event.
Site Tele-
phone

Merges in the telephone number of the off-premise site location of the event’s first sub-event.

Site Dir-
ections

Merges in all text in the Directions text box of the event’s first sub-event, complete with rich-
text formatting.

Site Dir-
ections
(Unformatted)

Merges in all text in the Directions text box of the event’s first sub-event, without any format-
ting (so it adopts the formatting of the merge document).

Site Notes Merges in all text in theNotes text box of the Site Location Database (Setup
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Field Description
> Site Locations), complete with rich-text formatting.

Site Notes
(Unformatted)

Merges in all text in theNotes text box of the Site Location Database (Setup> Site Loca-
tions) without any format-ting (so it adopts the formatting of the merge document).

Site Descrip-
tion

Merges in all text in theDescription text box of the Site Location Database (Setup
> Site Locations), complete with rich-text formatting.

Site Descrip-
tion
(Unformatted)

Merges in all text in theDescription text box of the Site Location Database (Setup> Site
Locations) without any format-ting (so it adopts the formatting of the merge document).

Site Category Merges in the name of the site category. This is a customizable quickpick list.
Site Website Merges in the website address of the off-premise site location of the event’s first sub-event.
Setup Notes Merges in all text contained within the Setup Notes area of the event’s first sub-event, com-

plete with rich-text for-matting.
Setup Notes
(Unformatted)

Merges in all text contained within the Setup Notes area, without any formatting (so it
adopts the formatting of the merge document).

Setup Person Merges in the name of the setup person. This is a customizable quickpick list.
Delivery
Charge

Merges in the delivery charge, if applicable.

Delivery Cat-
egory

Merges in the delivery category. This is a customizable quickpick list.

Delivery Per-
son

Merges in the name of the delivery person. This is a customizable quickpick list.

Delivery Notes Merges in all text contained within theDelivery Notes area of the event’s first sub-event,
complete with rich-text for-matting.

Delivery Notes 
(Unformatted)

Merges in all text contained within theDelivery Notes area, without any formatting (so it
adopts the formatting of the merge document).

Comments Merges in all text on the Comments tab of the event’s first sub-event, complete with rich-
text for-matting.

Comments
(Unformatted)

Merges in all text on the Comments tab of the event’s first sub-event,without any formatting 
(so it adopts the formatting of the merge document).

Planned
Guests

Merges in the planned guest count of the event's first sub-event.

Actual Guests Merges in the actual guest count of the event's first sub-event.
Guaranteed
Guests

Merges in the guaranteed guest count of event's first sub-event.

Sub-Event
Number

Merges in the sub-event number of the event's first sub-event.
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Customizing Quickpick Lists
Throughout Caterease the majority of fields offer "quickpick lists" - drop-down lists of choices that you can
select from to keep your data entry consistent. These lists are yours to create, and they can be edited as
described below.

Note: Editing the list of "Sales Representatives" is done through System Security.

Editing Quickpick Lists

1. Click the Administration ribbon tab at the top of your screen.

2. Click Lists > Quickpicks.
Result: The Setup Quickpick Lists window opens.
Note: You can also click theQuickpicks button in the Setup group of the navigation pane (left-hand side
of your screen).

3. On the left-hand side of the Setup Quickpick Lists window, click the expand button to the left of any

quickpick category to see the corresponding lists. Click the Full Expand button to view all expan-
ded categories.
The "Room" list, available in the "Event Manager" category above (under "Sub-Event"), is only available
if your company has NOT purchased banquet room tracking. This list allows you to create a custom
quickpick list for the Room field, but will not track or graph those rooms.

4. Click on the desired quickpick list to select it.
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5. [Optional] Click the Add New Item button at the top right of the window to add a new item to
the list.
Note: In certain lists (Business Type, Status, Event Category), you are able to apply a color to the item, so
that you might color-code your Event Scheduler and various detail grids based on these lists. Simply
click into the Color column next to each item and click the down arrow to select a new color, or click
the browse button (ellipsis button) to set a custom color.

6. [Optional] Click on an item to select it and either edit as desired, or click the Delete Current Item but-

ton to remove the item from the list.

7. [Optional] Hold your left mouse button down on any item in the list and drag it up or down to repos-
ition it.
Note: You cannot drag an item you are currently editing; click off of the item first and then click and
hold your left mouse button over it again to drag and drop.

- 75 -



Unit 5: Entering General Event Information

Renaming Fields
If you do not like the term "Sub-Event," or if you'd rather use the field "Category" to track some specific piece
of information, either of these can be renamed through your program's Global Settings. Various fields through-
out your program can be renamed by following the steps outlined below.

Customizing Field Names
Tip: If prints in your
Print Designer or
Marketing Tools
package use the par-
ticular fields you
have renamed here,
you will likely need
to open those prints
and reselect those
fields with their new
names in order for
them to merge
information prop-
erly.

1. Click the Administration ribbon tab at the top of your screen.

2. Click General > Customize Names.
Result: The Customize Names window opens.

3. Click into the General, Financials, Events, Times, Enterprise, or Miscellaneous category fields and type a
new name as desired.

4. When finished, click OK.
Result: A notification message appears.
Note: Changes will take effect throughout the program anywhere these terms are found.
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Note: Click the Reset Names button at the top right-hand side of the window to restore all fields back
to their defaults.

5. Click OK on the notification message.
Result: The window closes and your changes are saved.
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Creating User-Defined Fields
If your company needs to keep track of unique information about your clients, events, menu items, etc., you
can create your own custom user-defined fields. These fields can be displayed anywhere in their respective
areas of the program or on various prints, and can be formatted as text fields (for which you can create custom
quickpick lists), phone numbers (which will honor your custom phone number format), number fields (offer-
ing drop-down calculators), currency fields, dates (offering drop-down calendars), or times.

Creating a User-Defined Field

1. Click the Administration ribbon tab (top of your screen).

2. Click the Lists button and choose User Defined Fields.
Result: The User-Defined Fields window opens.

3. Click on the appropriate tab at the top of your User-Defined Fields window for the type of field you are
creating: the Accounts tab for fields to use in Account Manager, Events tab for your Event Manager,
Sub-Events tab for your sub-event window (in Event Manager), and Guestrooms tab for your
Guestrooms Manager (if applicable).

4. Click into the first available user-defined field and type as desired. (A field will be "available" if it has the
default value of "NA," meaning a user-defined field has yet to be created.)
Note: You may need to use your [Backspace] or [Delete] keys to erase the "NA" that is currently in the
field.
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5. Press your [Enter] key.
Result: Your cursor positions you to the right, to the Type field.

6. Click the down arrow at the right of the Type field, and select a format type for this field.

l A Text field allows for free-flowing text, and allows you to create a custom quickpick list for the new
field.

l A Phone field formats the field according to how phone numbers are set up in your "Regional"
Global Settings.

l A Number field allows for free-flowing numbers, and offers the use of a drop-down calculator.

l A Currency field formats numbers entered as currency (e.g., "1.5" will print as "$1.50").

l A Date field allows you to type a date, and offers the use of a drop-down calendar.

l A Time field contains a colon (between hours and minutes) and the letter "M" (for AM or PM - not
applicable if you have the 24 Hour Clock "Regional" Global Setting established.

7. Repeat Steps 3-6 as necessary to add more fields.

8. When finished, click OK at the bottom right of the window to save your changes.
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Creating a Quickpick List for a User-Defined Field
1. Click the Administration ribbon tab at the top of your screen.

2. Click Lists > Quickpicks.
Result: The Setup Quickpick Lists window opens.
Note: You can also click theQuickpicks button in the Setup group of the navigation pane (left-hand side
of your screen).

3. On the left-hand side of the Setup Quickpick Lists window, click the expand button to the left of the cat-

egory labeled User Defined Fields. (Optionally click the Full Expand button , located on the upper
left-hand side of the window, to expand all quickpick categories.)
Result: Any user-defined field you have created and formatted as a Text field will be listed here.
Note: Quickpick lists can only be created for user-defined fields with a Type of "Text."

4. Click on the desired user-defined field to select it.

5. Click the Add New Item button at the top right of the window to add a new quickpick item for
the user-defined field.
Note: To delete an item from a list, select it and click the Delete Current Item button
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.

6. [Optional] Hold your left mouse button down on any item in the list and drag it up or down to repos-
ition it.
Note: You cannot drag an item you are currently editing. Click off of the item first and then click and
hold your left mouse button over it again to drag and drop.
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Displaying User-Defined Fields
1. Decide where on the Manager screen you would like to place the user-defined field.

2. Right-click directly on any field name or tab name on the screen.
Note: Right-clicking within a field brings up a completely different pop-up menu.

3. Select Customize from the pop-up window which displays.
Result: The Customize window opens.

4. Hold your left mouse button down on the name of the user-defined field (found in the Available Items
pane) you would like to display on your screen.

5. Drag the field name into position anywhere on the screen, and then release your mouse button.

Note: Remember to click the Save Current Window Settings button if you would like to retain the
new arrangement as your default setting.
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Making Fields Required
Using the steps below, you can make certain fields of information required or even conditionally required,
meaning certain details are required for one type of event or customer but might not be required for others.
(For example, perhaps a "corporate" customer is required to have a fax number and e-mail address, while a
"social" customer requires a cell phone number.)

Making Fields Generally Required
Tip: Even user-
defined fields you
have created can be
designated as
required fields using
this tool, and will be
listed along with the
other fields on the
appropriate tabs.
Also, note that you
can optionally select
all fields on the cur-
rently displayed tab
as required inform-
ation by clicking the
Check All Fields
button at the top
right of the window.

1. Click the Administration ribbon tab at the top of your screen.

2. Click General > Required Fields.
Result: The Required Fields window opens.

3. On the left-hand side of the window, click on the tab representing the area of the program where you
want to create required fields.
Note: You can make fields required for your accounts (or "customers"), your prospective leads, your
events (including sub-event or "meal" details), or your group rooms contracts.

4. [Optional] If you have already created conditions for your required fields (see topic below), click the
condition in labeled "All Accounts" (or "All Events," "All Prospects," etc.), in the left pane of the win-
dow.
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5. In the right-hand pane of the window, click into the checkbox next to any field you want to be required
information, optionally clicking expand button next to any unopened group of fields to choose fields
from that group.
Result: The selected fields will now be required information, meaning that no accounts, events, etc., will
be able to be saved without those details entered. (Existing accounts, events, etc., that are missing
required information can be opened; however, they cannot be edited and saved until all required
information has been entered.)

Important Note: If designating required fields for events, you can click the Sub-Events button at the
bottom right of the window to make specific sub-event details required.

6. Click OK to close the window and save your changes.

- 84 -



Unit 5: Entering General Event Information

Making Fields Conditionally Required
Tip: The program
evaluates these con-
ditions in the order
they are listed, and
stops when it
reaches a condition
that is true. For
example, if your first
condition for
accounts is "Cat-
egory = Corporate"
and your second con-
dition is "Description
= Association Mem-
ber," when the pro-
gram finds an
account with a cat-
egory of "Cor-
porate," it will apply
those required fields
and stop, never eval-
uating for the
second condition.
For this reason, it is
imperative that any
condition that says
"All" records
("Accounts,"
"Events," etc.),
must be the LAST
condition listed.

1. On the left-hand side of the Required Fields window, click on the tab rep-
resenting the area of the program where you want to create conditionally
required fields.
Note: You can make fields required for your accounts (or "customers"), your
prospective leads, your events (including sub-event or "meal" details) or your
group rooms contracts.

2. Click the Add Condition button , located at the top center of the window.
Result: The Select Condition window opens.

3. Click the down arrow to the right of the first field in the window to select a con-
dition.
Note: Conditions vary depending on the tab selected in Step 1, above.

4. Click the down arrow to the right of the second field in the window and choose an option from the cor-
responding quickpick list.
Note: You can customize these lists.

5. In the right pane of the window, click into the checkbox next to any field you want to designate as
required information for records that match your condition, optionally clicking the expand button next
to any unopened group of fields to choose fields from that group.
Result: The selected fields will only be required for records that match your condition (see the tip below
for important information about prioritizing conditions).
Note: When using EventWizard to book an event, you can create custom Wizard layouts with the same
names as your event "Categories" or "Business Types," and when you use one of thoseWizards to book
a new event, the appropriate fields will be required.

Important: Hold your left mouse button down on the new condition you've created in the left pane of
the window and drag it up (or down) in the list to prioritize.
See the tip for important information.

6. When finished, click OK to close the window and save your changes.
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Establishing New Booking Defaults
The New Booking Defaults feature (available in all versions of Caterease) allows you to change certain settings
in the program and affect all users on your Caterease network. Settings here include general regional settings,
such as phone/fax number format, and general field settings, such as the ability to rename time fields. New
Booking Defaults also affect settings specific to particular Managers, such as defaulting guest counts in Event
Manager, as well as a variety of other miscellaneous settings.

Setting New Booking Defaults

1. Click the Administration ribbon tab at the top of your screen.

2. Click General > New Booking Defaults.
Result: The New Booking Defaults window opens.

3. Along the left-hand side of the New Booking Defaults window, select the tab that has the information
you want to enter or change.

4. Enter information into a field in one of the following ways:

l Click into a field and type a default entry as desired.

l Click into a quickpick field, click the down arrow at the right of a field, and select a default from the
corresponding quickpick list.
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Note: If the default entry you want is not on a quickpick list (or if there is no list), see Customizing
Quickpick Lists.

5. Click into a checkbox to enable a default feature.

6. Press your [Enter] key to move from field to field.

7. Repeat Steps 3-5 as necessary to enter more default information.

8. When finished, click OK at the bottom right of the window to close the window and save your changes.
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Adding or Editing Contact People in an Event
Your customers might have multiple contact people, each with his or her own telephone number, address,
etc. Once a contact has been added, all you have to do is retrieve the contact information (rather than type it
all again). Or, if no contact has been added, you can enter on-the-fly, directly from your event.

Adding or Editing Contact People in an Event

1. From the Event tab in Event Manager, click the down arrow to the right of the Booking Contact field or
Site Contact field.
Result: A pop-up window opens, from which you can edit your existing contact's information, choose
another contact, or add a new contact.

2. If you already entered a contact person for this account, click the Select Contact From File button
located on the upper right-hand side of the window, then double-click on the contact person's name to
select him or her into the event.
Result: The Select Contact window opens.
Note: Click into the Site & Booking Contact checkbox if you would like the contact person you are select-
ing to appear as both the Site Contact and Booking Contact.
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3. When finished, click OK.
Result: The Select Contact window closes and contact person you selected in step 2, above, displays in
the Booking Contact and/or Site Contact field.

4. Add a new contact by typing directly into the various fields (Name fields, Salutation, Telephone/Fax/Cel-
lular, Email) or, in the case of the Title field, by choosing an available option from the drop-down quick-
pick list to the right of the field.
Note: If no quickpick list appears for a field, see Customizing Quickpick Lists.

5. Click the Add Contact to File button to add the new contact to your contact list.
Result: A confirmation prompt appears.

6. Click Yes to confirm.
Result: An informational prompt appears.

7. Click OK.
Result: The contact is added to your contact list.
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Selecting a Contact from a Different Account
1. From the Event tab in Event Manager, click the down arrow to the right of the Booking Contact field or

Site Contact field.
Result: A pop-up window opens, from which you can edit your existing contact's information, choose
another contact, or add a new contact.

2. Click the Select Contact From File button , located on the upper right-hand side of the window.
Result: The Select Contact window opens.

3. Click the Show Accounts/Hide Accounts button.
Result: A panel is added to the right of the Select Contact window, revealing your account list.

4. Begin typing the name of the account (which has the contact you are seeking) into the Search For field.
Result: You are scrolled to a match as you type.

5. Double-click on the name of the contact person you would like to add as the Booking Contact or Site
Contact.
Result: The Select Contact window closes and the selected contact name displays in the Booking
Contact and/or Site Contact field.
Note: Click into the Site & Booking Contact checkbox if you would like this contact to serve as both the
Site Contact and Booking Contact.

Tip: Click theQuick
Column Cus-

tomizing button ,
located to the left of
the word Client, to
reveal additional
columns that can be
added to your dis-
play.
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Adding a Sub-Event (or Meal)
Tip: Leave the
Included checkbox
(bottom left of the
New Sub-Event win-
dow) selected,
unless you decide
you do not want to
include this sub-
event and its details
(menu, venue,
times, etc.), with
this event (for
example, if it was
created as an
optional proposal
and is not to be
included).

1. Click the Sub-Event button, located next to the Event button on the left-hand
side of your screen.
Result: The Event Manager changes to the Sub-Event Display.

2. Click the Add A New Sub-Event button , located on the Sub-Event pane,
which is to the left of your Food/Service tab.
Result: The Sub-Event window opens, with the date and guest counts defaulting
from your general event information.
Note: As an alternative, hold your [Shift] key down simultaneously while click-
ing the above button. Doing so prevents a new sub-event window from popping
up, and instead you can edit your new sub-event directly in the grid on the left-
hand side of your screen.

3. Click into the Description field and type a description for the sub-event, or select one from your custom
quickpick list.
Note: Examples of sub-event descriptions might include "Breakfast," "Break," "Buffet," etc.

4. [Optional] Click into the Type field and enter a type for the sub-event, or select one from the custom
quickpick list.
Note: This field can be used for tracking your sub-events. Examples might include "Off-Premise," "On-
Premise," "Delivery," etc.

5. Enter times by hand, using the formats below, or by using the Time Wizard tool:

l As a normal number for AM hours - that is, type "9" for 9:00 AM, "11" for 11:00 AM, etc.

l As a four-digit number for any other times - that is, type "0930" for 9:30 AM or "0930" and a "P" for
9:30 PM.
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l Click into the hours, minutes, or AM/PM area of the time field and use the up-and-down arrows at
the right of the field to make changes.

6. [Optional] Enter banquet room details or off-premise information, depending on the venue of the
party.
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Using the Mapping Interface
You can get up-to-the-minute accurate directions to a customer's or prospect's address, or to an event's site
location, using our dynamic interface with various online mapping software.

Using theMapping Interface
Tip: You can copy
and paste these dir-
ections into
Caterease using the
Paste as Plain
Text option. Do NOT
opt to simply paste
this text, as it will
bring HTML code
and other formatting
from the website;
using "Paste as Plain
Text" strips it of this
code.

1. Click the Get Map button from the toolbar at the bottom of your Account
Manager or Event Manager screen (also in Prospect Manager, if you own the
Prospect Manager add-in module).
Result: The Get Directions window opens, with your company's address auto-
matically filed in as the Start information and the address of the client (Account
Manager, Event Manager), prospect (Prospect manager) or Site Location (Event
Manager Sub-Event display) as the End information.
Note: If you have not filled in this prospect's address, city, state, etc., then the
End information will be blank.

2. [Optional] In Event Manager, click the down arrow to the right of the "End"
address field to alternate between using the client's address and the site loc-
ation address.

3. Click the down arrow next to Map Provider in the Options section and choose your preferred mapping
website.
Note: Google Maps automatically provides directions in the default language (English, Spanish, etc.), of
your browser.
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4. Click OK to generate the directions.
Result: Your web browser will open on your chosen website, showing directions to the "End" address.
Note: This interface only works if you have a connection to the Internet currently active on your com-
puter.

5. When finished, click OK.
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Managing Multiple Events Simultaneously
Caterease lets you open multiple windows (including multiple Event Managers) simultaneously, so you can
handle any interruption without losing your place!

Opening Multiple Managers
Tip: Up to three
instances of each
Manager can be
opened at the same
time. The tabs at the
top of your screen
indicate the number
of open Managers,
as well as any other
open Caterease
screens, such as
your Scheduler, Mar-
keting Tools, etc.

1. With one Event Manager (or other Manager) open, click the Event Manager
button (or other "Manager" button) on the Main sidebar.
Result: A confirmation prompt appears.

2. Click Yes to confirm your choice.

3. Work as desired in the new Manager.

4. Close the second Manager to return to your previous Manager (or toggle
between the two). Your cursor will be positioned in the exact location in which
you were working before you switched to the other Manager.
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Managing Event Costing
The cost of an event is automatically calculated based on the cost of its menu items, the wages paid to staff
working the party and any additional adjustments you choose to make. While all versions of Caterease allow
you to enter a line item cost for each menu item, the Standard and Professional versions can automatically cal-
culate an item cost based on its ingredients, and allow you to change those ingredients on-the-fly.

Reviewing the Event Costing Summary

1. In the Event Manager, retrieve the event for which you want to reviewing costing.

Note: In the
Express version, you
can review event
cost and profit by
clicking your right
mouse button over
the Financials area
(top right of Event
Manager) and choos-
ing
Customize.Next,
click into the check-
boxes next to "Cost"
and "Profit."

2. Click the Tools button from the Home ribbon tab and choose the Costing Sum-

mary button .
Note: Depending on your personal configuration, the Costing Summary button
may appear in the toolbar at the bottom of your screen.
Result: The Event Costing Summary window opens.

3. [Optional] Click the View Line Item Details button , located to the right of the Total Line Items field,
to see a breakdown of the cost of each food/service item.
Result: The Food/Service Items Breakdown window opens.
Note: You can manipulate the data in this grid in many ways, and print the grid details.

4. [Optional] Click the View Staffing Details button to the right of the Employee Staffing field to
review staffing cost breakdowns.
Result: The Staffing Breakdown window opens.

5. [Optional] Click the View/Edit Costing Adjustments button to the right of the Adjustments field to
review, edit or add cost adjustments.
Result: The Event Costing Adjustments window opens.
Note: You can add adjustments to the cost of an event easily (if, for example, there is an additional cost
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you are incurring that is not part of the menu or staffing of this event) by clicking the green plus sign
button in this window.

6. To print a costing summary for the current event, click the Print Costing Summary button at the top left
of the Event Costing Summary window.
Result: A print preview of the Event Costing Summary displays.
Note: If you have not yet saved recent changes to your event, you may be prompted to do so. You can
also print the Event Costing Summary by clicking the Home ribbon tab and selecting Prints > Event Sub-
prints > Event Costing Summary.
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Changing Menu Line Item Costs
1. In the Event Manager, click the Sub-Event button to show the meal(s) for the event.

2. In the grid on the Food/Service tab, click the Quick Column Customizing button , located to the left of
the Item Name column heading.
Result: A drop-down list of optional columns appears.

3. Click into the checkbox to the left of the Cost column to display that column in the grid.

4. [Optional] Hold your left mouse button down on the Cost column title and drag it up or down in the
drop-down list to reposition it on the grid, or drag and drop the column heading on the grid itself.

5. Click into the Cost column for any menu item in the grid and enter or edit a line-item cost as desired.
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Setting Discounts for an Event
Discounts can be easily applied to an event either as a percentage of "food" items, "beverage" items, "liquor"
items, etc., or as a whole dollar amount.

Applying Event Discounts

1. In the Event Manager, retrieve the event for which you want to establish default discounts.

2. Click the Tools button from the Home ribbon tab.

3. Click the Default Discounts button.
Result: The Event Discounts window opens.

4. Click into any field and enter a discount rate.
Note: Type in a field to enter information, or use the up-and-down arrows next to a field to adjust the
rate one-hundredth (.01) of a percent. You can also optionally enter a whole-dollar discount (see Step 7,
below).

5. Press your [Enter] key to move from field to field.

6. Repeat for any menu item type.

7. [Optional] Enter a number into the Additional field to serve as a whole dollar discount.
Note: Simply type into the field, or click the down arrow to the right of a field to access the drop-down
calculator.
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8. [Optional] Type a word or phrase into the Comment field to identify the discount, or select an option
from the quickpick list.
Note: This comment will appear on your event prints (Contract, etc.) next to the discount amount.
Examples include "VIP Discount," "Gift Certificate," etc. If this field is blank, default comment of "Dis-
count Given" will appear.

9. Click Close when finished.
Result: The Event Discounts window closes, saving your changes.
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Copying Discounts for an Event
1. In the Event Manager, retrieve the event for which you want to establish default discounts.

2. Click the Tools button from the Home ribbon tab and choose Default Discounts.
Result: The Event Discounts window opens.

3. Click into any field and enter a discount rate.
Note: Type in a field to enter information, or use the up-and-down arrows next to a field to adjust the
rate up or down one-hundredth (.01) of a percent.

4. Press your [Enter] key.

5. Click the Copy Discounts button .
Result: The discount that was entered in Step 4 is copied to the other fields.
Note: Click the Clear button to remove the discount from the fields.

6. [Optional] Enter a number into the Additional field to serve as a whole dollar discount.
Note: Simply type into the field, or click the down arrow to the right of the field to use the drop-down
calculator.

7. [Optional] Type a word or phrase in the Comment field to identify the discount, or select from the
quickpick list.
Note: This comment will appear on your event prints (Contract, BEO, etc.), next to the discount amount.
Examples include "VIP Discount," "Gift Certificate," etc. If this field is blank, the default comment of "Dis-
count Given" will display.

8. Click Close when finished.
Result: The Event Discounts window closes, saving your changes.
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Displaying Discounts on the Event Manager Screen
1. In Event Manager, click your right mouse button over the Financials area at the top right of the win-

dow.

2. Choose Customize.
Result: The Set Financial Display window opens.

3. Click into the checkbox next to Show Discount.

4. Click the , located at the upper right-hand corner of the window, to close the window.
Result: The Financials area display adjusts based on your selection; it is divided into two sections, with
the discount details on the left.

5. Click the Save Current Window Settings button to have discounts show as a default for any event
in your Event Manager.

- 105 -





Unit 7: Entering General Notes and Comments for an Event

In this section, you will learn:

Setting Up the Program's Scratch Pad
Entering Comments for an Event

Entering General Notes for an Event
Copying Comments or Notes from the Scratch Pad

Having Comments or Notes Appear on Prints





Unit 7: Entering General Notes and Comments for an Event

Setting Up the Scratch Pad
You can avoid repetitive typing by storing large amounts of commonly used text (comments, special requests,
setup notes, etc.), in the Scratch Pad.

Storing Text in the Scratch Pad

1. Click the Administration ribbon tab at the top of your screen.

2. Click Lists > Scratch Pad.
Result: The Scratch Pad Setup window opens.

3. Click the Add New Category button , located directly beside the list of categories in the pane on
the left.
Result: A confirmation prompt appears.

4. Click Yes.
Result: A New Category field is added to the bottom of your Categories list, with your cursor positioned
for you to enter a new title.

5. Type a name for your new category and press [Enter].
Result: Your new category name is saved.
Note: Categories are used to organize your list and make locating certain notes easier. Examples might
include "Setup Notes," "Equipment," "Special Requests," etc.

6. Click into the large white text box, in the Scratch Pad Comments area, and type notes for the category
as desired.

7. Format your Scratch Pad text using the Basic Text Editing tools available in the Home ribbon tab.

8. When finished, click the , located at the upper right-hand side of the window.
Result: A confirmation prompt appears.
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9. Click Yes to save your changes and close the window.
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Entering Special Requests or Comments
The Comments tab in Event Manager is a place for you to enter a customer's general special requests. These
comments can print on your Contract, BEO, and other event prints, or can be optionally suppressed.

Typing Comments by Hand

1. In the Event Manager, click the Sub-Event button on the left-hand side of your screen.
Result: The Event Manager switches to the Sub-Event display.

2. Click on the Comments tab at the bottom of your screen.

3. Click into the large white text box and type as desired.
Note: To avoid repetitive typing, retrieve commonly used comments from the Scratch Pad as described
in the topic below.
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Copying Comments from the Scratch Pad
Tip:When you
select a category on
the left side of your
Scratch Pad (Step 3
above), all text in
that category is auto-
matically highlighted
by default. As a
shortcut, you can
quickly insert all
highlighted text by
simply double-click-
ing on a Scratch Pad
category.

1. On the Comments tab in Event Manager, click in the large text block, placing
your cursor where you want to insert new text.

2. Click the Scratch Pad button , located in the toolbar at the bottom of your
screen.
Result: The Scratch Pad opens.

3. [Optional] If you have separated your Scratch Pad into various categories, click a category on the left
side of the Scratch Pad window to select it.
Result: The text for the selected category is displayed on the right-hand side of the Scratch Pad window.

4. Highlight the text you want to copy, and press the Insert Text button.
Result: The highlighted text will be inserted at the current location of your cursor.

Note: To have text inserted WITHOUT its formatting, click the Include Formatting button to dis-
able it. (This button is enabled as a default.)

5. When finished, click the at the top right of your Scratch Pad window.
Result: The Scratch Pad window closes.

6. Format the inserted text by highlighting it and using the Format toolbar as described in the topic below.

Formatting Text

1. In the "Notes" text box in Event Manager, highlight any text to select it for formatting.
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2. Click the Home ribbon tab at the top of your Caterease screen, if it is not already selected.

3. In the Basic Editing Tools group, use the following available tools:

Formatting Tool Description
Font: Click the down arrow and choose another font for the selected
text.
Font Size: Click the down arrow and choose another size for the selec-
ted text.
Increase/Decrease Font Size: Click these buttons to increase or
decrease the size of text by one font size, respectively.
Font Color: Click the down arrow and choose another color for the selec-
ted text.
Bullet Wizard: Click this button to select bullet style, number style,
and outline style.

Bold: Click this button to make the selected text bold.

Italic: Click this button to make the selected text italic.

Underline: Click this button to underline the selected text.

Align Left: Click this button to align the selected text with the left-hand
side of the window.
Align Center: Click this button to center the selected text in the win-
dow.

Align Right: Click this button to align the selected text with the right-
hand side of the window.
Increase Indent: Click this button to increase the paragraph indent of
the selected text.
Decrease Indent: Click this button to decrease the paragraph indent
of the selected text.
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Showing Comments on Event Prints
Tip: Event com-
ments can be
included in Mar-
keting Tools merge
documents by click-
ing the Insert
Fields button and
choosing either the
formatted or
unformatted option
from the Sub-Event
Fields list.

1. Click the Setup sidebar group on the left-hand side of your Caterease screen.

2. Click the Print Designer button.
Result: The Print Designer window opens.

3. On the left side of the window, click the title of the print you want to add "Com-
ments" to.

4. On the lower right of the Print Designer window, confirm there is no check in
the checkbox to the right of the Comments section.
Note: This checkbox will suppress the section; with no check in the box, the
Comments section will appear on the print.

5. [Optional] Click into the gray header box that reads Comments, and enter new heading text for the sec-
tion if desired.

6. When finished, close Print Designer and save your changes.
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Entering General Event Notes
You can use the large text block at the bottom of the Events display in Event Manager to store general event
notes. These notes can be included on your various custom event prints (in Print Designer or Marketing Tools),
but do not have to be. You can also copy common notes from your program's Scratch Pad.

Typing Notes by Hand

1. In the Event Manager, click the Event button (if it is not already selected).

2. Click into the large white Notes text box at the bottom of your screen.

3. Type as desired.
Note: To avoid repetitive typing, retrieve commonly used comments using the Scratch Pad, as described
in the topic below.

4. [Optional] Click your right mouse button anywhere in the Notes pane and choose Insert > Current
Date & Time to have the current date and time inserted into your notes. Click Insert > Image to
browse to a stored image.

5. [Optional] Highlight any text and format as desired.
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Copying Notes from the Scratch Pad
Tip:When you
select a category on
the left-hand side of
your Scratch Pad, all
text in that category
is automatically high-
lighted by default.
As a shortcut, you
can quickly insert all
highlighted text by
simply double-click-
ing on a Scratch Pad
category title.

1. Click into the large Notes text box on the Event Manager screen, placing your
cursor where you want to insert new text.

2. Click the Scratch Pad button , located at the lower left-hand side of your
Event Manager screen. (You can also access the Scratch Pad from your Tools
menu.)
Result: The Scratch Pad window opens.

3. [Optional] If you have separated your Scratch Pad into various categories, click on a category on the
left-hand side of the Scratch Pad window to select it.
Result: The text for the selected category is displayed on the right-hand side of the Scratch Pad window.
Note: If you have not separated Scratch Pad text into Categories, see Setting Up the Scratch Pad for
more information.

4. Highlight the text you want to copy, and press the Insert Text button.
Result: The highlighted text will be inserted at the current location of your cursor.

Note: To have text inserted WITHOUT its formatting, click the Include Formatting button to dis-
able it. (This button is enabled as a default.)

5. When finished, click the at the top right of your Scratch Pad window.
Result: The Scratch Pad window closes.

6. Format the inserted text by highlighting it and using the Format toolbar.

- 116 -



Unit 7: Entering General Notes and Comments for an Event

Showing Notes on Event Prints
Tip: Event Notes can
be included in Mar-
keting Tools merge
documents by click-
ing the Insert
Fields button and
choosing either the
formatted or
unformatted option
from the Event
Fields list.

1. Click the Setup sidebar group on the left-hand side of your Caterease screen.

2. Click the Print Designer button.
Result: The Print Designer window opens.

3. On the left side of the window, click on the title of the print you want to add
Notes to.

4. On the lower right of the Print Designer window, remove the check from the
checkbox to the right of the Notes section.
Note: This checkbox will suppress the section; with no check in the box, the
Notes section will appear on the print.

5. [Optional] Click into the gray header box that reads Event Notes, and enter new heading text for the
section, if desired.

6. When finished, close Print Designer and save your changes.
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Copying Sub-Events (or Meals)
The Professional version of the program allows you to quickly copy a sub-event, optionally including menu
items and other details. You can even choose whether or not to include each sub-event in your various prints,
essentially using them as optional proposed meals to present to your customer.

Copying Sub-Events (or Meals)
Tip: To include only
certain sub-events
on event prints,
simply hold the
[Shift] key down on
your keyboard as
you select the print
title.

1. In the Event Manager, click the Sub-Event button, next to the Event button on
the left-hand side of your screen.
Result: The Event Manager switches to the Sub-Event display.

2. Select a sub-event (if more than one) which you wish to copy.
Note: The number of sub-events associated with the current event is indicated
at the bottom of the sub-event list on the left-hand side of your screen. You can
use the navigation bar below the list to scroll through the sub-events.

3. Click the Copy Sub-Event button , located to the right of the list of sub-events.
Result: A confirmation window opens, with checkbox options.

4. Click into individual checkboxes if you wish to include food/service items, scheduled staff, or Scheduled
Items (Tables, Vans, Lanes, etc.).
Note: If there is no check in a checkbox, that option will not be included in your copy.

5. Click OK.
Result: Your sub-event is copied, and you are placed on the new copy.

6. Edit the sub-event details (of the copied sub-event) as desired.
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Copying Menu Items from One Event to Another
1. [Optional] On the Food/Service tab from a Sub-Event in Event Manager, select the specific menu items

you want to copy, holding your [Ctrl] or [Shift] keys down to select multiple items.

2. Click your right mouse button anywhere within the Food/Service grid.
Result: A pop-up menu opens.

3. Select Special Editing > Copy (All Items) or Copy Selected Items.
Result: A confirmation message appears.

4. Click Yes to confirm your choice.
Result: A notification message appears.

5. Click OK.
Result: Your menu items have been copied into memory (but have not yet been pasted anywhere).

6. Retrieve the event you want to paste your copied menu items into.

7. Click your right mouse button anywhere on the Food/Service grid of this event.
Result: A pop-up menu opens.
Note: You must be viewing the Sub-Event display of Event Manager to access the Food/Service tab/-
grid.

8. Select Special Editing > Paste (All Copied Items).
Result: A confirmation message appears.

9. Click Yes to confirm.
Result: Your copied menu items are pasted into this event.
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Copying Events
The powerful Copy Events tool helps you easily handle repeat business by copying an entire party to another
date or making it occur at regular intervals (weekly, monthly, etc.). You can even choose specific days of the
week on which to have the party recur.

Copying Events to Specific Dates

1. In Event Manager, search for and retrieve the event you want to copy.

2. Click the Tools button at the top of your screen and select Copy Event, or click the Copy Event button

from the toolbar at the bottom of your screen, depending on your personal configuration.
Result: The Copy Event window opens.

3. Type a date into the first To field on the Specific Dates tab, or click the down arrow to access the drop-
down calendar to make your selection.

4. [Optional] Enter more dates as desired to make more than one copy of the event.

5. At the bottom left of the Copy Event window, click into individual checkboxes if you wish to include
food/service items, shifts needed, scheduled staff or Scheduled Items (Tables, Vans, Lanes, etc.), or
Timeline (Professional version only).
Note: If there is no check in a checkbox, that option will not be included in your copy/copies.

6. At the bottom right of the Copy Event window, choose to update event financial details by using cur-
rent menu price/cost, using current tax rates, or including any discounts. Also choose to include dia-
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grams or automatic reminders (if applicable) in your copy.
Note: If there is no check in a checkbox, that option will not be included in your copy/copies.

7. Click OK.
Result: A confirmation message appears.

8. Click Yes to confirm.
Result: Your copies are created, and the Copy Event Results window opens.

IMPORTANT NOTE: Your new events have been booked. If there is a red X through the staffing ( ),

room ( ), or scheduled items ( ) icon , a conflict has occurred, and you will receive a warning

prompt that the copied event(s) should be edited. (Click the View Conflicts button to see
details.) You can print this copy results screen, or simply double-click a new event in the results win-
dow to retrieve and edit it while leaving the results window open. (After conflicts are corrected, the
Copy Event Results window DOES NOT refresh.)
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Copying Events for Regular Intervals (Monthly, Weekly,
etc.)

1. In Event Manager, search for and retrieve the event you want to copy.

2. Click the Tools button at the top of your screen and select Copy Event, or click the Copy Event button

from the toolbar at the bottom of your screen, depending on your personal configuration.
Result: The Copy Event window opens.

3. Click the Optional Parameters tab.

4. Click the down arrow next to the Sequence field.
Result: A drop-down list of options appears, allowing you to make the current event weekly, monthly,
etc.

5. Choose a sequence for the copy.
Note: "Monthly" copies will occur on the same date. To copy to a particular day of the week, choose
"First Weekday of Month," etc. ("Weekday" means any day of week, including weekends.)

6. Select a Beginning Date or day on which the copy should begin.
Note: If copying to "First/Second/Third/Last Weekday of Month," you must pick which day, month, and
year you want to begin your copy; for all other sequences, simply pick a date.

7. Enter the number of copies needed into the Number of Copies field, or use the up-and-down arrows
to adjust the number.
Note: In other words: if copying monthly, how many months should it continue for?

- 125 -



Unit 8: Copying Sub-Events, Menus and Events

8. At the bottom left of the Copy Event window, click into individual checkboxes if you wish to include
food/service items, shifts needed, scheduled staff or Scheduled Items (Tables, Vans, Lanes, etc.), or
Timeline (Professional version only).
Note: If there is no check in a checkbox, that option will not be included in your copy/copies.

9. At the bottom right, choose to update event financial details by using current menu price/cost, using
current tax rates or including any discounts. Also choose to include diagrams or automatic reminders (if
applicable) in your copy.
Note: If there is no check in a checkbox, that option will not be included in your copy/copies.

10. Click OK.
Result: A confirmation message appears, verifying the copy parameters you have chosen.

11. Click Yes to confirm.
Result: Another confirmation message appears, listing the specific dates your copies will be made for.

12. Click Yes to confirm.
Result: Your copies are created, and a result screen indicates new event numbers and whether any con-
flicts occurred.

IMPORTANT NOTE: Your new events have been booked. If there is a red X through the staffing ( ),

room ( ), or scheduled items ( ) icon, a conflict has occurred, and the corresponding event(s)

should be edited. (Click the View Conflicts button to see details.) You can print this copy results
screen, or simply double-click a new event in the results window to retrieve and edit it while leaving
the results window open. (After conflicts are corrected, the Copy Results window DOES NOT refresh.)
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Copying to Specific Days of the Week
1. In Event Manager, search for and retrieve the event you want to copy.

2. Click the Tools button at the top of your screen and select Copy Event, or click the Copy Event button

from the toolbar at the bottom of your screen, depending on your personal configuration.
Result: The Copy Event window opens.

3. Click the Within Range tab.

4. On the right-hand side of the tab, select the specific days to which you want to copy the event.

5. On the left-hand side of the tab, click the down arrow next to the From field to choose a date to being
the copies.

6. Click the down arrow next to the To field to choose a date to being the copies.
Note: Copies will be created for the days you selected in Step 4 that fall within the date range you selec-
ted in Steps 5 and 6.

7. At the bottom left of the Copy Event window, click into individual checkboxes if you wish to include
food/service items, shifts needed, scheduled staff or Scheduled Items (Tables, Vans, Lanes, etc.), or
Timeline (Professional version only).
Note: If there is no check in a checkbox, that option will not be included in your copy/copies.

8. At the bottom right, choose to update event financial details by using current menu price/cost, using
current tax rates or including any discounts. Also choose to include diagrams or automatic reminders (if
applicable) in your copy.
Note: If there is no check in a checkbox, that option will not be included in your copy/copies.

- 127 -



Unit 8: Copying Sub-Events, Menus and Events

9. Click OK.
Result: A confirmation message appears, verifying the copy parameters you have chosen.

10. Click Yes to confirm.
Result: Another confirmation message appears, listing the specific dates your copies will be made for.

11. Click Yes to confirm.
Result: Your copies are created, and a result screen indicates new event numbers and whether any con-
flicts occurred.

IMPORTANT NOTE: Your new events have been booked. If there is a red X through the staffing ( ),

room ( ), or scheduled items ( ) icon, a conflict has occurred, and the corresponding event(s)

should be edited. (Click the View Conflicts button to see details.) You can print this copy results
screen, or simply double-click a new event in the results window to retrieve and edit it while leaving
the results window open. (After conflicts are corrected, the Copy Event Results window DOES NOT
refresh.)
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In this section, you will learn:

Setting Up Default Checklists
Establishing a Checklist for an Event

Printing an Event Checklist
Modifying the Checklist Print
Running a Checklist Report
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Creating an Event Checklist of To-Do Items
You can create a checklist of "to-do" items for your various events, either selecting from default lists of tasks or
adding a custom task on-the-fly. In addition, you can assign default due dates to these checklist items, telling
the program to calculate a certain number of days after the date an event is booked or held, or even having
that number conditionally change based on such details as event "theme," "category," "status," etc. Event
Checklist items can also be conveniently accessed from the Backstage Tab.

Adding a New Checklist

1. Click the Administration ribbon tab at the top of your screen.

2. Click the Lists button and choose Default Checklists.
Result: The Default Checklists window opens.

3. Click the Add New Checklist button , located on the top left-hand side of the window.
Note: This button is identical to the Add New Checklist Item button on the right-hand side of the win-
dow; take care not to confuse the two.
Result: A confirmation prompt appears.

4. Click Yes to confirm your choice.
Result: A new field is added to the bottom of the list.
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5. In the newly created field, type over the name "New Checklist" to rename your new default checklist.

6. Press [Enter] to save your new default checklist.

7. [Optional] Use the checklist panel, located in the left-hand pane, to modify your checklist.

l Delete Checklist: This button deletes the currently highlighted checklist and all of its items.
Note: This function cannot be undone; you will therefore be prompted to confirm your choice.

l Move Up: This button moves the highlighted checklist up one position in the list.

l Move Down: This button moves the highlighted checklist down one position in the list.

l Rename Checklist: This option allows you to rename the checklist. Simply type over the existing
name, and then press [Enter].

- 132 -



Unit 9: Using the Event Checklist

Adding a New Checklist Item

1. To add a new item to your default checklist, click the Add New Checklist Item button , located at
the top right-hand side of the Default Checklists window.
Result: A blank field is added to the bottom of the list.

2. Type a checklist item into the Item field, and press [Tab] or [Enter] to move to the next field.

3. Select a Category from the drop-down quickpick list to the right of the field, and press [Tab] or [Enter].
Note: You may also type directly into the field.

4. Click the down arrow to the right of the Assigned To field to select, from the quickpick list, the person
responsible for the checklist item. (You may also type a name directly into the field.)

5. Click the View Checklist Item button , located on the right-hand side of the window.
Result: The Checklist Item window opens, and any information you entered on the previous screen (Item
Name, Category, Assigned To Name) auto-populate.

6. Click into the checkbox next to Auto Default Checklist Item Date if you would like to set a due date for
the checklist item.
Result: The fields in the Set the checklist due date for area become enabled.

7. Indicate the number of days/weeks/months before or after the Booked Date or Event Date you would
like the checklist due date to reflect by selecting the options from the drop-down lists.

8. Click OK.
Result: You are returned to the Default Checklists window.
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9. [Optional] Click on the Notes tab and enter any desired notes pertaining to the default checklist into
the text box.
Note: These notes are retrieved into an event along with the checklist. Format the notes by highlighting
the text, right-clicking, and selecting Font.

10. Click OK to save your work and close the window.

Tip: The steps out-
lined here, while sim-
ilar to the steps
outlined in the topic
below, pertain to a
checklist that is not
based on "con-
ditions." See the
topic below for
information about
creating a con-
ditional checklist.
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Retrieving Items from Default Checklists
1. Search for and retrieve the event for which you want to establish a checklist.

2. Click the Event Checklist button , located in the toolbar at the bottom of Event Manager. (This but-
ton may also be accessed from your Toolsmenu.)
Result: The Event Checklist window opens.

3. Click the View Or Select From Default Checklists button , located at the top right-hand side of the
Event Checklist window.
Result: The Select Default Checklists window opens.
Note: Default checklists eliminate repetitive data entry if you use the same checklist items over and over
in your events. If this window is empty, see "Creating an Event Default Checklist," above.

4. Select a checklist in the left pane of the Select Default Checklists window.
Result: The right-hand panel of the window updates to reflect the specific items in the list you've selec-
ted.

5. Highlight one or more checklist items.
Note: Highlight multiple items by holding your mouse button down and dragging, or holding your
[Ctrl] key down as you select.

6. Click OK.
Result: The Select Default Checklists window closes, and selected items are entered into the Event Check-
list window.
Note: As an alternative, drag and drop selected items into the Event Checklist window or click the
Select Items button to retrieve checklist items while leaving the Select Default Checklists window open.
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7. Click into the Due date field for a particular item and type the date the task should be performed by (or
click the down arrow to access the drop-down calendar).
Note: The Due date may default based on settings established in your default checklists.

8. [Optional] Click into the Assigned To field and type the name of the person responsible for this item, or
click the down arrow to choose a name from the corresponding list.
Note: This namemay have defaulted from your default checklist.

9. [Optional]When an item has been completed, click into the corresponding checkbox to the left of the
Done On field.
Result: The current date is automatically entered in the Done column, and the checklist item is des-
ignated as having been completed.

Note: As an option, click the Show Done/Not Done Tree button to group items in this grid by
their completion status.
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Making Checklist Items Conditional
1. Follow the steps on page 133 to create a checklist.

2. Click the Add Automatic Item button , located on the right-hand side of the Auto tab.
Result: The Auto-Create Checklist Item window opens.

3. Click the down arrow below the Auto-Create a new Checklist Item that applies to...heading to create
a condition for all events or for specific events based on Status, Category, Theme, etc.
Note: A second drop-down list is not available for All Events.

4. Click the down arrow to the right of the Assign the checklist item to area, and choose the person to
whom this checklist item is being assigned.

5. Click into the Auto Default Checklist Due Date checkbox.
Result: The Set the checklist due date for fields are now enabled.

6. Indicate the number of days/weeks/months before or after the Booked Date or Event Date you would
like the checklist due date to reflect by selecting the options in the Set the checklist due dates for area.

7. Click OK to save your changes and close the Auto-Create Checklist Item window.

8. [Optional] Click on the Notes tab and enter any desired notes pertaining to the auto-checklist into the
text box.
Note: These notes are retrieved into an event along with the checklist item.

9. When finished, click OK at the Default Checklists window.
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Adding a Conditional Auto-Checklist to an Event
Tip: You can determ-
ine what columns
are displayed on the
Event Checklist grid
by clicking the
Quick Column Cus-
tomizing button at
the far left of the
column headings.
Delete a checklist
item by selecting it
and clicking the
Delete Current
Checklist Item but-
ton.

1. Retrieve the event for which you want to establish an auto-checklist.

2. Click the Event Checklist button , located at the bottom of Event Manager.
Result: The Event Checklist window opens.

3. Click the Auto Create Event Checklist Items button , located on the right-
hand side of the Event Checklist window.
Result: A confirmation window opens.

4. Click Yes to confirm your choice.
Result: An informational prompt appears.

5. Click OK at the information prompt.
Result: The previously created default checklist displays in the window.

6. [Optional] Click the Quick Column Customizing button to add or remove headings from the checklist.

7. Click in the Due date field for a particular item and type the date the task should be performed by (or
click the down arrow to use the drop-down calendar).
Note: The Due date may default based on settings established in your default checklists.

8. [Optional] Click into the Assigned To field and type the name of the person responsible for this item, or
click the down arrow to choose a name from the corresponding list.
Note: This namemay have defaulted from your default checklist.

9. [Optional]When an item has been completed, click into the corresponding checkbox to the left of the
Done On column.
Result: The current date is automatically entered in the Done On column, and the checklist item is des-
ignated as having been completed.

Note: As an option, click the Show Done/Not Done Tree button to group items in this grid by
their completion status.
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Adding Unique Checklist Items by Hand
1. Search for and retrieve the event for which you want to establish a checklist.

2. Click the Event Checklist button , located at the bottom left-hand side of Event Manager.
Result: The Event Checklist window opens.

3. Click the Add A New Checklist Item button , located on the right-hand side of the window.
Result: A blank line is added to the bottom of the Event Checklist grid.

4. Type a description of the item into the Checklist Item field.

5. Press your [Enter] key.
Result: Your cursor moves to the Due date field.

6. Type the date the task should be performed by, or click the down arrow to access the drop-down cal-
endar.

7. Press [Enter] again.
Result: Your cursor moves to the Assigned To field.

8. [Optional] Click into the Assigned To field and type the name of the person responsible for this item, or
click the down arrow to choose a name from the corresponding quickpick list.

9. [Optional]When an item has been completed, click into the corresponding checkbox to the left of the
Done On column.
Result: The current date is automatically entered in the Done On column, and the checklist item is des-
ignated as having been completed.

Note: As an option, click the Show Done/Not Done Tree button to group items in this grid by
their completion status.

- 139 -



Unit 9: Using the Event Checklist

Printing a Checklist for an Event
Tip: If your Event
Checklist window is
open in Event Man-
ager, you can simply
click the Print but-
ton at the top left of
the window to gen-
erate the print.
Otherwise, you can
follow the steps
below.

1. With your event open in Event Manager, click the bottom half of the Prints but-
ton in the Home ribbon tab at the top of your screen.
Result: A drop-down list of options appears.

2. Click EventSubprints > Event Checklist.
Result: The Event Checklist subprint opens.
Note: This print (and other miscellaneous event sub-prints) can be customized
using the Miscellaneous Prints Designer.
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Generating the Event Checklist Report
This report lists all duties that pertain to events taking place on the day or date range you indicate. Fields prin-
ted include Checklist Item; Due Date; Assigned To; Done On; Done By; Event Information.

Generating the Event Checklist Report
Tip: As an option,
click the checkbox
labeled Close After
Printing at the bot-
tom left of the tool to
have this window
close automatically
as soon as your
report has been prin-
ted.

1. Click the Reports ribbon tab at the top of the screen.

2. Click the Activity button and choose Event Checklist.
Result: The Event Checklist window opens, where you can select your report
parameters.

3. Set a Date Range for your report by choosing the option Less Than or Equal To, Greater Than or Equal
To,Within Date Range, or choose a Relative Date Range for the report.

4. [Optional] Change the title of the report by highlighting the words "Event Checklist" and typing directly
into the field.

5. [Optional] Click the down arrow to the right of the Exclude Status field and select any event statuses
you would like excluded from your query.
Note: Placing a check in a box causes the tool to exclude events with that status from your results.

6. [Optional] Select other available options from the left-hand side of the screen to Include Done Items
or to Group by Done/Not Done or by Group by Category.
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7. [Optional] Click into the Show Notes checkbox if you would like notes to that were included for the
checklist item display on the report.

8. [Optional] Click into the Show Colors checkbox if you would like completed tasks to display in black font
and tasks that have not been completed to display in red font.

9. When finished setting your report parameters, click OK.
Result: The Event Checklist Report is generated, incorporating the parameters you established.
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In this section, you will learn:

Setting Up Default Timeline Lists
Establishing a Timeline for an Event

Setting Times for IndividualMenu Items
Printing an Event Timeline

Adding the Timeline to the Contract
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Creating a Detailed Event Timeline
In addition to the various time fields available in Event Manager, several of which can be renamed, you can
also create a detailed timeline unique to each party. For example, elaborate events such as wedding recep-
tions may require a longer list of times, including times for such things as Best Man's Toast, Father/Daughter
Dance, Cake Cutting, and more. You can either create these times on-the-fly within an event, or you can select
them from default lists.

Creating an Event Default Timeline

1. Click the Administration ribbon tab at the top of your screen.

2. Click the Lists button and choose Default Timeline Items.
Result: The Default Timeline Items window opens.

3. Click the Add New Timeline button , located on the left-hand side of the window.
Note: This button is identical to the Add New Timeline Item button on the right-hand side of the screen,
so do not confuse the two.
Result: A confirmation prompt displays.

4. Click Yes to confirm your choice.
Result: A new field is added to the bottom of the list.

5. In the newly created field, type over the name "New List" to rename your new default timeline.

6. Press [Enter] to save your new default timeline.

7. [Optional] Use the timeline panel, located in the left-hand pane, to modify your checklist.
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l Delete Timeline: This button deletes the currently highlighted checklist and all of its items.
Note: This function cannot be undone; you will be prompted to confirm your choice.

l Move Up: This button moves the highlighted timeline up one position in the list.

l Move Down: This button moves the highlighted timeline down one position in the list.

l Rename Timeline LIst: This option allows you to rename the timeline. Simply type over the existing
name, and then press [Enter].

8. To add a new item to your default timeline, click the Add New Timeline Item button , located at
the top right-hand side of the Default Timeline Items window.
Result: A blank field is added to the bottom of the list.

9. Type a timeline item into the Item field and press [Tab] or [Enter] to move to the next field.

10. Select a Category from the drop-down quickpick list to the right of the field, and press [Tab] or [Enter].
Note: You may also type directly into the field.

11. In the Time field, type the time the timeline item is due or use the up-and-down arrows to select a
time.

12. Repeat Steps 8-11 until you have finished creating your default timeline.

13. [Optional] Click the Notes text block and enter any desired notes pertaining to the default timeline.
Note: These notes are retrieved into an event along with the timeline. Format the notes by highlighting
the text, right-clicking, and selecting Font.

14. Click OK to save your work and close the window.
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Retrieving Items from Default Timelines
1. Retrieve the event for which you want to establish a timeline.

2. Click the Event Timeline button , located in the toolbar at the bottom of Event Manager. (This but-
ton can also be accessed from the Tools menu at the top of your screen.
Result: The Event Timeline window opens.

3. Click the View Or Select From Default Timeline Items button , located at the top right-hand side
of the Event Timeline window.
Result: The Select Default Timeline Items window opens.
Note: Default timelines eliminate repetitive entry if you use the same timeline items over and over in
your events. If this window is empty, you must first create default timeline lists from which to choose
these items.

4. Select a list in the left pane of the Select Default Timeline Items window.
Result: The right panel of the window updates to reflect the specific items in the list you've selected.

5. Highlight one or more timeline items.
Note: Highlight multiple items by holding your mouse button down and dragging, or holding your
[Ctrl] key down as you select.

6. Click OK.
Result: The Select Default Timeline Items window closes, and selected items are entered into the Event
Timeline window.
Note: As an alternative, drag and drop selected items into the Event Timeline window or click the Select
Items button to retrieve checklist items while leaving the Select Default Timeline Items window open.
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7. Click into the Time field for a particular item and enter a time, or use the up-and-down arrows to adjust
by one hour.
Note: The Time may default based on settings established in your default timeline lists.

8. [Optional] Enter a Category to use for future tracking of this item, or click the down arrow to choose a
name from the corresponding quickpick list.
Note: This "Category" may have defaulted from your default timeline list. The drop-down list of options
can be customized in your program's quickpick lists.

9. [Optional] Click Print at the top left of the Event Timeline window to print the timeline.
Note: This print can be modified in your program's Miscellaneous Print Designer.
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Adding Unique Timeline Items by Hand
1. Retrieve the event for which you want to establish a checklist.

2. Click the Event Timeline button , located in the toolbar at the bottom of Event Manager.
Result: The Event Timeline window opens.

3. Click the Add A New Timeline Item button on the right-hand side of the window.
Result: A new, blank record is added to the Event Timeline window.

4. Type a time for the item, and press your [Enter] key.
Result: Your cursor moves to the Timeline Item field.

5. Type the name of the item, and press [Enter] again.
Result: Your cursor moves to the Category field.

6. [Optional] Enter a Category to use for future tracking of this item, or click the down arrow to choose a
name from the corresponding quickpick list.
Note: This "Category" may have defaulted from your default timeline list. The drop-down list of options
can be customized in your program's quickpick lists.

7. [Optional] Click Print at the top left of the Event Timeline window to print the timeline.
Note: This print can be modified in your program's Miscellaneous Prints Designer.
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Adding Times to a Food/Service Item
1. Confirm the Food/Service tab is currently selected at the bottom of your Sub-Event display in Event

Manager.

2. Click the Quick Column Customizing button , located at the top left of the Food/Service grid.
Result: A drop-down list of optional columns appears.

3. Click into the checkbox next to the Time field.
Result: The time column is added to the Food/Service grid.

4. Enter the desired time into the Time field.
Note: Use the up-and-down arrows to adjust the AM/PM setting.

Tip: If you want the
Time column to be
displayed in the
Food/Service grid as
a default, click the
Save Current Win-
dow Settings but-
ton at the top right
of the Event Man-
ager window.

5. Click the bottom half of the Prints button, located at the top of your Caterease
screen.

6. Select Event Subprints > Event Timeline.
Note: You may need to modify the print to display your menu times. See the
topic below.
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Printing a Timeline for an Event
Tip: If your Event
Timeline window is
open in Event Man-
ager, you can simply
click the Print but-
ton at the top left to
generate the print.
Otherwise, you can
follow the steps
below.

1. With your event open in Event Manager, click the bottom half of the Prints but-
ton in the Home ribbon tab at the top of the screen.
Result: A drop-down list of options appears.
Note: You can also click the top of the Prints button to get a print selection win-
dow, and then choose the Subprints tab and move on to Step 3, below.

2. Click Event Subprints.
Result: Another drill-down list appears.

3. Choose Event Timeline.
Result: A preview window for the print appears.
Note: This print (and other miscellaneous event sub-prints) can be customized using the Miscellaneous
Prints Designer.

4. Click the Print button at the top of the print preview screen to send the print to a printer.
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Showing Event Timelines on Other Event Prints
Tip: You can determ-
ine what columns
are displayed on the
Event Timeline grid
by clicking Quick
Column Cus-
tomizing button at
the far left of the
column headings.
Delete a timeline
item by selecting it
and clicking the
Delete Current
Timeline Item but-
ton.

1. In the Print Designer, locate the Event Timeline section towards the bottom of
the print.

2. To display the timeline on the print, ensure the Event Timeline has not been suppressed, i.e., that the
checkboxes next to the timeline and timeline notes do not contain a check mark.
Note: An timeline must exist in Event Manager for this event in order for the timeline and associated
notes to display on the print.

3. If you do not want to display the timeline notes, click into the checkbox to the left of Suppress Event
Timeline Notes.
Result: Any timeline notes that have been entered into the event within Event Manager will not display
on the print.

4. If you do not want to display the timeline, click the box on the far right-hand side of the screen.
Result: Neither the timeline nor the timeline notes entered into the event within Event Manager will dis-
play on the print.
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In this section, you will learn:

Establishing Default Tax Rates
Creating Multiple Tax Schedules

Renaming Tax/Service Charge/Gratuity Names
Managing Tax Rates for an Event
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Establishing Default Tax Rates
You can easily establish or edit the default tax, service charge, and gratuity rates for all new events booked in
the program. In addition, you can create multiple tax schedules and assign them to individual customers or site
locations used for an event.

Note: Any changes to default tax/service charge rates affect events booked in the future; events currently in
the program will not be automatically affected.

Setting Tax/Service Charge Rates

1. Click the Administration ribbon tab at the top of your screen.

2. Click General > Tax/Service Charge Rates.
Result: The Default Tax & Service Charge Rates window opens.

3. Enter a new tax rate for your Food items by typing numbers into the Food field as desired.
Note: The up-and-down arrows next to the rate adjust it one-hundredth (.01) of a percent.

4. Press your [Enter] key to move to the next field (the Beverage field).

5. Continue to enter default tax rates as desired for all food/service item types.
Note: Individual menu items can be designated as exempt from tax, service charge, and/or gratuity in
Menu Manager. For example, even if you establish a default tax rate for "Equipment" items here, you
can make individual items tax-exempt in your default menus (or on-the-fly, within an event).
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6. [Optional] Continue to add rates into the second and third tax columns as desired.
Note: Multiple tax rates are often used by European or Canadian companies, and can also be used in
the United States to track separate "City," "State," and "County" taxes.

7. Continue to add rates for default Gratuity and/or Service Charge for each type of menu item by typing
into their respective columns.

8. [Optional] Click into the checkbox labeled Tax Grat or Tax Serv Chg at the top of the fifth or seventh
column, respectively, to apply a tax to your gratuity or service charge rates.
Result: The gratuity or service charge of each new event will be taxed at the rate or rates you have set
on this screen.
Note: If you wish to establish a new unique tax rate to apply to the gratuity or service charge, click into
the checkbox labeled At New Rate at the top of the fifth or seventh column and set the new rate manu-
ally.

9. [Optional] Click into the checkbox labeled Tax Exempt at the bottom left of the window to make all
new orders in your program default to tax-exempt.
Note: Individual events can be designated as tax-exempt, as well.

10. [Optional] Enter whole dollar amounts in any of the fields listed under Additional Adjustments (lower
right of window) to add that amount to the subtotal, tax, gratuity, or service charge of all new events.
Note: These adjustments can also be made within individual events.

11. Click the OK button at the bottom right of the window when finished.
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Creating Multiple Tax Schedules
1. Click the Tax Schedules button at the top right of the Default Tax & Service Charge Rates window.

Result: The window expands to expose a new pane on the right-hand side.

2. Click the Add Tax Schedule button .
Result: A confirmation prompt appears.

3. Click Yes.
Result: A new tax schedule is added to the pane on the right of the window, with your cursor positioned
to enter a new name.

4. Type a name for your new schedule, and press your [Enter] key.
Result: Your new schedule name is saved.

5. Enter tax, gratuity, and service charge rates as described in "Setting Tax/Service Charge Rates," above.
Note: Specific tax schedules can be linked to individual customers or to individual site locations. Other-
wise, new events will default to reflect your "primary" schedule.

6. Repeat to add additional schedules, or click the OK button at the bottom right of the window when fin-
ished.
Note: You are able to incrementally search for your tax schedules by typing into the Search field, loc-
ated at the upper right-hand side of the extended Tax Schedules window.
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Renaming Tax Names
1. Click the Administration ribbon tab and choose General > Customize Names.

2. In the Financials group, click into the Tax 1, Tax 2, and/or Tax 3 fields, and type new names as desired.
Note: You can rename "Gratuity" and "Service Charge" here, as well.

3. When finished, click OK.
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Setting Event Tax Rates
New events automatically assume the default tax/service charge/gratuity rates you have established in your
program's setup, or they can pull in a unique tax schedule that might be applied to a client or site location. In
either case, rates can be easily edited on-the-fly within an event.

Editing Event Tax/Service Charge Rates

1. In the Event Manager, retrieve the event for which you want to edit rates.

2. Click the Tax Rates button , located in the toolbar at the bottom of your display or, depending on
your personal configuration, click the Tools button at the top of your screen to access the Tax Rates
button from the list of drop-down options.
Result: The Event Tax Rates window opens.
Note: When this event was added to your program, these rates defaulted to your program's default
tax rates

3. Click into any field and edit as desired.
Note: Up to three separate taxes, a gratuity and a service charge can be assigned to each type of food
or service item. You can type in a field to enter information, or use the arrows next to a field to adjust
the rate one percent or one-hundredth (.01) of a percent.

4. Press your [Enter] key to move from field to field.
Note: See topics below for details on taxing gratuity/service charge, making an event tax exempt,
adding additional adjustments, or selecting optional tax schedules.

Applying Tax on Gratuity or Service Charge

1. Access the Event Tax Rates window as shown above.
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2. Click into the checkbox labeled Tax Gratuity or Tax Serv Chg, at the top right of the Event Tax Rates win-
dow.
Result: Your event's gratuity or service charge is now taxed at the tax rate(s) you have established.
Note: If you do not want to set a unique tax rate for your service charge, you can skip Steps 3 and 4,
below.

3. [Optional] Click into the checkbox labeled At New Rate underneath the Tax Gratuity or Tax Service
Charge option.
Result: The column of fields below the At New Rate option is enabled.
Note: Use this feature only if you wish to tax your service charge at a rate that is different from your
current tax rate(s).

4. [Optional] Click into the various rate fields below the At New Rate option to set the tax rate to be
applied to the gratuity/service charge.
Note: This step is only necessary if you perform Step 3, above.

Making an Event Tax Exempt

1. Access the Event Tax Rates window as described above.

2. Click into the checkbox labeled Exempt, at the lower left of the Event Tax Rates window.
Result: The current event is now tax exempt.

3. Click into the Exempt # field and enter an optional tax exempt ID number.

Adding Whole Dollar Adjustments

1. Access the Event Tax Rates window as described above.

2. Click into one of the fields at the lower right of the form, under the heading "Additional Adjustments."

3. Enter a dollar amount to be added to the subtotal, tax, gratuity, or service charge of the event.
Note: As an alternative, you can click the down arrow in any field to use the drop-down calculator.
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Selecting an Optional Tax Schedule
1. Access the Event Tax Rates window as described above.

2. Click the Select Tax Schedule button .
Result: The Select Tax Schedule window opens.
Note: This feature allows you have multiple tax schedules in your program, and select from them on-
the-fly.

3. Select a schedule from the list.

Tip: Use the incre-
mental search tool to
locate your tax
schedules, if numer-
ous schedules have
been created. Sim-
ply begin typing the
name of your tax
schedule into the
Search field, and
you will be taken to
your matching
record.

4. Click OK.
Result: The event's tax/service charge rates are updated to reflect your selec-
tion.
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Adding a Payment for an Event
1. In Event Manager, retrieve the event for which you want to add a payment.

2. Click the Payments Made button , located at the bottom of the Event Manager, or from the Tools
menu at the top of your screen, depending on your personal configuration.
Result: The Event Payments window opens.

3. Click the Add Payment button , located on the right-hand side of the Event Payments window.
Result: The Payment Details window opens.
Note: The current date defaults as the new payment date, but can easily be edited.
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4. Enter a dollar amount into the Amount field.
Note: Type a dollar amount or click the down arrow to access the drop-down calculator.

5. Select a Pay Method from the drop-down quickpick list, or accept the default. (You may also type dir-
ectly into the field.)
Note: This information will default from the PaymentMethod of the event (if one exists).

6. Optionally enter a Category or choose a category from the drop-down quickpick list.
Note: Examples of categories might include "Initial Deposit," "Final Payment," etc.

7. Enter a Comment, if desired.

8. [Optional] Enter credit card details, if posting a credit card payment .

9. [Optional] Enter additional information, including a Revenue Code or Account Code for the payment, as
well as Check # and Check Date.
Note: None of this is required information.

10. Click OK.
Result: The Payment Details window closes, and your new payment is listed in the Event Payments win-
dow.
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11. Click the , located at the upper right-hand side of the window, to close the Event Payments win-
dow.
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Editing an Existing Event Payment

1. Click the Payments Made button , located at the bottom of the Event Manager, or from the Tools
button at the top of your screen, depending on your personal configuration.
Result: The Event Payments window opens.

2. Select any payment listed in the Event Payments window.

3. Click the View/Edit Payment Details button , located on the right-hand side of the window.
Result: The Payment Details window for that payment opens.

4. Edit information as desired and click OK.
Result: You are returned to the Event Payments window.

5. Click the , located at the upper right-hand side of the window, to close the window.
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Showing Payment Information on an Event Print
You may want to include information on your print about payments you have already received. Payments rep-
resent money you have received (whereas deposits, discussed in the next unit, represent money that will be
due at some point in the future).

1. Click the Setup sidebar group on the left-hand side of your Caterease screen.

2. Click the Print Designer button.
Result: The Print Designer window opens.

3. Click on a title, such as Contract, from the prints panel on the left-hand side of your Print Designer.

4. Click into the section heading labeled Payments Made and optionally type a new heading as desired.

5. Verify the Suppress Payments checkbox, located to the right of the Payments Made section, is not
checked.

6. Click the down arrow to the right of the first field, and select a field to appear (or selectNone).

7. Repeat Step 6 for other fields in the section.
Result: With the checkbox unchecked, this section will appear on the print.

See the following table for a description of the available payment fields.

Available Payment Fields

Field Description
Payment Prints the payment amount for the event.
Pmt Date Prints the date of each payment made for the event.
Pmt Method Prints the method of each payment.
Pmt Card Type Prints the credit card type, if applicable, used for each payment.
Pmt Card Number (Hidden) Prints the last four digits of the credit card, if applicable, used for each

payment.
Pmt Card Holder Prints the name of the credit card holder, if applicable, for each pay-

ment.
Pmt Expires Prints the expiration date of the credit card.
Pmt Approval Prints the authorization details from the credit card company, if applic-

able.
Pmt Rev Code Prints an optional revenue code you may have entered for each payment

(often used for in-house tracking).
Pmt Acct Code Prints an optional account code you may have entered for each payment

(often used for in-house tracking or for interfaces with third-party
accounting packages).

Pmt Check # Prints the check number, if the payment type is Check.
Pmt Check Date Prints the date the check was written, if the payment type is Check.
Pmt Category Prints the payment category, e.g, Scheduled Payment.
None Choose this option if you do not want anything to appear in one of these

fields on the print.
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Generating the Payments Made Report
Tip: As an option,
click the checkbox
labeled Close After
Printing at the bot-
tom left of the tool to
have this window
close automatically
as soon as your
report has been prin-
ted.

1. Click the Reports ribbon tab at the top of the screen.

2. Click the Financials button in the Event Information group.

3. Choose Payments Made.
Result: The Payments Made window opens, where you can select your report
parameters.

4. Set a Date Range for your report by choosing the option Less Than or Equal To, Greater Than or Equal
To,Within Date Range, or choose a Relative Date Range for the report.

5. [Optional] Change the title of the report by highlighting the words "Payments Made" and typing directly
into the field.

6. [Optional] Choose to base results on either Payment Date, Event Date OR Group Booking Departure
Date, or choose Either Payment Date OR Event Date OR Group Booking Departure Date.
Note: This option is applicable if you own the Guestrooms Manager add-in module.

7. [Optional] Click the down arrow under Group By to group by a detail other than Payment Date.
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8. [Optional] Choose to Include Details or Group Booking Payments by clicking into the corresponding
checkbox.

9. When finished, click OK.
Result: The Payments Made Report is generated, incorporating the parameters you established.
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Scheduling Future Event Deposits
In Caterease, there is a distinction between payments made for an event and deposits that are due in the
future. Future deposits are discussed below, including the option to create a regular schedule of deposits auto-
matically calculated based on the date a party is booked or held.

Scheduling an Event Deposit

1. In the Event Manager, search for and select the event for which you want to schedule a deposit.

2. Click on the Deposits Due button , located at the bottom left-hand side of the Event Manager win-
dow, or from the Tools button in the Home ribbon tab, depending on your personal configuration.
Result: The Event Deposits window opens.

3. Click the Add Deposit button , located at the right-hand side of the Event Deposits window.
Result: A new, blank line is added to your deposits list.

4. Click the down arrow at the right of the Due Date field and select a due date for the new deposit using
the drop-down calendar or optionally type a date by hand.

5. Press your [Enter] key.
Result: Your cursor moves to the Due Amount field.

6. Enter an amount for the deposit, or click the down arrow to access the drop-down calculator.

7. Press [Enter] and enter a Comment, if desired.
Note: Examples of comments might include "Initial Deposit," "Final Payment," etc.

8. Repeat Steps 3-7 to add other deposits as desired.
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Making Payments on a Deposit

1. Click on the Deposits Due button , located at the bottom left-hand side of the Event Manager win-
dow, or from the Tools button in the Home ribbon tab, depending on your personal configuration.
Result: The Event Deposits window opens.

2. Select a deposit on the Event Deposits window.

3. Click into the checkbox in the Paid column.
Result: The current date is automatically entered in the Paid Date column, and the due amount is
entered as the Paid Amount.
Note: These defaults can be overridden, if necessary.

4. Click Add To Payments button to automatically add a payment to this event reflecting this
deposit.
Result: A confirmation message appears.
Note: Since Caterease treats deposits due differently from payments made, it is highly recommended
that you add any paid deposits to your event payments by following this step and the next two steps.

5. Click Yes.
Result: A Payment Details window opens.
Note: The payment date and amount will default from your Event Deposits information, while the pay-
ment method will default from the general event information (if you have entered a payment method
and/or credit card information).

6. Enter or edit information as desired and click OK.
Result: A new payment has been added to this event based on the paid deposit.

Note: If you wish to review payments made for this event, click the Payments Made button , also
located in the toolbar at the bottom of your screen (or accessed via the Tools button in your Home rib-
bon tab, depending on your personal configuration).

- 176 -



Unit 13: Scheduling Future Deposits for a Party

Adding Scheduled Event Deposits
1. In the Event Manager, search for and retrieve the event for which you want to schedule a deposit.

2. Click on the Deposits Due button , located at the bottom left-hand side of the Event Manager win-
dow, or from the Tools button in the Home ribbon tab, depending on your personal configuration.
Result: The Event Deposits window opens.

3. Click the Make Scheduled Deposits button , located on the right-hand side of the Event Deposits
window.
Result: A list of deposits is created, based on the conditional deposit schedules you have created in your
program.
Note: See above for information on making payments on these deposits.
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Creating Default Deposit Schedules
You can create automatic schedules of future deposits for your parties - complete with due amounts (in dollars
or percentages of event totals) and due dates (relative to the event date or booked date), and then use these
schedules for the various events that you book. Schedules can be conditional, so it applies only to a certain
type of event - and you can even tell the program to automatically update the due amounts or due dates if
details of the party change. Note: This feature is not available in the Express version of the program.

Creating a Conditional Deposit Schedule
Tip: The program
evaluates these con-
ditions in the order
they are listed - and
stops when it
reaches a condition
that is true. For
example, if your first
condition for events
says "Category =
Business" and your
second condition
says "Status = Def-
inite," when the pro-
gram finds an event
with a category of
"Business" it will
apply those required
fields and stop -
never evaluating for
the second con-
dition. For this
reason, it is imper-
ative that any con-
dition that says "All"
records ("Events,"
"Accounts," etc.),
must be the LAST
condition listed.

1. Click the Administration ribbon tab at the top of the Caterease screen.

2. Click the Options button and choose Deposit Schedule.
Result: The Default Deposit Schedule window opens.

3. Click the Add Group button , located at the top left-hand side of the Conditional Group pane.
Result: The Select Condition window opens.
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4. Select a condition from the Create a new group that applies to... drop-down list. Choose from the fol-
lowing:

l All Events
Note: If All Events is selected, the second drop-down list will not display.

l Events with a Status of (or Category of; Theme of; Operation of; Business Type of; Sales Rep-
resentative of)
Note: If any of these options is selected, the second drop-down list becomes available, along with its
corresponding drop-down list.

5. Click OK.
Result: The Select Condition window closes and the Default Deposit Schedule window remains open.

6. In the Deposit Details area, choose whether this deposit will be due Before or After the Event Date or
the date on which the event is booked (Booked Date), and how many days/week/months before/after
the Event Date/Booked Date.

7. Determine whether the amount of the deposit should be calculated as a percentage of the event totals
or as a whole dollar amount by choosing either A Percent or An Amount from the drop-down list.

l If setting a percentage of the event totals, use the fields in the fourth row of the Deposit Details
area to set the percentage amount (first field) and the total to use as the basis.
Note: You would probably use the "Remaining balance due" option for all subsequent deposits after
the first one. For example, a possible first deposit might be "50% of the Total balance due," but sub-
sequent deposits might be based on the balance that remains. In other words, "Total balance due"
represents the total amount of sales for that event, regardless of whether any deposits have been
received.

l If setting a whole dollar amount, use the field in the fifth row of the Deposit Details area to set that
dollar amount - either by typing into the field or clicking the down arrow to access the drop-down
calculator.
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Showing Deposits Due on Event Prints
In addition to general financial information about an event, you may want the schedule of future deposits due
for a party to display on your print. This section will list all deposits that have not yet been paid, i.e., those
deposits that are due at some point in the future.

1. Click the Setup sidebar group on the left-hand side of your Caterease screen.

2. Click the Print Designer button.
Result: The Print Designer window opens.

3. Click on a title, such as Contract, from the prints panel on the left-hand side of your Print Designer.

4. Verify the Suppress Deposit Due Schedule checkbox, located beneath the Suppress Miscellaneous
Charges/Discounts checkbox, is not checked.
Note: To identify a checkbox, float your mouse pointer over it prior to clicking.

5. Click into the checkbox to add or remove a check mark.
Result: With the checkbox unchecked, this section will appear on the print.
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Generating the Deposits Due Report
This report lists all events with deposits due in a certain date range, as well as amounts and due dates of those
deposits.

Generating the Deposits Due Report
Tip: As an option,
click the checkbox
labeled Close After
Printing at the bot-
tom left of the tool to
have this window
close automatically
as soon as your
report has been prin-
ted.

1. Click the Reports ribbon tab at the top of the screen.

2. Click the Financials button and choose Deposits Due.
Result: The Deposits Due window opens, where you can select your report para-
meters.

3. Set a date range for your report by choosing an option from the drop-down list to the right of the Fore-
cast Numbers field.

4. [Optional] Change the title of the report by highlighting the words "Deposits Due" and typing directly
into the field.

5. [Optional] Click the down arrow to the right of the Exclude Status field and select any event statuses
you would like excluded from your query.
Note: Placing a check in a box causes the tool to exclude events with that status from your results.

6. [Optional]Click into the checkbox to the left of Include Paid Deposits to view events with paid deposits.

7. [Optional] Click into the checkbox to the left of Include Group Booking Deposits to view events with
group bookings.
Note: This is applicable if you own the Guestrooms Manager add-in.

8. When finished, click OK.
Result: The Deposits Due Report is generated, incorporating the parameters you established.
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Setting the Program to Update Deposits Due Auto-
matically

1. Click the Administration ribbon tab at the top of the Caterease screen.

2. Click the Settings button and choose Global Settings.
Result: The View/Edit Caterease Global Settings window opens.
Note: All Managers and other windows must be closed to access this tool. You will receive an inform-
ational prompt to this effect. Click Yes to close the operation.

3. Click the Miscellaneous tab, located on the left-hand side of the window.

4. Click into the checkbox next to Automatic Deposit Amount Adjustments.
Note: This setting causes the program to automatically recalculate percentage deposits ("50% of the
event total," etc.), if the event totals change. Fixed dollar amount deposits and deposits that have
already been paid will not be affected.
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5. Click into the checkbox next to Automatic Deposit Date Adjustments.
Note: This setting causes the program to automatically alter the due date of future deposits ("10 days
before the event date," etc.), if the relative event date changes. Deposits that have already been paid will
not be affected.

6. Click OK to close the window.
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Relating Files to an Event
If you have any computer files, such as Word docs, Excel spreadsheets, PDF files, images, etc., that are some-
how related to an event, you can associate those files to the party in Event Manager. For example, perhaps you
want to maintain a copy of each updated contract on record, in order to compare changes over time. Or
maybe you want to create a diagram of the party in an image software program, and then attach that image as
a JPG or BMP file. You can choose to embed a copy of each file into the Caterease database or, if you plan to
make future changes to the file, you can establish a link to the file itself. You can even attach PDF copies of
Caterease prints (Contracts, Invoices, letters, etc.), with a single mouse click, in the print preview window.

Adding a Related File to an Event
Tip: Open a file from
the Event Related
Files window by
double-clicking its
name or by selecting
it and clicking the
Open File button.

1. Click the Related Files button , located at the bottom left-hand side of the
Event Manager window, or from the Tools button in the Home ribbon tab,
depending on your personal configuration.
Result: The Event Related Files window opens.

2. Click the Add File button , located on the right-hand side of the Event Related Files window.
Result: A confirmation message appears.

3. Choose to "Embed the existing file into the database" or "Establish a link to the existing file."
Note: Embedding the file into the database copies the file in its current form and attaches it to this
event; establishing a link to a file will connect this event to a file on your computer or network that you
may change over time. (When establishing a link to a file that is not saved on your computer, you will
only be able to review that file when your computer has access to it.)

4. Click Yes.
Result: A browse window opens.

5. Browse your way to the file you want to attach to this event, and select it.
Note: You may want to click the down arrow next to the file type field at the bottom right of the browse
window and select a different type of file.
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6. Click Open.
Result: The selected file is attached to this event, and is listed in the Event Related Files window.
Note: As an alternative, you could double-click the file name in Step 5, above.

7. [Optional] Enter a Comment to describe the file or its relationship to the event.

8. Click the , located at the upper right-hand corner of the window, to close the window.

- 188 -



Unit 14: Attaching an External File to an Event

Replacing an Existing Related File

1. Click the Related Files button , located at the bottom left-hand side of the Event Manager win-
dow, or from the Tools button in the Home ribbon tab, depending on your personal configuration.
Result: The Event Related Files window opens.

2. Click on the name of the related file you want to replace.

3. Click the Replace File button on the right-hand side of the window.
Result: A browse window opens.

4. Browse your way to the replacement file and select it.
Note: You may want to click the down arrow next to the file type field a the bottom right of the browse
window and select a different type of file.

5. Click Open.
Result: The selected file is attached to this event, replacing the file highlighted in the Event Related Files
window.
Note: As an alternative, you could double-click the file name in Step 4, above.

6. [Optional] Update the Comment to describe the file or its relationship to the event.

7. Click the , located at the upper right-hand corner of the window, to close the window.
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Attaching a Caterease Print to an Event
1. Click the Prints button in the Home ribbon tab at the top of your Caterease screen, and select the print

you want to attach to this event.
Result: A print preview window opens.

2. Click the Attach button at the top of the print preview window.
Result: A confirmation window opens.

3. [Optional] Enter a Comment to describe the document or its relationship to the event ("Original Con-
tract," "Contract Update," "Invoice," etc.).

4. Click Yes.
Result: Another confirmation message appears.

5. Click Yes to close both the confirmation message and the print preview window, or click No to close
only the confirmation message.
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Customizing the Tools Menu and Tools Bar
Every Manager has a unique and dynamic Tools Menu and Tools Bar. Any tools that you use all the time can be
made easily and instantly accessible through the Tools Bar, while tools that you use “every so often” can be
available in the Tools Menu drop-down list.

Customizing the Tools Menu

1. Open the desired Manager you would like to customize.

2. Click the Toolsmenu, located at the top of your screen, in the Home ribbon tab.
Result: A drop-down list of options display. Remember, each Manager will have its own list of tools.

3. Choose Customize, located at the bottom of any Toolsmenu.

Note: Make sure the correct window (Managers, Queries, etc.) is open before you customize and
save your changes.

4. To remove a shortcut or shortcuts from the Tools Menu Shortcuts pane (left-hand side), simply click on
a shortcut from the Tools Menu Shortcut pane (left-hand side), hold, and drag to the trashcan icon at
the bottom of the window.

5. To add a shortcut, click on a shortcut from the Available Shortcuts pane (right-hand side), and drag and
drop into the Tools Menu Shortcuts pane.
Note: Click the expand button to the left of individual folders to reveal all available options.

6. To reposition buttons, drag and drop them up and down as desired in the list of Tools Menu Shortcuts.

- 193 -



Unit 15: Customizing the Tools Menu and Tools Bar

7. When finished, click OK.

8. Click the Save Current Window Settings button to save your customizations. Click the Settings
button > Shared > Current Window to save your customizations for every user in your company.
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Customizing the Toolbar
1. Open the desired Manager you would like to customize.

2. Click the Customize button, located at the bottom right-hand corner of your Manager screen.
Result: The Customize Tools Bar window opens.

3. To remove a shortcut or shortcuts from the Tools Bar Shortcuts pane (left-hand side), simply click on a
shortcut from the Tools Bar Shortcut pane (left-hand side), hold, and drag to the trashcan icon at the bot-
tom of the window.

4. To add a shortcut, click on a shortcut from the Available Shortcuts pane (right-hand side), and drag and
drop into the Tools Bar Shortcuts pane.
Note: Click the expand button to the left of individual folders to reveal all available options.
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5. To reposition buttons, drag and drop them up and down as desired in the list of Tools Bar Shortcuts.

Tip: To remove the
toolbar from your
screen altogether,
click into the Show
Tools Bar checkbox
to remove the check.

6. When finished, click OK.

7. Click the Save Current Window Settings button to save your cus-
tomizations. Click the Settings button > Shared > Current Window to save your
customizations for every user in your company.
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Searching for Accounts
You can find existing customers based on virtually any detail. A special tool lets you incrementally search as you
type the client's name, while the Account Finder tool lets you use basically any detail or combination of details
to locate the customer you need.

Searching Incrementally by Company Name
1. In Account Manager, click into the Search For field, located in theHome ribbon tab at the top of your

Caterease screen.

2. Begin typing the name of the customer you want to find.
Result: You are scrolled to a match as you type.
Note: You will be searching based on client name, since that is how accounts are sorted (by default).
See the topic below for details on how to sort and search by other details.
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Using the Account Finder
1. Click the Find button (binoculars), located on the Home ribbon tab at the top of your Caterease screen.

Result: The Account Finder tool opens.

2. In the Search By Fields area, type the text you would like to search for.
Note: You may search by more than one field. Many fields, such as Category, Reference, Description,
etc., have a corresponding drop-down lists to the right of the field.

3. In the Search Rules field, select the appropriate rule.
Note: Confirm that Ignore Case is selected if you want to ignore capitalization when you enter your
text.

l Starts With - The field you chose in the Search By Fields area starts with the words or letter you
typed.

l Exact Match - The field you chose in the Search By Fields area contains exactly the words you
typed (and nothing else).

l Anywhere in Field - The words or letters you typed appear anywhere in the field you chose in the
Search By Fields area.

l Sounds Like - The words or letters you typed match phonetically to the words in the field you chose
in the Search By Fields area.

4. [Optional] Click the radio button next to And or Or, within the Multiple Field Operator section, if you
are searching by multiple search criteria.

5. [Optional] Click into the Include Prefixes checkbox and then type the prefix (a, an, the) into the fields
within the Search Prefixes section to include prefixes in your search.
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6. Click the Find Records button, located at the bottom of the window.

7. [Optional] Click the Show Results/Hide Results button at the top right of the Finder to display a list
of all records your search has found thus far.
Note: Click once on a "found record" in the list to move to that account; double-click a record to move
to it AND close the Finder tool down.

8. [Optional] If you accidentally skip over the record you want, click the arrows on either side of the Find
Records button to move forward or backward.

9. Once your record is located, click Close.
Result: The Account Finder window closes and you are positioned on the record you sought.
Note: Click the Clear Criteria button after you have run a search, to clear all results and begin again.
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Creating and Using Custom Account Filter Tabs
There are several quick, easy ways to locate a client in Caterease. One of the easiest ways is to use the handy
Rolodex-style filter tabs that separate clients alphabetically based on names. To make this feature even more
handy, you can create your own custom tabs to organize clients any way you want.

Creating Custom Filter Tabs

1. Right-click on your Caterease main screen and choose User Preferences.
Result: The View/Edit Caterease Preferences window opens.
Note: This window can also be accessed from the Administration ribbon tab > Settings > User Prefer-
ences.

2. Click on the Filter Tabs tab, located on the left-hand side of the window.

3. Create a new filter tab in one of two ways:

l Simply click into the text field you want to change, then type in a new tab heading.

l Click the Add Tab button , located on the right-hand side of the window.
Result: A new tab is created at the bottom of the list. Edit the tab as desired.
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4. You can click, hold, and drag the tabs up and down the list, changing their positions.

5. To delete a tab, click on the tab you want to edit, then click the Delete Tab button , located on the
upper right-hand side of the window.

6. When finished, click OK.
Result: The new tab layout will be applied throughout your various Managers.

Tip: Any letter or number can be entered as a Tab Caption. A dash (-) is also permitted. Tab Caption
conventions are listed below.

Tab
Caption

Filter

A All records starting with the letter A
ABC All records starting either with the letter A, B, or C
A-C All records starting with the letter A and ending with the letter C
ABP-S All records starting with the letter A or B or P through S
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Using Custom Filter Tabs
1. Click the Account Manager button from your Main sidebar.

Result: Account Manager opens.

2. Click on the filter tabs, located on the upper left-hand side of your screen. The first tab is for "All
Records.” Remaining tabs contain only records that begin with the tab's letter.

3. Customize your filter tabs by following the steps listed in the topic above.

4. Click the arrows to scroll through your tabs.

Tip: Filter Tabs are
available in Account
Manager, Prospect
Manager, Contact
Manager, Employee
Manager, and the
Event Wizard.
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Adding an Account in Account Manager
A new customer can be added in several different places: in Event Manager or the EventWizard, while adding
a new event for that customer; in Prospect Manager, if you want the new customer to be included as a "pro-
spective lead" rather than an active client; or in Account Manager, if you simply want to have the new cus-
tomer's information on record. This topic discusses the latter approach.

Adding a New Account
Tip: Account Notes,
Directions, and
Allergy text can be
set to default for
each new event
booked for this cli-
ent. Additionally,
this text can be
formatted here or in
an event, using the
Basic Text Editing
tools.

1. Click the Account Manager button from the Main sidebar to access Account
Manager.
Result: Your Account Manager opens, with the General tab selected as a
default.

2. Click the Add Record button , located in the Home ribbon tab at the top of
your screen.
Result: A confirmation message appears.

3. Click Yes to confirm your choice.
Result: A new account is added, with the default name of "New Account."
Note: If your new client is an individual (as opposed to a company), see "Adding an AccountWho Is Not
a Company," below.

4. Type the name of your new account into the Client field, and press your [Enter] or [Tab] key to move
to the next field.
Result: The name you typed into the Client field replaces the default name "New Account."
Note: You can add, remove, or rearrange fields on this and other areas of the screen.
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5. Continue to fill out the fields on the General tab as desired, pressing [Enter] or [Tab] after each one to
move to the next field.

6. [Optional] On the Miscellaneous tab, type into a field or click the down arrow to the right of each field
to select from the corresponding quickpick list.
Note: These fields are used for tracking your customers, and are entirely optional. Also available on this
tab is the option to make an account tax exempt by clicking into the Tax Exempt checkbox.

7. [Optional] Click on the Notes tab in the top right window of Account Manager (if it is not already selec-
ted) and type any account-related notes as desired into the text box.

8. [Optional] Click on the Directions tab and type into the text box as desired if you wish to include dir-
ections to this account's facility.

9. [Optional] Click on the Allergy tab and type, into the text box, details of any allergies the client has dis-
closed.

10. [Optional] Click on the Picture tab, then right-click within the text block and choose Load From File if
you want to include a digital image to associate with this account.
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Fields Available in Account Manager
Field Description
Client/Organization* Identifies the name of the customer.
Address* Identifies the customer’s address.
Address (Other) Offers an optional address field; available as a sub-field of the Address field.
City* Identifies the city where the customer resides.
St/Prov* Identifies the state or province where the customer resides.
Postal* Identifies the postal code or ZIP code for the customer.
Telephone* Identifies the customer’s telephone number; will be formatted as per your pro-gram’s

Global Settings.
Telephone (Other) Offers an optional additional phone number field; will be formatted as per your pro-

gram’s Global Settings; available as a sub-field of Telephone.
Fax* Identifies the fax number of the client; will be formatted as per your program’s

Global Settings.
Cellular* Identifies a cellular phone number for the client; will be formatted as per your pro-

gram’s Global Settings.
Country Identifies the country where the customer resides.
Email* Identifies the customer’s e-mail address.
Website Identifies the website address of the customer.
County Identifies the county where the customer resides.
Category** Allows you to separate customers by category, for tracking purposes; exam-ples

might include “Corporate,” “Government,” “Educational,”etc.
Reference** Allows you to accurately track your marketing strategies by identifying how the cus-

tomer heard of you originally (as opposed to why they might book indi-vidual events
with you in the future).

Description** Allows you to further distinguish between customers, for tracking purposes; e.g.,
you might have customers with a Category (see above) of “Corporate” AND a Descrip-
tion of “Association Member.”

Sales Rep** Identifies a sales representative linked to the customer.
Tax Exempt** Allows you to designate every future event for this customer as tax-exempt.
Exempt #** Identifies a Tax Exempt ID number for a tax-exempt customer; available as a sub-

field of the Tax Exempt field.
Expires** Allows you to enter an expiration date for the client's tax exempt number.
Account ID Allows you to enter a custom ID number for the customer.
Account # Offers a unique identifier for the customer; automatically assigned by the pro-gram.
Group Offers a custom quickpick list so multiple clients can be associated with a single

group; e.g., different branches of a company or bank might be grouped by that com-
pany or bank’s name.

Hold Displays a checkbox to place a client on hold (meaning that the client cannot book
new events).

Hold Type Offers a custom quickpick list of reasons the client was placed on "hold" (e.g., "Past
Due Balance," "Seasonal," etc.).

Hold Date Automatically notes the date and time a client was placed on "hold."
Base Price Markup Allows you to select a default "base price markup" schedule for the client, so that

prices for any event booked by the client will be adjusted by a certain percentage
automatically.

Contact Time Prefer-
ence

Identifies the preferred time to be contacted: Morning, Afternoon, Evening.

Contact Type Prefer-
ence

Identifies the preferred contact type: Phone, E-mail.

Coordinator Allows you to enter a Coordinator for the account. The Coordinator is the person who
is coordinating the event. This might be the sales rep, the booking or site contact, or
someone totally different.

Site Name/Address Identifies the site name and address for off-premise events.
Tax Schedule Allows you to select a default tax schedule for the client, so that any event booked by

the client will default to those specific rates.
Pay Method Allows you to establish a default payment method for all future events booked by the

client.
Loyalty Num Allows you to enter a custom number to track customer loyalty; this number will

default to each contact person for the client (but can be changed) and will default for
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Field Description
each event the client or contact books.

Master Account Displays the master account this client belongs to, if you have setup a master
account relationship.

Master Account # Allows you to enter a custom number to track a particular customer account number.
User Defined Fields Allows you to create any unique fields you want, to suit your company's needs.
* Displayed on the General tab by default.
** Displayed on theMiscellaneous tab by default.
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Adding or Editing Contact People
Your customers might have multiple contact people, each with his or her own telephone number, address,
etc. You can add as many contact people as you want by following the steps outlined below.

Adding a New Contact Person

1. Click the Contacts tab at the bottom of Account Manager (if it is not already selected).
Result: The list of contacts for the current account are displayed.

2. Click the Add a New Contact button , located on the right-hand side of your screen.
Result: The Contact window opens, where you can enter contact person information.

3. Type the contact person's last name into the Last Name field.

4. Press your [Enter] or [Tab] key.
Result: Your cursor moves to the next field, the First Name field.

5. Continue to fill out information as desired, pressing [Enter] or [Tab] to move from field to field.
Note: Drop-down quickpick lists are offered for fields such as Title, and you can quickly and easily cus-
tomize them.

6. When finished, click OK to close the Contact window.
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Editing Contact Person Information

1. Click the Contacts tab at the bottom of Account Manager (if it is not already selected).
Result: The list of contacts for the current account is displayed.

2. Click on one of the contact people listed on that tab to select it for editing.

3. Click the Show Contact Details button , located at the right-hand side of your screen.
Result: The Contact window for the selected contact person opens.

4. Click on any tab within the Contact window and edit any information as desired.
Note: Drop-down quickpick lists are offered for fields such as Title, and you can easily customize them.

5. When finished, click OK.
Result: The Contact window closes and your changes are saved.
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Adding an Account Who is Not a Company
1. Click the Account Manager button from the Main sidebar to access Account Manager.

Result: Your Account Manager opens, with the General tab selected as a default.

2. Click the Add Record button , located in the Home ribbon tab at the top of your screen.
Result: A confirmation message appears.

3. Click Yes to confirm your choice.
Result: A new account is added, with the default name of "New Account."
Note: Do not fill out any General account details; instead, proceed to the next step, Step 4.

4. Click the Add A New Contact button , located on the right-hand side of the Contacts tab on the
Account Manager window.
Note: This button is identical to the Add Record button you clicked in Step 2, above. Be careful not to
confuse them.
Result: The Contact window opens, where you can enter your contact person information.

5. Type the customer's last name into the Last Name field.

6. Press your [Enter] or [Tab] key.
Result: Your cursor moves to the next field, the First Name field.
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7. Continue to fill out customer information as desired, pressing [Enter] or [Tab] to move from field to
field.
Note: Drop-down quickpick lists are offered for fields such as Title, and you can easily customize them.
The Salutation for the client (how you would address him/her in a letter) can be set to default from the
first name.

8. Click the Copy To Client button, located on the top left-hand side of the Contact window.
Result: All name and address information from the contact person is copied into the respective fields
for the client.
Note: If any client information already exists, you will be prompted to confirm you want it overwritten.
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Adding and Retrieving Events from Account Manager
Because Account Manager is a "one-stop shop" for your client information, you can review details of all events
a customer has booked, as well as retrieve those events (or even create new ones).

Adding a New Event from Account Manager
Tip: As an altern-
ative, you can click
the Event Wizard
button. You can then
use the Event Wiz-
ard tool to book your
new event, with the
account you have
chosen selected by
default.

1. Click the Account Manager button from the Main sidebar to access Account
Manager.

2. Search for and retrieve the account whose events you want to review, edit, or
add.

3. [Optional] Select a contact person on the Contacts tab at the bottom of the
Account Manager screen to be the default contact of the new event you will
add.
Note: This step is optional; the contact person you select will default as the
Booking and/or Site Contact of your new event, if you have enabled this option.

4. Click the Events tab at the bottom of Account Manager (if it is not already selected).
Result: The list of events booked for the current account (past or future) is displayed.

Note: This step is very important. The Add a New Event button in the next step performs different
functions, depending upon which tab is active in Account Manager.

5. Click the Add a New Event button , located on the right-hand side of the Account Manager
screen.
Result: A confirmation message appears. (If you have made changes to the account, you will be asked
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to save those changes before continuing.)

Note: This button is identical to the Add Record button at the top of your Caterease screen, which
is used to add new accounts, so take care not to confuse them.

6. Click Yes to verify your choice.
Result: Event Manager will open and position you on a brand-new event for the customer you selected
in Step 2, above.

Retrieving Events from Account Manager

1. Click the Events tab in the bottom window of Account Manager (if it is not already selected).
Result: The list of events booked (past or future) for the current account are displayed.

2. Click on one of the events listed on that tab to select it.

3. Click the Select button , located on the lower right-hand side of the Account Manager screen (or
you may simply double-click your selection).
Result: A confirmation message appears. (If you have made changes to the account, you will be promp-
ted to save those changes before continuing.)

4. Click Yes to confirm your choice.
Result: You will be taken into Event Manager and placed on the event which you selected in Step 2,
above.
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Assigning a Default Payment Method to an Account
You can assign a default payment method for each of your customers, and this payment will automatically be
assigned to every new event they book. (Note: This field is not displayed in Account Manager by default; you
might therefore need to begin with the steps under "Displaying the Pay Method Field," below.)

Displaying the PayMethod Field

1. In Account Manager, click a tab at the top left (General,Miscellaneous) where you want the Pay
Method field to be displayed.

2. Click your right mouse button within the tab and choose Customize.
Result: The Customize window opens.
Note: Do not right-click inside of fields, but rather on the tab itself.

3. On the right-hand side of the Customize window, hold your left mouse button down on the field titled
Pay Method.

4. Drag the field into the tab on the Account Manager window, and place it beneath one of the existing
fields.
Note: It is important to note your cursor's position as you drag this field, as it will be easier to place this
field beneath another field rather than to the right of a field. If you make a mistake, click the Undo but-

ton , located at the top left of the Customize window, and try again.

5. Once the Pay Method field is in position on the tab, release your mouse button.
Result: The Pay Method field has been placed on the form.
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6. Click Close on the Customize window to close the window.

7. Click the Save Current Window Settings button at the top right of the Account Manager window
to save this arrangement as the new default look for the window.

Assigning a Default PayMethod

1. Click the Account Manager button from the Main sidebar to access Account Manager.

2. Locate and retrieve the account for which you wish to assign a default pay method.

3. At the top pane of Account Manager, click the tab that displays the Pay Method field.
Note: This field is not displayed by default; see "Displaying the Pay Method Field," below.

4. Click into the Pay Method field and click the down arrow at the right.
Result: A custom quickpick list of payment methods appear.

5. Click on a specific pay method in the list to select it as the default for all future events booked by this
account.

6. Click the Save Window Settings button at the top right of the Account Manager window to save
this arrangement as the new default.
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Assigning a Default Site Location to an Account
You can assign a default site location for each of your customers, and that location will serve as the default loc-
ation for every new event they book (although you can easily change a site location, should the need arise).

Assigning a Default Site Location

1. Click the Account Manager button from the Main sidebar to access Account Manager.

2. Locate and retrieve the account for which you wish to assign a default site location.

3. On the toolbar at the bottom of the Account Manager, click the Default Site Location button .
Result: The Default Site Location window opens.
Note: As an alternative, you can click the Tools button at the top of the screen and then click Default
Site Location if you have customized your Tools Menu Shortcuts to include Default Site Location.

4. Enter General Site Information, such as Name, Address, etc., by simply typing into each field and press-
ing your [Enter] or [Tab] key to move to the next field.

5. Optionally click into the Directions text block to enter detailed directions to the default site location.

Note: Click the Site Locations Database button to select from your list of frequently used loc-
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ations, or click the Copy From Client button to use this company's address (and optional dir-
ections) as the default location.

6. [Optional] Click the Add to Site Locations Database button to add this location to your program's
default list for future use with other clients or events.

7. When finished, click Close.
Result: The window closes and your changes are saved.
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Combining Duplicate Accounts
When you add a new client in Account Manager, Caterease will automatically warn you if it appears to be a
duplicate of another customer by comparing the name and address (as well as ten-digit phone number) with
other clients in the system. If you do end up adding duplicate accounts, the steps below will combine ALL of
the records of both customers together: contact people, events, etc.

Combining Duplicate Accounts

1. Click the Account Manager button in the Main group of the program's sidebar to access Account Man-
ager.

2. Search for and retrieve the duplicate account which you want to remove from the program.

3. From the Home ribbon tab at the top of your screen, click the Tools button and choose Combine
Accounts.
Result: A confirmation prompt appears.
Note: It is important to be on the record you intend to remove from the program before continuing.

Note: You may need to add this feature to your list of Tools shortcuts. To do so, click Tools > Cus-
tomize and drag Combine Accounts into the Tools Menu Shortcuts pane.

4. Click Yes to confirm.
Result: An account selection window opens.

5. Select an existing account (or add a new one) to which you will reassign all of the events, contact
people, and other details of the client you are removing.
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6. Click OK.
Result: A confirmation message appears.

7. Click Yes to confirm.
Result: The information from your first account (selected in Step 2, above) is moved to your second
account (selected in Step 5, above) and you are prompted to delete the first account from Step 2.

8. Click Yes to delete the first account (selected in Step 2, above).
Result: The account is deleted.
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Printing a Consolidated Billing Statement
1. Click the Home ribbon tab at the top of the screen, if it is not already selected.

2. Click the bottom half of the Prints button, located in the main toolbar at the top of your screen, and
choose Account Manager.

3. Select Billing Statement.
Result: The Billing Statement window opens, listing all parties on record for the customer.
Note: Click into the checkbox at the bottom left of the Billing Statement window to see only events with
a current balance or to have the Billing Statement close after the print preview has been generated.

4. Highlight the records you would like to include in your Billing Statement print.
Note: Hold your left mouse button down and drag over multiple records to highlight, or hold the [Ctrl]
key down to select individual records.

5. Click OK.
Result: A print preview of the Billing Statement is generated, listing details from the parties you selected
in Step 4, above.

6. Click the Print button at the top left of the print preview screen to print.
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In this section, you will learn:

Adding a New Prospect in Prospect Manager
Adding Contact People to a Prospect
Creating Next Actions and Action Dates

Setting a Prospect Status
Establishing a Filter in Prospect Manager

Creating a Prospect Proposal
Printing a Prospect Proposal

Copying a Proposal
Creating an Event from a Proposal
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Adding a New Prospect in Prospect Manager
Prospect Manager allows you to maintain a detailed database of leads, separate from your accounts in Account
Manager. You can track your history with these leads, including your next action and its action date, and then
quickly promote those leads to active accounts whenever they are ready to accept a proposal for an event. Pro-
spect Manager gives you the power to manage your leads from start to finish, in that you have a dynamic
import tool in which to pull customers into the program, and the capability to generate batch prints or e-mails
to market to an entire group of leads.

Tip: Once you have
added your new pro-
spect, you will prob-
ably want to add
information about a
specific contact per-
son.

1. Access Prospect Manager by clicking the Prospect Manager button from the
Main Caterease sidebar.

2. Click the Add Record button , located in the main toolbar at the top of
your Caterease screen.
Result: A confirmation message appears.

3. Click Yes to confirm your choice.
Result: A new prospect record is added, with the default name of "New
Account."
Note: If your new prospective customer is an individual (as opposed to a company), see "Adding a Cus-
tomer Who Is Not a Company," below.

4. Type the name of your new prospect into the Client field, and press [Tab] or [Enter] to move to the
next field.
Result: The name you type replaces the default name "New Account."
Note: You can add, remove, or rearrange fields on this and other areas of the screen.

5. Continue to fill out the fields on the General tab as desired, pressing [Enter] or [Tab] after each one to
move to the next field.
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6. [Optional] On the Miscellaneous tab, located to the right of the General tab, type into a field or click
the down arrow to the right of each field to make a choice from the corresponding quickpick lists.
Note: These fields are used for tracking your prospects, and are entirely optional. Also available (by
default) on this tab is the option to make a client tax exempt by clicking into the Tax Exempt checkbox.

7. [Optional] Click the Directions tab and type into the text block as desired if you wish to include dir-
ections to this prospect's facility.
Note: You may also paste copied directions into the text block.

8. [Optional] Click the Notes tab and type any notes into the text block as desired.

9. [Optional] Click the Picture tab, then right-click within the white text block area and choose Load From
File if you wish to include a digital image to associate with this prospect.
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Adding Contact People
If a prospective customer decides to book an event with your company, you can easily make that prospect into
an active account in Prospect Manager, and all of your contact people and history notes will be transferred into
Account Manager (the main account maintenance module) along with it. Of course, you are always free to add
additional contact people in Account Manager (or in Event Manager) as the need arises.

Adding Contact People to a Prospective Account
Tip: You can click
Copy to Client at
the top left of the
New Contact window
to copy all contact
person details -
name, address,
phone, etc. - to the
client (or prospect),
so you do not have to
type that information
more than once. As a
default, the name
will copy in the
format of Last Name
First Name.

1. Access Prospect Manager by clicking the Prospect Manager button from the
Main Caterease sidebar.

2. Find the prospect to which you wish to add a contact person, or add a new one.

3. Click the Contacts tab, located at the bottom left-hand side of the Prospect
Manager screen, if it is not already selected.

4. Click the Add A New Contact button , located at the right-hand side of the
screen.
Result: The Contact window opens.

5. Type the contact person's last name into the Last Name field, and press [Tab] or [Enter] to move to the
next field.

6. Type the contact person's first name into the First Name field, and press [Tab] or [Enter].
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7. Type the salutation into the Salutation field.
Note: Examples include John, Mr. Smith, Dr. Jones, etc.

8. Click the down arrow to the right of the Title field, and select an option from the drop-down quickpick
list. See "Creating Quickpick Lists for Status, Next Action, and Proposal Status," below.

9. Continue to fill out the fields on the General tab as desired, pressing [Enter] or [Tab] after each one to
move to the next field.

10. [Optional] Click the Credit Card Information button and complete the credit card information for
the contact.

11. [Optional] Click the Notes tab and type any desired notes pertaining to this contact person.
Note: These notes do not print anywhere; they are merely here for your on-screen reference. You can
format the text by highlighting the text, clicking your right mouse button, and choosing Font.

12. [Optional] Click the Picture tab, then right-click within the text block and choose Load From File if you
wish to include a digital image to associate with this prospect.

13. When finished, click OK, located at the bottom of the form, to close the form and save your changes.
Result: The contact person's name appears in the grid.

14. Continue adding contacts as desired.
Note: The first contact person entered is designated as the primary contact.
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Creating Next Actions and Action Dates
When you are prospecting your leads in Prospect Manager, you will want to schedule the next action you need
to take for each of those leads. This Next Action field is a quickpick list you can customize in order to create a
list of common actions and not have to type the same thing more than once. In addition, you can set up a filter
in your Prospect Manager to instantly show you all prospects with a next action date of today (and, for that mat-
ter, your name as a sales rep), all with the click of a button!

Adding Next Actions and Next Action Dates

1. Locate the prospect record you would like to set a next action for, or add a new prospect.

2. Click into the Next Date field, located at the top of the screen, towards the middle.

3. Type a next-action date into the field, or click the down arrow to the right of the field to access a drop-
down calendar.
Note: There are two calendars from which to choose: The first drop-down calendar (to the immediate
right of the Next Date field) drops down the standard calendar view; the second drop-down calendar
(displayed below) indicates the number of next actions that have been set for a particular date.

4. Click the down arrow to the right of the Next Action field and select an option from the quickpick list.

5. Click the Save Changes button , located in the main toolbar at the top of the screen.
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Setting a Prospect Status
You can assign a status to a prospect, using a custom quickpick list of options, so you can track its progression
from lead to account.

Assigning a Status to a Prospect

1. Access Prospect Manager by clicking the Prospect Manager button from the Main Caterease sidebar.

2. Click the Status field, located towards the top right-hand side of the window.

3. Click the down arrow at the far right of the field to choose a status for the prospect from the cus-
tomizable quickpick list.

4. Click the Save Changes button , located in the main toolbar at the top of the screen.
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Establishing a Filter in Prospect Manager
Perhaps at any time you might see more records in your Prospect Manager grid than you really want to look at.
You can instantly (and temporarily) filter out certain records from your grid based on next actions, next action
date, follow-up type, etc.

Establishing a Filter

1. From your main Prospect Manager screen, click the Display Full Grid button , located at the upper
right-hand side of the screen.
Result: Your Prospect Manager opens in full-grid mode.

2. Click the Quick Column Customizing button , located to the left of the Client/Organization field.
Result: A drop-down list of column headings displays.

3. Click the checkbox next to the desired field name, such as Next Action and/or Next Date.

4. Click the funnel at the right of a particular column heading--for example, the column heading labeled
Next Action, and select a snap filter from the drop-down option (or create a custom filter).

Saving a Filter

1. Establish a filter, as outlined above.

2. Click the Filters button, located at the top left-hand side of the Prospect Manager screen.

3. Click Custom.
Result: The Custom Filters window opens.

4. [Optional] Click the Shared button at the bottom of the Custom Filters window if you want this custom
filter to be shared with other users on your Caterease network. (Available if you own the Professional
version of Caterease.)
Note: The User button, selected by default, means this filter is only available under your user name.

5. Click the Add Filter button .
Result: A new filter is added to your list, with the default name "New Filter."

6. Type a name for your new filter into the field.

7. Click the Save Current Filter button .
Result: Your new filter is saved.
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Retrieving a Previously Saved Filter

1. Click the Filters button, located at the upper left-hand side of your main Prospect Manager screen.
Result: The list of custom filters you have created display in a drop-down list.

2. Select the filter from the drop-down list.
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Creating a Prospect Proposal
You can create a detailed proposal in Prospect Manager without needing to make the prospect into an active
client. Basic details, such as theme, date, times, price estimates, etc., can be included, and prints that include
these details can be easily generated.

Filling out the Proposals Tab

1. Access Prospect Manager by clicking the Prospect Manager button from the Main Caterease sidebar.

2. Click the Proposals tab, located near the bottom of the screen.

3. Click the Add A New Proposal button , located on the right-hand side of the screen.
Result: The Proposal window opens, on the General tab.

4. Type the party name into the Party Name field, and press [Tab] or [Enter].

5. Type a theme into the Theme field or click the down arrow to the right of the field to select an option
from the quickpick list.

6. Continue to fill out the General Proposal information as desired by making selections from the drop-
down quickpicks.

7. In the Event Information section, select the proposed event date by clicking the down arrow to the
right of the Date field to access the calendar tool.

8. [Optional] Select a Status from the drop-down list.
Note: Status options can be added through Setup > Quickpicks > Prospect Manager > Proposal Status.

9. Type the time into any Time fields, or click the Time Wizard button to graphically select the desired
times.

10. Type the planned guest count into the Planned or Actual field.

11. Click the Miscellaneous tab, located to the right of the General tab, and make your selections from the
drop-down lists.

12. [Optional] Click into the Notes text block and type any proposal notes, or use the Scratch Pad to insert
pre-formatted text.
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Filling out the Details Tab
1. Click the Details tab, located to the right of the Proposals tab.

Result: The Proposal window opens, and you are positioned on the Food/Service tab.

2.  Click the Display Menus button , located on the right-hand side of the screen, and select food/ser-
vice items.

3. [Optional] Click the Add Menu Item button to add a new proposal item on-the-fly.

4. [Optional] Click the Comments tab, located at the bottom of the window, and enter proposal com-
ments into the text block or retrieve pre-formatted text from the Scratch Pad.

5. When finished, click OK.
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Printing a Prospect Proposal
1. From the Proposal window in Prospect Manager, click the Print button at the top left-hand side of your

screen.

2. Select Proposal.
Result: A Print Preview screen displays.
Note: You may be prompted to save your changes.

3. From the available options at the top of the screen, you may elect to print the document or e-mail the
document., as described in previous sections of this guide.

4. [Optional] Click the Setup button on the Print Preview screen to change the selected printer or the
number of pages or copies.
Result: The Printer Setup window opens, allowing you to change various printer option.
Note: If you perform this step, you must click OK before moving to Step 5, below.

5. Click the Print button from the Print Preview screen.
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Copying a Proposal
If a prospect or active account would like a proposal that consists of almost the same event details as a pre-
vious proposal, you can make a quick copy of the proposal, then make any necessary changes to the new copy.

Copying a Prospect Proposal

1. Access Prospect Manager by clicking the Prospect Manager button from the Main Caterease sidebar.

2. Click the Proposals tab, located near the bottom of the screen.

3. Click on the proposal you would like to copy, from the grid.

4. Click the Copy Proposal button , located on the right-hand side of the screen.
Result: A confirmation prompt appears.

5. Click Yes to confirm.
Result: A copy of the proposal displays.

6. Fill in the proposal details as desired, selecting or adding proposal items.
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Creating an Event from a Proposal
You can create an event directly from a proposal, with the click of a button.

Creating an Event from a Proposal

1. Access Prospect Manager by clicking the Prospect Manager button from the Main Caterease sidebar.

2. Click the Proposals tab, located near the bottom of the screen.

3. Select the proposal that you would like to make into an event by clicking on it in the grid.

4. Click the Create Event From Proposal button , located on the right-hand side of the screen.
Result: A confirmation prompt appears.

5. Click Yes to confirm.
Result: You are placed on Step 2 of the EventWizard.

6. Fill in the event details as desired.

7. When finished, click OK.
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In this section, you will learn:

Creating Contact History Items in Prospect Manager
Creating Reminders in Prospect Manager
Creating a NewReminder in Event Manager

Creating a NewContact History Note in Event Manager
Creating a Contact History Note from an Email

Creating Automatic Reminders
Managing Reminders and History Notes
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Creating Contact History Items in Prospect Manager
You can use Contact History Notes in your Prospect Manager to keep track of conversations and tasks per-
taining to your prospective customers. When you take a phone call, send an e-mail, etc., you can quickly log
that occurrence in a Contact History Note, which will automatically be stamped with the current date and time.
Once that prospective customer becomes an active account, all notes can be managed in Contact Manager and
tracked via prints and reports.

Creating a New Contact History Note from Prospect Manager

1. Access Prospect Manager by clicking the Prospect Manager button from the Main Caterease sidebar.

2. Search for and select the prospect for whom you would like to add a contact history note.

3. Click the New Contact Item button , located at the bottom of your screen, or from the Tools drop-
down list from the Home ribbon tab, depending on your personal configuration.
Result: The Contact Item window opens.

Note: You can also click the Add a New Contact Item button from the Contact History tab.

4. Type a subject into the Subject field, or select a subject from the drop-down quickpick list.

5. Complete the Date field by clicking the down arrow to the right of the field to access the calendar tool.
Note: The current date is populated, by default.

6. Complete the Time field by typing directly into the field or using the up-and-down arrows to adjust the
time.
Note: The current time is populated, by default.

7. Complete the following Contact History Information fields:

l Category -- Type directly into this field or click the down arrow at the right of the field and choose
from the corresponding quickpick list.

l User -- This is the person who performed the task to which this contact history note refers. Accept
the default name or click the down arrow at the right of the field and choose an option from the
drop-down list.

l Contact -- Click the down arrow to the right of the Contact field and select an existing contact or
add a new contact.

8. Type the Contact History action into the Comment text block.
Note: You may also access the Scratch Pad to insert pre-formatted text.
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9.  When finished, click OK.
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Creating Reminders in Prospect Manager
Prospect Manager allows you to create a single next action and its action date and then filter your records so
you can view all actions that are due that day. However, if you want to create reminders that will prompt you
the moment you open Caterease, you can do so if you own the Contact Manager add-in to the program.

Creating a New Reminder

1. Access Prospect Manager by clicking the Prospect Manager button from the Main Caterease sidebar
group.

2. Click the New Reminder button , located on the toolbar at the bottom of the screen, or from the
Tools button at the top of the screen, depending on your personal configuration.
Result: The Reminder window opens.

Note: You may also click the Add a New Reminder button from the Reminders tab.

3. Complete the following information in the Reminder fields.

l Subject: Type a Subject for this reminder, or click the down arrow to the right of the field to select
items from a drop-down quickpick list.

l Location: Type a Location to associate with this reminder, or select from the drop-down quickpick
list.

l Label: Optionally assign a Label to the reminder by selecting an option from the drop-down list of
options.

l Start Date: In the first field to the right of Start, click the down arrow and select a start date from
the drop-down calendar.
Note: The current date is entered by default.

l Start Time/End Time: [Optional] Enter Start and End times by typing directly into the fields or
using the up-and-down arrows to select the times.
Note: The current Start time is entered by default. This time will be displayed with the reminder, but
will not control what time the reminder appears; in other words, a reminder might state you need
to do something at 12:00 p.m., but it will appear when you first open Caterease that day.

l End Date: In the first field to the right of End, click the down arrow and select an end date from the
drop-down calendar.

l Reminder Active: The check mark in the Reminder Active checkbox designates the reminder as act-
ive; removing the check mark makes the reminder inactive. The "Active" times may be adjusted by
clicking the down arrow to the right of the field and choosing from the drop-down list.
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4. Complete the following information in the Reminder Information fields.

l Client: This is the client/organization to which the reminder pertains. You can accept the default or
click the magnifying glass to the right of the field to search for another client/organization.

l Contact: This is the contact person at the company to which this reminder pertains. You can accept
the default or click the down arrow to the right of the field and choose another contact (or edit the
existing one).

l Link: This button will link the reminder to the event you are currently on. You can click the mag-
nifying glass to the right of the field to view the linked event information.

l Category: Type into this field or click the down arrow at the right of the field and choose from the
corresponding quickpick list.

l User: This is the person to be reminded. Accept the default name or click the down arrow at the
right of the field and choose an option from the quickpick list.
Note: Select Everyone if you would like the reminder to be seen by all users.

5. Click into the Message text block and type in the action this reminder is being used for.
Note: You may also access the Scratch Pad to insert pre-formatted text.
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6. When finished, click OK.
Result: The window closes and the reminder has been created.
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Creating a New Reminder from Event Manager
If you own the Caterease Contact Manager add-in, you can create reminders directly from Event
Manager; there is no need to open your Contact Manager.

Creating a New Reminder from Event Manager

1. Access Event Manager by clicking the Event Manager button from the Main sidebar group located on
the left-hand side of your screen.

2. Click the New Reminder button , located at the bottom of the screen.
Result: The Reminder window opens.

3. Complete the following information in the Reminder fields.

l Subject -- Type a Subject for this reminder, or click the down arrow to the right of the field to select
items from a drop-down quickpick list.
(See Unit 5 for information about managing your quickpick lists.)

l Location -- Type a Location to associate with this reminder, or select from the drop-down quickpick
list.

l Label -- Optionally assign a Label to the reminder (Business, Personal, etc.), by selecting from the
drop-down list of options.

l Start Date -- In the first field to the right of Start, click the down arrow and select a start date from
the drop-down calendar.
Note: The current date is entered by default.

l Start Time/End Time -- [Optional] Enter start and end times by typing directly into the fields or
using the up-and-down arrows to select the times.
Note: The current Start time is entered by default. This time will be displayed with the reminder, but
will not control what time the reminder appears; in other words, a reminder might state you need
to do something at 12:00 p.m., but it will appear when you first open Caterease that day.

l All Day Event -- Click into this checkbox if the event is to last the entire day. (Selecting this option
will remove the Start and End times from the window.)

l End Date -- In the first field to the right of End, click the down arrow and select an end date from
the drop-down calendar.

l Show Time As: Optionally select an option from the drop-down list (Free; Tentative; Busy; Out of
Office).

l Reminder Active -- The check mark in the Reminder Active checkbox designates the reminder as
active; removing the check mark makes the reminder inactive. The "Active" times may be adjusted
by clicking the down arrow to the right of the field and choosing from the drop-down list.

l Client -- This is the client/organization to which the reminder pertains. You can accept the default or
click the magnifying glass to the right of the field to search for another client/organization.
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l Contact -- This is the contact person at the company to which this reminder pertains. You can
accept the default or click the down arrow to the right of the field and choose another contact (or
edit the existing one).

l Link -- This button will link the reminder to the event you are currently on. You can click the mag-
nifying class to the right of the field to link the reminder to another event.

l Category -- Type directly into this field or click the down arrow at the right of the field and choose
from the corresponding quickpick list.

l User -- This is the person to be reminded. Accept the default name or click the down arrow at the
right of the field and choose from the drop-down list of options.
Note: Select Everyone if you would like the reminder to be seen by all users.

4. Click into the Message text block and type in the action this reminder is being used for.

Note: You may also access the Scratch Pad to insert pre-formatted text.

Tip: Set up your
Scratch Pad notes
from the Admin-
istration ribbon tab
> Lists > Scratch
Pad.

5. When finished, click OK.
Result: The window closes and the reminder has been created.
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Creating a New Contact History Note from Event Man-
ager
If you own the Contact Manager add-in, you can use Contact History Notes to keep track of conversations and
tasks pertaining to clients or events. When you take a phone call, edit an event, etc., you can quickly log that
occurrence in a Contact History Note, which will automatically be stamped with the current date and time, in
your Event Manager.

Adding a New Contact History Note In Event Manager

1. Access Event Manager by clicking the Event Manager button from the Main sidebar group on the left-
hand side of your screen.

2. Search for and select the account to which you would like to add a contact history note.

3. Click the New Contact History Item button , located in the toolbar on the bottom left-hand side of
your screen (or access this tool from your Toolsmenu, located in the main ribbon tab at the top of your
screen, depending on your personal configuration).
Result: The Contact Item window opens.

4. Type a subject into the Subject field, or select a subject from the drop-down quickpick list. (See Unit 5
for information about managing your quickpick lists.)
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5. Complete the Date field by clicking the down arrow to the right of the field to access the calendar tool.
Note: The current date is populated by default.

6. Complete the Time field by typing directly into the field or using the up-and-down arrows to adjust the
time.
Note: The current time is populated by default.

7. Complete the following Contact History Information fields:

l Category -- Type directly into this field or click the down arrow at the right of the field and choose
from the corresponding quickpick list.

l User -- This is the person who performed the task to which this contact history note refers. Accept
the default name or click the down arrow at the right of the field and choose from the drop-down
list of options.

l Contact -- Click the down arrow to the right of the Contact field and select an existing contact or
add a new contact.

8. Type the Contact History action into the Comment text block.

Note: You may also access the Scratch Pad to insert pre-formatted text.

9. When finished, click OK.

Tip: Set up your
Scratch Pad notes
from the Admin-
istration ribbon tab
> Lists > Scratch
Pad.
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Creating a Contact History Note from an Email
A Contact History Note is a written (or in this case, typed) record of some action you did or conversation you
had related to a certain client. For example, if a customer calls to change the menu for their order, you may
want to make a record of that call for future reference. You are able to keep a record of proposals and con-
tracts directly from your e-mail window.

1. Click the E-mail button at the top of your Event Manager screen.
Note: This button is also available from any Print Preview screen, and will automatically attach
whatever print you are previewing (Contract, Billing Statement, etc.), to the outgoing e-mail.

2. In the To… field, type the e-mail address of the person you want to send your e-mail to, or click the

Address Book button to access a list of e-mail addresses for all contact people associated with this
account.
Note: You can also access the list of e-mail addresses by clicking on the word To at the left of the field.
Note that this list is not your address book from Outlook; rather, it is the list of e-mail addresses you've
entered into Caterease for the contact people of this e-mail recipient.

3. [Optional] In the Cc field, type the e-mail address of the carbon copy recipient here (separate multiple
recipient addresses by semicolons).

4. [Optional] In the Bcc field type the e-mail address of the blind carbon copy recipient here (separate
multiple recipient addresses by semicolons).

5. In the Subject field, type a subject for your e-mail, or click the down arrow to the right of the field to
access a custom quickpick list.

6. Click into the large white text box in the window.

7. Type a message as the body of your e-mail.
Note: If you own theMarketing Tools package, you can use one of your custom merge letters as the
body of your e-mail. These letters will automatically merge in information from the current prospect,
including name, salutation, current date, etc.

8. [Optional] Format the text of your e-mail using the formatting toolbar on your e-mail window.

9. [Optional] Click the Attach button at the top of the e-mail window and choose File to attach a file
(choose Print to attach a print).
Note: Attached files/prints will appear in the small pane at the bottom of the e-mail window.

10. Click the Contact History tab.

11. Type a contact history comment into the Comment field. Comments might include "Emailed
Proposal," "Response to Email about menu change," etc.

12. Type a contact history category into the Category (or select an option from the drop-down quickpick list
to the right of the field).
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13. Click the Auto-Save Email Content button to have Caterease automatically save your e-mail con-
tent; click Auto-Save Email Content > Auto Save Contact History Item Content to automatically save
your email content and log the email as a contact history item.
Note: Click the Save button, located on the upper left-hand side of the window, if you would like to save

the comment as a Contact History item; click the Save Email Content button if you would like to
save the e-mail content of this e-mail message only (without logging a contact history action).

14. Click on the Message tab, located to the left of the Contact History tab, and then click the Save Win-

dow Settings button in order to retain the settings you established in Step 13.

15. When finished, click Send.
Result: The e-mail is sent through your e-mail program (often Outlook), and any files/prints you have
attached are exported.
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Creating Automatic Reminders from Event Manager
If you own the Contact Manager add-in, you can create automatic reminders that will pop up on your screen in
Event Manager on a certain date to remind you to complete a task. These reminders can be linked to event
dates, booked dates, or revised dates.

Creating a New Automatic Reminder from Event Manager

1. Access Event Manager by clicking the Event Manager button from the Main sidebar group located on
the left-hand side of your screen.

2. Click the Administration ribbon tab at the top of the screen.

3. Click the Options button and select Automatic Reminders Setup.
Result: The Automatic Reminders window opens.

4. Click the Add New Auto-Reminder button , located at the top right-hand side of the window.
Result: The Set Auto Reminder window opens.
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5. Click the down arrow at the right of the first field on this screen and choose an action to trigger the cre-
ation of the reminder.

Create a new reminder when the following event occurs:

l  A New Event is Booked 

l An Existing Event is Changed

l  A Deposit is Scheduled

6. Click the days, weeks, or months drop-down list to determine the span of time the program should use
to set the automatic reminder (e.g., a certain number of days, weeks, or months before or after the
event date, booked date, or revised date).

7. Enter a number of days, weeks, or months, and select a date to have the automatic reminder linked to.

8. Click the down arrow to indicate whether the number of days you selected is to occur before or after
the reminder date and time.
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9. Click the down arrow to indicate whether the reminder pertains to Event Date, Booked Date, or
Revised Date.

10. [Optional] Click the down arrow next to Set the reminder for, and select the number of minutes or
hours prior to the reminder time you would like the reminder to display.
Note: This entry will not control what time you see this reminder; it will merely display to inform you
what time the reminder is due to be responded to.

11. [Optional] Complete the following information in the Reminder Detail fields.

l Subject -- Type a Subject for this auto-reminder, or click the down arrow to the right of the field to
select items from a drop-down quickpick list. (See Unit 5 for information about managing your
quickpick lists.)

l Location -- Type a Location to associate with this reminder, or select from the drop-down quickpick
list.

l Label -- Optionally assign a Label to the reminder (Business, Personal, etc.), by selecting the desired
label from the drop-down list of options.

l Category -- Type directly into this field or click the down arrow at the right of the field and choose
from the corresponding quickpick list. Category examples might include "Urgent," "Follow-up," etc.

l Contact -- This is the contact person at the company to which this auto-reminder pertains. You can
accept the default or click the down arrow to the right of the field and choose another contact (or
edit the existing one).

12. [Optional] Click the into the checkbox next to Confirm when created to enable these settings.
Note: "Confirm when created" sets the program to prompt you whenever this automatic reminder is
created for an event.

13. [Optional] Click into the checkbox next to Specific User and click the down arrow to assign this auto-
matic reminder to a particular user.
Note: If this option is not selected, the automatic reminder will be assigned to whichever user triggers
it; meaning the user who adds or modifies the event and causes the reminder to be created.

14. Type the text of your reminder into the Message box, or insert merge fields to dynamically merge
information into the reminder. (See the section below.)

15. When finished, click OK.
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Retrieving Linked Reminder Items into a Manager
You can view a reminder and then retrieve that reminder into aManager, where you can address the task the
reminder has prompted you to complete.

Retrieving Linked Reminders into a Manager

1. Click the Tools sidebar group on the left-hand side of your screen.

2. Click the Active Reminders button.
Result: The Reminder window opens.
Note: If you are logged in as an Administrator, you can elect to see reminders for all users of for indi-
vidual users by clicking the down arrow to the right of the User Name field.

3. Click the Select button at the top left-hand side of the window.

4. Choose which Manager you would like to associate with the reminder. Your list of options will depend
upon which modules you own.
Note: You will be prompted to confirm your choice:

l Into Contact Manager -- This option will open Contact Manager, and positions you on the account
associated with this reminder.

l Into Account Manager -- This option will open Account Manager on the account associated with
this reminder.

l Into Prospect Manager -- This option opens Prospect Manager, and positions you on the record
associated with this reminder.

- 255 -



Unit 18: Creating Reminders and History Notes

l Into Event Manager -- This option will open Event Manager on the event that this reminder is
linked to.
Note: If this option is not available when you click Select, this means that the highlighted (selected)
 reminder is not linked to an event.

l Into GuestroomsManager -- This option will open Guestrooms Manager on the account that this
reminder is linked to.
Note: If this option is not available when you click Select, this means that the highlighted (selected)
reminder is not linked to an existing guestrooms booking.

5. Click OK at the confirmation prompt.
Result: The reminder is retrieved into the Manager you selected.
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Viewing Contact History and Reminders in Event Man-
ager
Caterease Contact Manager lets you keep track of all contact you have had with your clients, including remind-
ers and contact history notes. Contact Manager features are interwoven throughout Caterease, meaning you
are able to view your contact history items directly from Event Manager or Account Manager, without having
to open Contact Manager.

Viewing Contact History from Event Manager

1. Access Event Manager by clicking the Event Manager button from the Main Caterease sidebar group,
located on the left-hand side of your screen.

2. Search for and select an account.

3. Click the Reminders & Contact History button , located at the bottom of the screen, to access the
contact history information.
Result: The Contact History & Reminders window opens.
Note: You may also access this feature from the Tools button, located in the Home ribbon tab at the top
of your screen.

4. Click the Contact History tab.

5. Click on the contact history item you would like to view.
Note: Click into the Current Event Only checkbox at the top of the window if you only want to see con-
tact history related to the current event.

6. Click the View Comment button , located on the right-hand side of the screen.
Result: The contact history note text will display below its date and time details.
Note: Click the View Contact History Comments button again and the note will close.

7. [Optional] Click the Quick Column Customizing button at the top left corner of the grid view and
check off other columns of details to be displayed in the grid.
Result: Any selected column is instantly displayed in the grid.

Viewing Reminders from Event Manager

1. Access Event Manager by clicking the Event Manager button from the Main Caterease sidebar group,
located on the left-hand side of your screen.

2. Search for and select an account.

3. Click the Reminders & Contact History button , located at the bottom left-hand side of your
screen, to access the reminder information.
Result: The Contact History & Reminders window opens.
Note: You may also access this feature from the Tools button, located in the Home ribbon tab at the top
of your screen.
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4. Click the Reminders tab.

5. Click on the reminder you would like to view.
Note: Click into the Current Event Only checkbox at the top of the window if you only want to see
reminders related to the current event.

6. Click the View Reminder Action Items button , located on the right-hand side of the screen.
Result: The reminder note text will display below its date and time details.
Note: Click the View Reminder Action Items button again and the note will close.

7. [Optional] Click the Quick Column Customizing button at the top left corner of the grid view and
check off other columns of details to be displayed in the grid.
Result: Any selected column is instantly displayed in the grid.

Viewing Sent Emails from Event Manager

1. Access Event Manager by clicking the Event Manager button from the Main Caterease sidebar group,
located on the left-hand side of your screen.

2. Search for and select an account.

3. Click the Reminders & Contact History button , located at the bottom left-hand side of your
screen, to access the e-mail information.
Result: The Contact History & Reminders window opens.
Note: You may also access this feature from the Tools button, located in the Home ribbon tab at the top
of your screen.

4. Click the Emails Sent tab.

5. Click on the e-mail you would like to view/edit.
Note: Click into the Current Event Only checkbox at the top of the window if you only want to see e-
mails related to the current event.

6. Click the View Email button , located on the right-hand side of the window, to view the e-mail that
was sent.
Result: The Email window opens.
Note: Use the zoom-in/zoom-out buttons to increase or decrease the size of the e-mail, or click the
down arrow to the right of the Percentage field to select a zoom-in/zoom-out percentage.

7. Click the Preview Email Comments button , located on the right-hand side of the screen.
Result: The e-mail note text will display below its date and time details.

Note: Click the Preview E-mail Comment button again and the note will close.

8. [Optional] Click the Quick Column Customizing button at the top left corner of the grid view and
check off other columns of details to be displayed in the grid.
Result: Any selected column is instantly displayed in the grid. The available fields are described below.
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Field Description
Date The date the contact history item was performed.
Subject The subject of the contact history item.
Sent To The recipient's e-mail address.
CC The e-mail of The person who was carbon copied (Cc'd) in the e-mail.
Attachments The attachment name and type of file.
User The person who sent the e-mail.
Category  The category of the e-mail; examples might include follow-up, confirmation, etc. 
Event # The event number the e-mail is linked to.
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Viewing Reminders in the Scheduler
You can see reminders in a day-at-a-glance, a week-at-a-glance, a custom work-week-at-a-glance, or a month-
at-a-glance display, just like you would in Microsoft Outlook.

Viewing Reminders in the Scheduler

1. Click the Scheduler button from the Main sidebar group, located on the left-hand side of your screen.

2. Click the Display button, located on the Home ribbon tab, and choose Reminders.

3. [Optional] Click the down arrow next to Group By, at the top left of the window, and choose Status,
User, Category, Location, or None.
Note: Administrators are able to view reminders for all users. If you are logged in as a specific user,
only your reminders will appear in the calendar
display.

4. [Optional] Export or synchronize your reminders. See the topic below.
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In this section, you will learn:

Tracking Current Events
Customizing Results Grids

Grouping Grid Data
Saving and Loading Custom Grid Views

Filtering Grid Data
Saving and Loading Custom Grid Filters
Saving and Loading Custom Grid Layouts

Using the Find Panel
Using the Preview Field
Exporting Grid Data

Printing Grids
Generating Batch Emails
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Tracking Current Events
Using the powerful Current Events tool, you can quickly and easily track all upcoming events - or only those in
the next week, two weeks, month, etc. Results are displayed in a detail grid, which can then be customized to
show any information you want and then printed or even exported in a variety of formats.

Tracking Your Current Events
Tip: Click into the
checkbox labeled
Don't Show Win-
dow at the bottom
left of the tool to auto-
matically display
your grid results.
You can quickly edit
your query criteria
at any time.

1. Click the Tools sidebar group, located on the left-hand side of the screen.

2. Click the Current Events button.
Result: The Current Events Base Query window opens.

3. Click the down arrow to the right of the Days Out field and choose how many days out you would like
your search to go.

4. [Optional] Click the down arrow to the right of the Exclude Status field and select any event statuses
you would like excluded from your query.
Note: Placing a check in a box causes the tool to exclude events with that status from your results.

5. Optionally click into the Include Remote Data checkbox (visible only if this feature has been enabled in
your Global Settings) if you would like remote data to be included in your query results.

6. When finished, click OK.
Result: The events matching your criteria are listed in a detail grid.

Tip: Click the SQL
button, located on
the upper right-
hand side of the win-
dow, to edit your
query criteria.
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Customizing Grid Columns

1. At the top left corner of a detail grid, (bottom pane) click the Quick Column Customizing button .
Result: A drop-down list of optional columns appears.

2. Click into the checkbox next to any column heading to have that column appear in the grid.
Result: Any columns with checks next to them appear in the grid.

Note: The Automatically Set Column Widths button , located on the right-hand side of the grid, is
generally enabled by default, meaning that any selected columns will automatically shrink to fit in this
window without the need to scroll horizontally.

3. [Optional] Hold your left mouse button down on a column title in the customization window and drag
up and down to reposition that column in the list of customization options.
Note: You can also drag column headings left and right in the grid itself.

4. Use these details to sort, group, or filter the grid data as described in the topics below.

Sorting Grid Data

1. Click on the heading of a column in a grid to sort by that detail.
Result: Records are sorted in ascending order by that detail.

2. [Optional] Click on the same column heading again to sort by that detail in descending order.

Tip: All grids (begin-
ning with Caterease
Version 16) allow for
sorting in ascending
and descending
order.

3. [Optional] Hold the [Shift] key down on your keyboard and click a second
column heading to sort by an additional detail.
Result: Records are sorted initially by the first detail you selected, then within
that group they are sorted by the second detail.
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Grouping Grid Data
Tip: You can also
use the "Group By
This Field" option to
separate records
into groups by
merely clicking on a
column heading with
your right mouse
button and choosing
Group By This
Field.

1. From a results grid, click the Group By Box button , located at the right of
the detail grid.
Result: A small pane appears across the top of the detail grid with the words
"Drag a column heading here to group by that column."

2. Hold your left mouse button down on the heading of any column and drag that
heading into the pane at the top of the grid.
Result: Grid data is now separated into groups based on your selection.
Note: As an alternative to Steps 1 and 2, you can right-click over a column
heading and choose Group By This Field (not available in Express).

3. Repeat Steps 1 and 2 to create groups within groups.
Result: Records are grouped initially by the first detail you selected, then within that group they are sep-
arated by the second detail.

4. Click the expand button to the left of each group in the grid to display the records in that group.
Result: The group opens and displays its records, including optional footers (group subtotals), where
applicable.

Note: If footers are not visible for each group, click the Grid Tools button , located on the right-
hand side of the window, and choose Show Footer.

5. [Optional] Right-click into the footer of any column in the grid, and choose to show a total "Count" for
that column, or for financial columns choose to show the sum of all values, the minimum value, the
maximum value, or the average value.

6. Click the triangle to the left of any expanded group to collapse that group and hide its contents.
Result: The group closes and hides its records.

- 266 -



Unit 19: Using the Query Tools to Track Business

Note: As an option, you can right-click within a grid and select Expand All or Collapse All to open or
close all groups.

7. Remove groups by dragging column headings from the "Group By Box" pane back into position among
other headings in the grid.
Note: If you have grouped by multiple details, each group heading must be removed individually.
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Saving/Loading Custom Grid Views
Once you have established the grid you want (the columns are displayed the way you want, sorted the way
you want, grouped the way you want, etc.), you can save that custom grid view for future use. Perhaps every
month you're going to want to look at your financial information grouped by sales representative, for example.
Create this grid view once, then save it to be retrieved every month, with just the click of a button. Grid views
can be saved locally (meaning they will only be available under your log-in credentials) or shared across all
Caterease users on your network). Not available in the Express version.

1. Establish a custom grid view, as outlined previously.

2. Click the Views button, located at the top left-hand side of the results grid display.

3. Choose Custom.
Result: The Custom Grid Views window opens.

4. [Optional] Click the Shared button at the bottom of the pop-up window if you want this custom filter to
be shared with other Caterease users.
Note: As a default, the User button is selected, meaning this new filter will only be available for your
use.

5. Click the Add Grid View button.
Result: A new blank line is added to the list.
Note: You can update an existing grid view by right-clicking on its name in the list and choosing Apply
Grid View.

6. Type a name for your new grid view into the field provided.
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7.  Click the Save Current Grid View button .

8. When finished, click the at the top right of the Custom Grid Views window to close it.

9. Switch among saved grid filters by clicking the Views button at the top of the grid and selecting the
name of a previously saved grid view.
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Filtering Grid Data
Tip: You can estab-
lish custom filters by
clicking Custom in
Step 3, above, and
then choosing from
comparison phrases
such as "equals,"
"does not equal,"
"less than," "like,"
etc. When using
"like" to filter for sim-
ilar records, use "_"
as a wildcard to rep-
resent any single
character, and "%"
to represent any
series of characters.
Use the con-
junctions "And" and
"Or" to optionally
establish a second
custom condition.

1. Float your mouse cursor over any column heading in a grid (without clicking).
Result: A down arrow appears at the right of the column heading.

2. Click the filter icon at the right of the column heading.
Result: A drop-down list of options appears.

3. Click into the checkbox next to any option in the drop-down list to filter by that
detail.
Result: The grid updates to show only records matching your selection.
Note: At the bottom of the grid window, the filter(s) you establish are being
stored temporarily while the grid remains open.

4. Repeat Steps 1-3 to filter by additional details as desired.

5. Restore previous filters from this grid session by clicking the filter icon to the right of the filter details
(bottom left corner of the grid) and choosing a different filter from the list.
Note: This list saves filters you have established in this one session of the grid only. See "Saving/Loading
Custom Filters," for information on creating a list of saved filters for frequent use.

6. [Optional] Remove the current filter by clicking the X to the left of the filter name or by clicking the

Clear Query Criteria & Results button , located on the upper right-hand side of the window.
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Customizing Conditions in a Filter
1. Generate a query, such as an Event Query (Queries sidebar > Event Query).

2. Click on the button to add a new condition (search criterion).
Result: A condition will be added, stating "Event # equals <empty>.
Note: To remove a condition added by mistake, click the ellipsis button to the left of the condition and
select Remove Condition.

3. Click on the words Event # in the condition and choose any condition from the drop-down list. This will
be the first condition you search by.

4. Click the equals, next to your condition, and choose any comparison option. Comparisons might say
"Like," "Between," "In," etc.

5. Click <empty> in the condition and choose a value for the condition to be compared to.
Note: These lists are dynamic. If you are searching by Event Theme, then this list will reflect your quick-
pick list of themes. If you are searching by date, this list will reflect days or date ranges. If you are search-
ing by financial fields, a window in which you can type specific values will open.

6. Add as many query conditions as desired by following Steps 2 - 5, above.
Note: You can query records that match one condition or another or records that do not match any
conditions you set. )

7. When finished adding conditions, click the Perform Query button .
Result: Your query results will display in a grid in the lower pane of your screen.
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Saving/Loading Custom Filters
1. Filter the grid data as described above.

2. Click the Filters button at the top of the grid window.

3. Click Custom.
Result: The Custom Filters window opens.

4. [Optional] Click the Shared button at the bottom of the pop-up window if you want this custom filter to
be shared with other Caterease users.
Note: As a default, the User button is selected, meaning this new filter will only be available for your
use.

5. Click the Add Filter button at the top left of the pop-up window.
Result: A new blank line is added to the list.
Note: You can update an existing filter by right-clicking on its name in the list and choosing Apply Filter.

6. Type a name for your new filter.

7. Click the Save Current Filter button .

8. When finished, click the at the top right of the Custom Filters window to close it.
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9. Switch among saved grid filters by clicking the Filters button at the top of the grid and selecting the
name of a previously saved filter.
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Saving Custom Layouts
Tip: Select a custom
layout on-the-fly by
clicking the Layouts
button at the top of
the window and
selecting a layout
name. (Multiple lay-
outs are not avail-
able in Express). If
you want to retrieve
custom window size
and position set-
tings, custom grid
views or custom tool
bar settings with
your saved layout,
select those options
first (Layouts >
Include) before
selecting your cus-
tom layout. If you
want this new layout
to serve as the
default look for the
program, you must
click the Save Win-
dow Settings but-
ton at the top right
of the window. If you
want this to be the
new default look for
all users on your net-
work, click the Set-
tings button at the
top right and choose
Shared> Save Cur-
rent Window.

1. Customize the results grid based on the topics above.

2. Click the Layout button at the top left of grid and choose Custom.
Result: The Custom Layouts window opens.

3. [Optional] Click the Shared button at the bottom left of the window if you
want your new layout to be available to all users on your Caterease network.
Note: User layouts are only available to you as a user (from any computer).

4. Click the Add Layout button , at the top left of the window.
Result: A new line is added to the window with the default name of "New Layout."
Note: You can update an existing layout on the list to show your current screen display by right-clicking
on the layout name and choosing Apply Layout.

5. Type a name for new layout, and click the Save Current Layout button .

6. Click the at the top right of the Custom Layout window to close it.
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Using the Find Panel
Tip: Prior to utilizing
the Find panel,
ensure you have cus-
tomized your grid to
display the desired
columns, as only vis-
ible fields can be
searched.

All queries now have an optional Find panel (Available in Version 16, Professional Ver-
sion).

1. Click the Grid Tools button , located on the right-hand side of the detail
grid.

2. Choose Visible or On Demand.
Note: "Invisible" is the default.

l If "Visible" is selected, the Find panel will display on your screen.

l If "On Demand" is selected, the panel will become visible when the [Ctrl] key and the F key are
pressed simultaneously.

3. Simply begin typing the name of item you are searching for into the field provided and you will be incre-
mentally scrolled to possible matches.
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Using the Preview Field
You can choose any text field as an optional Preview Field (for Notes, Comments, Allergy Information, Modi-
fications, for example), in any of your query grids. (Available in Version 16, Professional Version).

1. Click the Grid Tools button , located on the right-hand side of the detail grid.

2. Click the Preview Field button to expand your list of available fields.

3. Click on the desired option.
Result: The grid will instantly display the text associated with the field you specified.
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Exporting Grid Data
1. Click your right mouse button anywhere within a results grid.

Result: A pop-up menu appears.

2. Select Export Data.
Result: A sub-menu appears.

3. Choose a format for your export: Excel Spreadsheet, Text File, HTML File, XML File or Adobe Acrobat
File (.pdf).
Result: A window appears for you to type a name for your export file.
Note: Certain grids also allow export to Constant Contact or Exact Target (if you own the interface with
those services).

4. Enter a name for the exported file. Note the directory in which the file is being saved.
Note: You can easily change the export directory by clicking the down arrow next to the Save In field at
the top of the window and selecting another directory.

5. Click Save.
Result: A prompt will appear, and your export file has been created.
Note: If you have the Professional version of Caterease, this prompt will offer to open your export file
for you automatically. If you have the Standard or Express version, you will need to open a third-party
application on your own and seek out the export file.
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Printing Grids
Tip: You can option-
ally scale the size of
text on your grid
print to have it bet-
ter fit on the page.

1. Customize the detail grid as described in topics above.

2. Click the Print Grid button , located on the right-hand side of the grid.
Result: A preview of the grid print displays.

3. [Optional] On the print preview screen, click the Page Setup button to adjust paper size/orientation,
margin sizes, header/footer or to scale the size of the printed text (to prevent words or columns from
cutting off) - or the Format button to format title, footnotes, page numbering, or date and time.

4. Click the Print button at the top left of the print preview window to send the grid print to your printer.
Note: As an alternative, you can click the Export to PDF button to save the grid print as a PDF file.

5. When finished, close the print preview window.
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Making Changes to Events in Batch
The Event Query is perhaps the most popular and most powerful query tool Caterease has to offer. You can
make changes to multiple events simultaneously. Quickly and easily change such general details as Sales Rep,
Status, Category, etc., and even change financial details, such as tax rates, service charge, gratuity, etc., with the
click of a button.

Tip: This feature,
which is available to
Standard and Pro-
fessional users, is
also available in the
Current Events
Query, Account
Query, and Accounts
Receivable Query.

1. Click the Queries sidebar on the left-hand side of your screen.

2. Click the Event Query button.
Result: The Event Base Query window opens.

3. Set a Date Range for your query by choosing the option Less Than or Equal To, Greater Than or Equal
To or Within Date Range, or choose a Relative Date Range for the query.

4. Optionally exclude any statuses by selecting an option from the drop-down list to the right of the
Exclude Status field.

5. Optionally click into the Include Remote Data checkbox (visible only if this feature has been enabled in
your Global Settings) if you would like remote data to be included in your query results.

6. Click OK.
Result: The Event Query is generated.

7. Click inside the grid, and press your [Ctrl] key and [A] key simultaneously to highlight all records.

8. Right-click within the grid and choose Batch Processing.
Result: The Batch Processing window opens.

9. Click on the tab on the left-hand side of the window which corresponds with the item or items you
would like to change.
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l General Options: Party Name; Status; Sales Rep; Theme; Reference; Category; Business Type; Oper-
ation: Billing Client; Billing City; Billing State/Province; Billing Postal Code.

l Gratuity Rates: Food; Beverage; Liquor; Equipment; Labor; Room; Other.

l Service Charge Rates: Food; Beverage; Liquor; Equipment; Labor; Room; Other.

l Tax Rates (Tax 1, Tax 2, Tax 3): Food; Beverage; Liquor; Equipment; Labor; Room; Other.

l Miscellaneous Financials: Tax Exempt; Exempt #; Expires. Miscellaneous Adjustments: Subtotal;
Gratuity; Service Charge; Tax 1, Tax 2, Tax 3.

Note: The options above pertain to the Event Query, Current Events Query, and Accounts Receivable
query. (In the Account Query, general options are as follows: Category; Reference; Description; Sales
Rep; Group; Pay Method; Tax Schedule.)

10. Type your desired changes into the fields provided.

11. When finished, click OK.
Result: A confirmation prompt appears.

12. Click Yes.
Result: An informational prompt appears.

13. Click OK.
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Generating a Print for Multiple Events
1. Generate a query, such as an Event Query or Current Events Query.

2. From the query results, select multiple events by holding down your [Shift] or [Ctrl] key while select-
ing.
Note: The [Ctrl] key lets you select individual records; the [Shift] key selects two records and all others
in-between them.

3. Click the top half of the Prints button, located at the top of your screen, in the Home ribbon tab.
Result: The Select Desired Print window opens, where you can select your prints from a floating win-
dow.

4. Select the Prints, Sub-Prints, Documents, or Labels tab.
Note: Batch printing is not available for reports.

5. Click on a print title.

6. Click the Print button at the bottom right-hand side of the window.
Result: A confirmation prompt appears.

7. Click Yes.
Result: One print for each of the selected events will be automatically sent to your printer.
Note: Batch prints do not generate a Print Preview; they are sent to your printer automatically.
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Generating Multiple Prints for Multiple Events
1. Select an event from your results screen, or hold your [Shift] or [Ctrl] key down to select multiple

records.
Note: The [Ctrl] key lets you select individual records; the [Shift] key selects two records and all others
in-between them.

2. Click the top half of the Prints button, located at the top of your screen, in the Home ribbon tab.
Result: The Select Desired Print window opens, where you can select your prints from a floating win-
dow.

3. Click the Multiple button, located on the top right-hand side of the window.
Result: A new panel opens along the right-hand side of the Select Desired Print window.

4. Select the Prints, Subprints, Documents, or Labels tab.
Note: Multiple printing is not available (and not necessary) for reports.

5. Click on a print title.

6. Click the right-arrow button , located in the middle of the Select Desired Print window.
Result: Your selected print title is moved to the panel on the right-hand side of the window.

7. Repeat for other desired prints.

8. Type, into the field on the right-hand side of the pane, the number of prints you would like to generate
for each print.

9. Click the Print button at the bottom right-hand side of the window.
Result: Multiple prints for each of the selected events will automatically be sent to your printer.
Note: Multiple prints do not generate a Print Preview; they are sent to your printer automatically.
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Creating CustomMultiple Print Lists
Once you have established a list of multiple prints to generate, you can save that list for future use. For
example, you can create a custom list of multiple prints called “Back-of-House Prints,” which might consist of
kitchen prints, ingredients lists, required items lists, etc., and then retrieve that list, with a single mouse click.

Tip: If you want all
users on your
Caterease network to
have access to your
custom print list,
click the Shared but-
ton at the bottom of
the window. Local
(User) print lists
are only accessible
on the computer
from which they are
created. (Pro-
fessional Version.)

1. Follow the steps in the section above to select multiple prints to be generated.

2. Click the Multiple Prints button, located at the top right of the Select Desired
Print window.

3. Choose Custom.
Result: The Custom Multiple Prints window opens.

4. [Optional] Click the Shared button, located at the bottom of the Custom Mul-
tiple Prints window, if you want this custom prints list to be shared with other
users on your Caterease network. (Available in the Professional Version of
Caterease.)

5. Click the Add Multiple Prints .
Result: A line, titled "New Multiple Prints," is added to the list.

6. Type the name of your multiple prints list over the words "New Multiple Prints."

7. Click the Save Current Multiple Prints List button .

8. Close the Custom Multiple Prints window by clicking the , located on the top right-hand corner of
the window.
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Generating Batch E-mail
As an ultimate time-saver, Caterease lets you generate an entire batch of e-mails — multiple e-mails to mul-
tiple recipients — with a single mouse click! You can even attach files or Caterease event prints to these e-
mails. For example, you can send an e-mail to all clients that owe you money, and attach a unique invoice to
each one, as a .PDF (or other common format). But what really makes the Caterease e-mail tool stand out is the
ability to use one of your custom Marketing Tools merge letters as the body of your outgoing e-mail! So each
recipient receives their custom event print, attached to an e-mail letter that looks as if it were typed especially
for him, and your fingers never even have to touch the keyboard!

Generating Batch E-Mail

1. From the Current Events query (or other query), select multiple events by holding down your [Shift] or
[Ctrl] key while selecting.
Note: Batch e-mail printing is only available in the Professional version.

2. Click the Email button, located in the Home ribbon tab at the top of your screen.
Result: An Untitled Message window opens.
Note: The e-mail address for this outgoing e-mail will default to the Client E-mail associated with each
selected record.

3. Type a subject for your e-mail into the Subject field. Alternatively, click the down arrow to the right of
the field to access a custom, user-created, quickpick list.

4. Type a message as the body of your e-mail into the large white text box.
Note: If you own theMarketing Tools package, you can use one of your custom merge letters as the
body of your e-mail. These letters will automatically merge in information from the current prospect,
including name, salutation, current date, etc.

5. [Optional] Format the text of your e-mail using the formatting tools in the Basic Text Editing area on
your e-mail window.

6. [Optional] Click the Attach button, located at the top of the e-mail window, and choose File to attach a
different file from your computer, to this e-mail, or choose Print to attach one or several Caterease
event prints.
Note: Attached files and prints appear in the small pane at the bottom of the E-mail window.

7. When finished, click Send.
Result: The e-mails are sent through your E-mail program (often Outlook), and any files you have
attached are exported. Although the e-mails are sent as a batch, all merge fields will populate with the
specific details for each recipient.

- 286 -



Unit 19: Using the Query Tools to Track Business

- 287 -



Unit 19: Using the Query Tools to Track Business

Using Caterease Queries
Caterease offers multiple query tools to track different information in the program. Each tool offers a Base
Query to set the parameters of the search, and then shows results in a detail grid that can be filtered, grouped,
printed, exported, etc. It is important to choose the specific query that is designed for the information you are
looking to track. See the table below for a description of each query.

Query Description
Current Events You can see a complete list of all events scheduled for the next week, two weeks,

month, etc. Options in the base query include Total Current Events; Events Within
Next 7 Days; Events Within Next 14 Days; Events Within Next 21 Days; Events Within
Next 30 Days; Events This Month; Events Next Fiscal Quarter.
Note: You can also include your Remote Data, if desired.

Accounts Receivable This query tracks all events with a date that has passed and a balance still out-
standing. Options in the base query include Total Accounts Receivable; Over 30; Over
60; Over 90; Over 120; 31-60; 61-90; 91-120.

Client Contacts This query tracks all contacts that have been entered into your database. Options in
the base query include records with Only One Primary Contact; Only Contacts with
Events; Only Contacts With All Account Address Fields Filled Out; Only Active
Accounts.

Contacts Made** This query, which pertains to Contact Manager, tracks all of the contact history details
for an account, such as Contact History Subject and type of contact (phone, e-mail,
etc.).

Shift Manager** The Shift Manager query, which pertains to Employee Manager, allows you to manage a
day or date range of multiple shifts at one time. From here you can book employees to
multiple shifts, send out e-mail confirmation requests, and confirm the employee to
work a particular shift.

Event Query The Event Query is perhaps the most popular and most powerful query tool Caterease
has to offer. Using this feature, you can search through your entire database of events
and find only those records that match certain conditions you set. For example, you
could search only those events that take place during a certain date range, or only
those events with a certain theme, or only those events with a certain sales rep-
resentative. You could also search for only those events that take place during a certain
date range and have a certain theme and a certain sales representative. Any inform-
ation you need is available at your fingertips.
Note: You can also include your Remote Data, if desired.

Account Query In addition to querying events, you may want to query your list of customers as well.
For example, you may want to determine how many customers you have who do not
have fax numbers on record with you; or how many customers heard of you from a par-
ticular reference; or how many customers are corporate clients, as opposed to gov-
ernment or educational entities. Options in the base query allow you to Include
Accounts With Events Only or Include Only Accounts With All Address Fields Filled Out
and Exclude On Hold Accounts.

Prospect Query** Your Prospects Query, which pertains to Prospect Manager, helps you separate your
prospective customers (leads) from your active ones. Therefore, this query differs
from the previous one because it also contains your list of prospective customers, so
you can more easily market to them. Options in the base query allow you to Include
Only Prospects With All Address Fields Filled Out or exclude Active Accounts.

Group Booking
Query**

This query, which pertains to Guestrooms Manager, shows all group contracts booked
for a particular day or within a date range.

Payments Query* The Payments Activity Query tracks all payments made to your company during any
day or date range. As in all of our queries, powerful grid tools are available, such as
sorting, filtering, or grouping your data. Thus, you can use this tool to answer such
questions as “Which sales representative has received the most credit card payments
this month?” or “What has been my most common method of payment this year?”
Options in the base query are to Include Only Closed Events or Include Group Booking
Payments.

SubEvent Query* This query is focused on your sub-events, in other words, the individual meals you
have served. For example, you can use this to track how many “Dinner Buffets” you’ve
had during a particular date range or which type of sub-event has generated the most
revenue, etc. Options in the base query allow you to Exclude SubEvents Without Rooms
or Exclude SubEvents Without Site Locations.

Staffing Query* This query, which pertains to Employee Manager, is designed to track all employees
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Query Description
you have booked for any day or date range. As with the other activity queries, you can
sort, group, or filter your data and answer various questions about your employee staff-
ing activity.

Food/Service Items
Query*

The Food/Service Query is a flexible tool that allows you to track any menu items you
have ordered for any day or date range. Using this powerful feature, you can filter,
sort, and group your data to find answers to such questions as, “Which venue has sold
the most rental equipment?” or “Which sales representative is doing the best with this
month’s wine contest?” All food, liquor, equipment, and service item revenue can be
tracked any way you want. Options in the base query allow you to Exclude Items
Without Quantities, Exclude Items Without Totals, or Exclude Modifiers.

Proposal Query* This query, which pertains to Prospect Manager, is a flexible tool that allows you to
track any proposals that you have created for any day or date range.

Guestroom Query* This query, which pertains to Guestrooms Manager, shows the actual rooms (room
dates and types) booked for group contracts; i.e., how many rooms of a particular type
(singles, queens, etc.), have been booked, rate, how many bookings were generated
by a particular sales representative, etc.

Ingredient Query* This query shows all ingredients that are needed for events on a particular day or
within a date range. Options in the base query allow you to Exclude Items Without
Quantities or Include All Sub-Recipe Ingredients.

Required Item
Query*

This query is designed to track all of the required items (packing list items) you will
need for the events on a particular day or within a date range. An available option in the
base query is to Exclude Items Without Quantities.

*Available in the Professional Version
**Available if your own the corresponding add-in module
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In this section, you will learn:

Creating Default Shifts or Positions
Establishing Shift Rules
Adding Employees

Assigning a Position to an Employee
Setting EmployeeWork Schedules and Vacations

Selecting and Managing Staff for an Event
Managing Event Shifts

Customizing the Shift and Employee Grids
Printing a Staffing Sheet for an Event
Printing a Scheduled Shifts Report

Printing an Employee Staffing Schedule
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Creating Default Shifts or Positions
Employee Manager is where you go to establish all the positions or shifts your employees might be scheduled
to work. After adding the position ("Waitstaff," "Bartender," etc.), you can then designate other relative details:
an optional price to charge the customer; an estimated cost to you; default event times; and even event rules
to determine how many employees each position will require.

Adding a Position

You can create and store as many event staff positions as you’d like, such as wait staff, bartenders, host-
s/hostesses, delivery drivers, meat carvers, setup staff, etc., and then assign each position its own set price, uni-
form, or even default shift times.

1. Click the Main button from the Caterease sidebar area, located on the left-hand side of your screen.

2. Click the Employee Manager button.

3. Click the Tools button, located in the Home ribbon tab at the top of the Employee Manager window,

and choose Shift Setup (or click the Shift Setup button , located in the toolbar at the bottom of
your screen, depending on your personal configuration).
Result: The Shift Wizard Setup window opens.

4. Click the Add Position button , located at the top left-hand side of the window.
Result: A confirmation prompt appears.

5. Click Yes to confirm.
Result: A new line is added to the bottom of the Position grid.

6. Type the name of the new position into the Position field, located in the General pane on the right-
hand side of the window.

7. Press [Enter] or [Tab] to move to the next field.

8. [Optional] In the Uniform field, type the name of the uniform or click the down arrow and select an
option from the drop-down quickpick list.
Note: The Employee Manager quickpicks listed here are set up in Setup > Quickpicks > Employee Man-
ager. See "Creating Employee Manager Quickpick Lists" for information about adding quickpicks to
Shifts and Staffing.

9. [Optional] In the Agency field, type the employment agency name (if applicable) or click the down
arrow and select an option from the drop-down quickpick list.

10. [Optional] Click into the Est Cost field and type the estimated cost (per hour) for the position.
Note: You can also enter an estimated shift price by clicking the down arrow and accessing the drop-
down calculator.

11. Click into the Price field and type a default price (per hour) for the shift, or click the down arrow to the
right of the field to access the calculator tool.

12. [Optional] Click into the Flat Rate checkbox to designate the shift price as a flat rate.
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Tip: For more inform-
ation about Est Cost,
Price, and Flat Rate
fields, see the sec-
tion entitled "Cus-
tomizing the Staffing
Grid."

13. [Optional] Set the Default Shift Times by selecting the desired options from
the drop-down lists.
Note: The Default Shift Times are set to the Start and End times associated
with the sub-event.

14. [Optional] Click into the Notes text box and type relevant position notes as
desired.

15. [Optional] Establish any desired shift rules. (See the next topic, "Establishing Shift Rules.")

16. Click the Save Changes button , located at the top left-hand side of the window.
Result: The Position is saved.

17. Click Close to close the window.
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Establishing Shift Rules
Once you’ve created your shift position, you can apply various rules to the shift. Maybe you want to establish a
rule that, whenever you book a wedding, you need to assign one wait-staff for every ten guests. Choose to add
a new shift based on a set number of guests, then apply your shift rule to a certain theme or event category.
Once you add an event, Caterease will apply your shift rules based on the guest count, and will give you the
total required amount of staff needed for the event. (Available in Standard and Professional versions of
Caterease.)

Establishing Shift Rules

1. Click the Main button from the Caterease sidebar area.

2. Click the Employee Manager button.

3. Click the Tools button, located in the main toolbar at the top of your screen, and choose Shift Setup (or

click the Shift Setup button at the bottom of your screen, depending on your personal con-
figuration).
Result: The Shift Wizard Setup window opens.

4. Click on a position in the Position grid, in the left-hand pane, (or add a position, as described
previously).

5. Click the Add Rule button , located at the bottom right-hand side of the Shift Wizard Setup win-
dow, in the Wizard Rules area.
Result: The Shift Wizard Rule window opens.
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6. Click the down arrow in the first field beneath Create a new Wizard Rule that applies to…

l all new events (Select this option to apply the shift rule to all events.)

l events with a theme of

l events with a category of

7. If selecting the Theme or Category option, click the down arrow in the second field and make a selec-
tion from the quickpick list.
Note: The second field is not active for “All new events.”

8. In the Rule For… section, type the number of guests to add for every shift, or use the up-and-down
arrows to adjust the number of guests.

9. [Optional] Click into the checkbox under Options to round the shift count up, if needed.

10. [Optional] Click into the Comments text box and type any desired shift rule comments.

11. Click OK to close the Shift Wizard Rule window.

12. Click the Save Changes button , located at the top of the Shift Wizard Setup window.
Result: The Shift and Shift Rules are saved.

13. Click Close at the bottom of the Shift Wizard Setup window.
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Adding Employees
1. Click the Main button from the sidebar area on the left-hand side of your Caterease screen.

2. Click the Employee Manager button.

3. Click the Add Record button , located in the main toolbar at the top of your Caterease screen, in
the Home ribbon tab.
Result: A confirmation window opens.

4. Click Yes to confirm your choice.
Result: A new employee field is added to the top of the list, with the cursor positioned in the Last field.
Note: The Employee #, located above the Last field, is auto-assigned by Caterease.

5. Type the employee’s last name into the Last field.

6. Press [Enter] or [Tab] to move to the next field.

7. Fill out the remaining General tab fields by typing directly into the fields or by selecting items from the
corresponding drop-down lists (if quickpick items have been added).
Note: Press [Tab] or [Enter] to move from field to field.

8. [Optional] Add any extra fields to your screen, remembering to click the Save Current Window Set-

tings button to save your new default view.
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Filling Out the Address Tab
1. Click the Address tab, located to the right of the General tab, on the main Employee Manager screen.

2. Under Home Address, click into the Address field and type the employee’s home address.

3. Press [Enter] or [Tab] to move to the next field.

4. Continue to complete the home address information by typing into each field and pressing [Enter] or
[Tab] to move to the next field.

5. Under Mailing Address, click into the Address field and type the employee’s mailing address, if dif-
ferent from the home address. (The Mailing Address auto-populates based on the information entered
in the Home Address fields.)

6. Continue to complete the mailing address information by typing into each field and pressing [Enter] or
[Tab] to move to the next field.

- 298 -



Unit 20: Managing Staff for an Event

Adding Additional Employee Information
1. [Optional] Click the Notes tab, located at the top right-hand side of your screen.

2. Click into the text box and type any notes associated with the employee.
Note: You may also access the Scratch Pad to insert pre-typed notes by clicking the Scratch Pad button

, selecting (highlighting) the text, and clicking the Insert Text button.

Tip: Add text to your
Scratch Pad from the
Administration rib-
bon tab > Lists
> Scratch Pad.

3. [Optional] Click the Skills tab, located to the right of the Notes tab, at the top of
your screen.

4. Click into the text box and type employee skills information, or use the Scratch

Pad to insert pre-typed text.
Note: You may format your text in both the Notes and Skills tabs by right-click-
ing into the text box and selecting Font or by using the Basic Text Editing tools at the top left-hand side
of your screen.

5. [Optional] Click the Emergency tab, located at the top right of your screen, then click into the white
text box and enter employee emergency contact information or medical-related information.

6. [Optional] To add a picture of the employee, click into the Picture tab, located at the bottom of your
screen. Next, right-mouse click into the empty text box, select Load From File from the pop-up menu,
then browse to and select a stored employee picture.

7. [Optional] To attach the employee’s supporting documents, such as a scanned image of a driver's
license, click the Application tab, located at the bottom of your screen. Next, right-mouse click into the
text box, select Load From File from the pop-up menu, then browse to and select a stored image.
Note: You can also use the Related Files area to store supporting documents, such as a resume or letter
of recommendation. For more information, see the section on adding employee-related files.
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Assigning a Position to an Employee
Once you’ve entered your basic employee information into Employee Manager, you must assign that
employee a position if you want to be able to select the employee for an event. You can assign an employee
multiple positions and then select the employee for the event according to the desired position you are filling.

Assigning a Position

1. From the Employee Manager main screen, click the Positions tab, located at the bottom of your screen,
if it is not already selected.

2. Click the Select Positions for Employee button , located on the right-hand side of your screen,
towards the middle.
Result: The Select Position window opens.

3. Double-click on a position to select it.
Result: The position is selected, and appears in the Positions tab grid.
Note: You can select more than one position.

4. Click the at the top of the Select Position window to close the window.

5. [Optional] Click into the Uniform field and select the required uniform from the drop-down list.
Note: Uniform information will default if already assigned in the Shift Setup area. Refer to Unit 1.

6. Press [Tab] or [Enter] to move to the next field.

7. Click into the RegWage field and type the employee's regular hourly wage.
Note: You may also click the down arrow to the right of the field to access the drop-down calculator.

8. [Optional] Click into the Overtime field and type the employee's overtime wage.
Note: You may also click the down arrow to the right of the field to access the drop-down calculator.

9. If the wage is a flat rate, click into the Flat checkbox to place a check mark.

10. When finished adding position information, save your changes by clicking the Save Changes button

, located in the Home ribbon tab at the top of your screen.
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Setting a Defined Employee Work Schedule
With Employee Manager, you are able to designate the days and times an employee is unavailable for work.
You can mark an employee as unavailable all day or unavailable within a time range on a given day of the week.
Once these days or time ranges are established, you will be able to view which employees are available (or
unavailable) for an event.

Setting an EmployeeWork Schedule

1. From your Employee Manager main screen, click on the name of the employee whose work availability
you would like to set.

2. From the Tools button, located in the Home ribbon tab at the top of your Employee Manager screen,

selectWork Times, or click the Work Times button , located at the bottom of the screen, depend-
ing upon your personal configuration.
Result: The Enter Weekdays And Times Employee CANNOTWork window opens.

3. Click into aWeekdays checkbox.

4. Click either the All Day or Within Times radio button.
Note: SelectingWithin Timeswill enable access to the Time Ranges From and To fields.

5. IfWithin Times is selected, type a From and a To time.
Note: You are able to set two time ranges per day.

6. Continue establishing days/times the employee is unable to work, as described above.

7. When finished, click OK to close the window.
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Setting Employee Vacation Days
1. From your Employee Manager main screen, click on the name of the employee whose vacation dates

you would like to set.

2. Click the Tools button, located in the Home ribbon tab at the top of your Employee Manager screen,

and select Employee Vacations, or click the Employee Vacations button at the bottom of your
screen, depending upon your personal configuration.
Result: The Employee Vacation Days window opens.

3. Click and hold the left mouse button down on the vacation start date.

4. Drag the mouse to the end date and release the mouse button.

5. Click the Set Selected Dates button from the top left-hand side of the window.
Result: The Save Vacation Days window opens.

- 303 -



Unit 20: Managing Staff for an Event

6. Click either the Off All Day radio button or the Between Times radio button.
Note: If Between Times is selected, the From and To time fields are enabled.

7. [Optional] Click into the Vacation Day Notes text block and type any relevant notes.

8. When finished, click OK.
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Clearing Selected Vacation Dates
1. From your Employee Manager main screen, click on the name of the employee whose vacation dates

you would like to clear (remove).

2. Click the Tools button, located in the Home ribbon tab at the top of your Employee Manager screen,

and select Employee Vacations, or click the Employee Vacations button at the bottom of your
screen, depending upon your personal configuration.
Result: The Employee Vacation Days window opens.

3. Click and hold the left mouse button on the vacation start date you would like to clear.

4. Drag the mouse to the vacation end date you would like to clear.

5. Click the Clear Selected Dates button .
Note: To remove only one vacation day, click on the desired day you would like to clear, and click the

Clear Selected Dates button . To remove all vacation days for a particular employee, see the topic
below.

6. Click the Close button at the top right-hand side of the window to close the window.
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Selecting Event Staff
Tip: In addition to
(or instead of) track-
ing specific employ-
ees, you can also
simply keep track of
"shifts" for an event
(how many
unnamed "waiters"
or "bartenders" the
party will require).
See "Managing
Event Shifts," below,
for more inform-
ation.

1. In the Event Manager, click the Sub-Event button, located next to the Event but-
ton on the left-hand side of your screen.
Result: The Event Manager switches to the Sub-Event display.

2. Select a sub-event (if more than one) in the pane on the left-hand side of your
screen.
Note: The number of sub-events associated with the current event is indicated
at the bottom of the sub-event pane on the left-hand side of the screen. You can
use the scroll bar at the right of the pane or the navigation bar below the pane
to scroll through the sub-events.

3. Click the Staffing tab at the bottom of the screen.

4. Click the Select Staff button , located at the right of the Staffing tab.
Result: The Select Staffing for Event window opens, with employees separated into groups based on
their positions.

5. In the left pane of the window, click the "position," or shift ("Waiter/Waitress," "Bartender," "Bus Boy,"
etc.), that you want to schedule.
Result: The right-hand pane of the window displays the list employees for that specific position.
Note: Employees whose names are printed in red are unavailable to work this event. Click the View Con-
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flicts button on the Select Staff window to see why.

6. Select any available employees (drag your mouse or use your [Ctrl] key to select more than one at a
time).
Note: To select an unavailable employee (one highlighted in red), you must first click the Settings but-

ton at the top right-hand side of the window and choose Staff Selection > Allow Selection of

Unavailable Employees. (Click the Save Window Settings button to have this option default as
enabled.)

7. Click OK.
Result: The selected employees are added to the Staffing tab of the event, with their Start and End times
defaulting to whichever event times you have established as the defaults for their shifts.
Note: As an alternative to clicking OK, you can drag and drop selected employees from the Select Staff
window onto the Staffing tab in Event Manager, or you can click the Select Staff button.

8. [Optional] On the Staffing tab in Event Manager, click into the checkbox in the Conf column for any
employees who have confirmed they can work this party. Click into the checkbox in the Flat column to
optionally make the employee's wage a "flat" wage (not multiplied by hours worked).
Note: To have employees automatically "confirmed" when they are selected into the event, click the Set-

tings button , located at the top right-hand side of the Select Staffing window, and choose Staff
Selection > Select Staff as "Confirmed."
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Managing Event Shifts
Tip: You can use the
Caterease Shift Wiz-
ard to establish
rules dictating how
many of each shift is
required to service a
particular event.
These required num-
bers will auto-
matically calculate
for each party, and
reports and man-
agement tools allow
you track events that
are understaffed.

1. In the Event Manager, click the Sub-Event button, located next to the Event but-
ton on the left-hand side of the screen.
Result: The Event Manager switches to the Sub-Event Display.

2. Select a sub-event (if there are more than one) in the pane on the left-hand
side of the screen.
Note: The number of sub-events associated with the current event is indicated
at the bottom of the sub-event pane on the left-hand side of the screen. You
can use the scroll bar at the right of the pane or the navigation bar below the
pane to scroll through the sub-events.

3. Click the Staffing tab at the bottom of the screen.

4. Click the Select Staff button , located at the right of the Staffing tab.
Result: The Select Staff window opens, with employees separated into groups based on their positions.

5. In the Select Staff window, double-click on any shift ("Waiter," "Bartender," etc.), to retrieve it into the
sub-event.
Result: That shift - complete with optional price, required number, etc. - is added to the Staffing tab in
the sub-event. (See "Customizing the Shift and Employee Grids," below, for information on how to dis-
play these details in your shifts grid.)
Note: You can also highlight multiple shifts by dragging or dropping or using your [Ctrl] or [Shift] key,
then clicking OK to retrieve.

6. Repeat Step 5 to retrieve other shifts as desired.

7. [Optional] Click the View Shift Rules button to see the specific rule (created by you) that the pro-
gram used to calculate the required number for a particular shift.
Note: Shift rules are established by you when you set up your program's shifts.

8. When finished, click OK to close the Select Staff window.

- 308 -



Unit 20: Managing Staff for an Event

Customizing the Shift and Employee Grids
Tip: If you want the
new columns you've
selected to be dis-
played in the staff-
ing grids as a
default, click the
Save Current Win-
dow Settings but-
ton at the top right
of the Event Man-
ager window.

1. Click the Quick Column Customizing button , located at the top left of the Shift
or Employee grid on the Staffing tab.
Result: A drop-down list of optional columns appears.
Note: There are two buttons available, as there are two grids - one for "shifts"
and another for "employees."

2. Click into the checkbox next to any column heading to have that column appear
in the corresponding grid.
Result: Any columns with checks next to them display in the grid.

Note: The Automatically Set Column Widths button on the right-hand
side of the Staffing tab is selected by default, meaning that any selected columns will automatically
shrink to fit in this window without the need to scroll horizontally.

3. [Optional] Hold your left mouse button down on a column heading in the list and drag up and down to
reposition that column in the grid.
Note: You can also drag column headings left and right in the grid itself.

4. Enter information into the new fields.
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Printing a Staffing Sheet for an Event
Tip: You can also
generate a staffing
reports for an entire
day or date range by
clicking the Reports
ribbon tab at the top
of the screen and
choosing Man-
agement >
Employee Staffing
or Management >
Scheduled Shifts.
In addition, you can
run a Staffing Activ-
ity Query (Pro-
fessional version
only) to get more
custom information
in a detail grid dis-
play.

1. With your event open in Event Manager, click the bottom half of the Prints but-
ton in the Home ribbon tab at the top of the screen.
Result: A drop-down list of options appears.
Note: You can also click the top of the Prints button to get a print selection win-
dow, and then choose the Subprints tab and move on to Step 3, below.

2. Click Event Subprints.
Result: Another drill-down list appears.

3. Choose Staffing > Staffing for Event or Staffing > Employee Sign-In Sheet.
Result: A preview window for the print appears.
Note: These prints (and other miscellaneous event sub-prints) can be customized using the Mis-
cellaneous Prints Designer .

4. Click the Print button at the top of the print preview screen to send the print to a printer.
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Tip: As an option,
click the checkbox
labeled Close After
Printing at the bot-
tom left of the tool to
have this window
close automatically
as soon as your
report has been prin-
ted.

Printing a Scheduled Shifts Report
The Scheduled Shifts Report is a powerful tool which allows you to print a schedule of
a shift or all shifts based on a day or date range. You can even choose to display the
name or names of the employees assigned to work the shift, along with additional staff-
ing information. Additionally, the Scheduled Shifts Report will even give you the option
of grouping the report based on selected event information.

Printing a Scheduled Shifts Report

1. Click Reports > Management > Scheduled Shifts.
Result: The Scheduled Shifts window opens.

2. [Optional] Change the title of the report by typing over the words "Scheduled Shifts."

3. Set a date range for your report by choosing the option Less Than Or Equal To, Greater Than Or Equal
To,Within Date Range, or Relative Date Range.

4. [Optional] Exclude an desired statuses by selecting the status from the Exclude Status drop-down list.
Choose from among Closed, Prospective, Tentative, Cancelled, and Definite.

5. [Optional] Group by Date, Shift, Sales Rep, or Client by selecting the respective option from the Group
By drop-down list.
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6. [Optional] Click into the Specific Shift checkbox, then the corresponding down arrow and select a pos-
ition from the drop-down list.

7. [Optional] Click into the Show Staffing Details checkbox to include the assigned employee information.

8. [Optional] Click into the Suppress Fully Booked & Confirmed Shifts checkbox to show only the shifts
that require staffing.

9. Click OK.
Result: The Scheduled Shifts Report is generated, incorporating the parameters you established.
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Tip: As an option,
click the checkbox
labeled Close After
Printing at the bot-
tom left of the tool to
have this window
close automatically
as soon as your
report has been prin-
ted.

Printing an Employee Staffing Schedule
The Employee Staffing Report allows you to print an employee schedule based on a
day or date range for an individual employee or for all employees. Information in this
report includes the assigned position; the event client; the event theme; the assigned
room; the employee start and end times; and the total number of event work hours.
In addition, the report will identify employees that are confirmed to work their
assigned event.

Printing an Employee Staffing Schedule

1. Click Reports > Management > Employee Staffing.
Result: The Employee Staffing window opens.

2. Set a date range for your report by choosing the option Less Than Or Equal To, Greater Than Or Equal
To,Within Date Range, or Relative Date Range.

3. [Optional] Change the title of the report by typing over the words "Employee Staffing."

4. Select from among Employee Staffing Schedule, Employee Staffing Schedule (No Wage Details), or
Employee Diary.
Note: Selecting Employee Diary enables you to print separate employee schedules in diary format
rather than in a grid layout. With diary format, each print will include the event date; the assigned pos-
ition; employee start and end times; the client’s name, address, and phone number; the assigned room;
the confirmed date; and the time, party name, and event theme. Off-premise caterers can choose to
include the site location information, as well.

5. [Optional] Click into the checkboxes under Sort Order and choose to group Staffing items by a certain
detail.
Note: You can drag and drop these fields to customize your sort order.

6. [Optional] Click into the Include Site Directions checkbox if you would like to include the directions to
the site location in the report.

7. [Optional] Exclude any desired statuses by selecting the status from the Exclude Status drop-down list.
Choose from among Closed, Prospective, Tentative, Cancelled, and Definite.

8. [Optional] For an individual employee schedule, click the Specific Employee checkbox, then click the
corresponding down arrow and select an employee.

9. Click OK to generate the report.
Result: The Employee Staffing Report is generated, incorporating the parameters you established.
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In this section, you will learn:

Setting Up Automatic User Notifications
Establishing a Custom Filter

Viewing and Managing Notifications
Enabling and Disabling Notifications
Using the Notifications Backstage Tab
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User Notifications Module
It is extremely important for you and your team to be constantly updated. The incredible Caterease Automatic
Notifications feature not only lets you tell the program what specific changes you or others want to be notified
about, but it also allows you to have those notifications sent to you via e-mail or text.

Setting up Notifications

1. Click the Administration ribbon tab, located at the top of your screen.

2. Choose General > Notifications Setup.
Result: The Notifications Setup window opens.

3. Click the Add Notification button , located in the middle of the window, towards the top.

4. Fill out the information in the Notification Details area:

l Name - Type a Notification Name into the Name field.

l Change In - Choose from the list of options available in the drop-down list to the right of the Change
In field: Events; Sub-Events; Food/Service Items; Shifts; Payments.

l Type - Select Change or New from the Type drop-down list.
Note: "New" is available only if Event or Payment is selected in the Change In field.

l Change Of - Select an option from the Change Of drop-down list.
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Note: Available options depend on what is selected in the Change In field.

l Category - Select an option from the drop-down quickpick list to the right of the Category field.

5. Optionally apply any desired filters by clicking the Filter button and customizing the conditions.
(See "Establishing a Custom Filter," below.)

6. Click the Add User button , in the Notify Users area at the bottom right-hand side of the window.
Result: The Select Users window opens.

7. Double-click on any User Name/Sales Rep who should receive this notification.
Note: You can also highlight multiple users by dragging or dropping or by using your [Ctrl] or [Shift]
key, then clicking Select to retrieve.

8. Click the , located at the upper right-hand side of the window, to close the window.
Result: You are returned to the Notifications Setup window.

9. Click into the Text Msg and/or Email checkbox next to a User Name/Sales Rep to choose which users
will be alerted via e-mail or text message when changes have been made or records have been added.
To receive an alert via text message, the user must be registered with Twilio.

10. Click OK to exit and save your changes.
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Establishing a Custom Filter

1. Click the Filter button , located on the right-hand side of the Notifications Setup window, in the
Condition area.
Result: The Customize Filter Window opens.

2. Click the Click here to add a new condition button.
Result: A new group is created with the default first condition of "Event # equals <empty>."

3. Click the word AND in the line "AND applies to the main query" at the beginning of your new group.
Result: A drop-down list of options appears.

4. Select the desired option: And, Or, Not And, Not Or. Refer to the table below for option descriptions.

Option Description
And This option means the records that result from this query must match the original criteria you

set, and all of the criteria you create in this group.
Or This option means the records that result from this query must match the original criteria you

set, and any one of the criteria you set in this group - either the first condition in the group OR
the second OR the third, etc.

Not
And

This option means the records that result from this query must match the original criteria you
set, but not all conditions in this group. They can match one or another, but NOT the first AND
the second AND the third, etc.

Not Or This option means the records that result from this query must match the original criteria you
set, but not any of the conditions in this group - NOT the first condition in the group OR the
second, etc.

5. Click on the words Event # in the first condition of your new group and choose any condition from the
drop-down list.
Result: You are establishing the first criterion for your query.

6. Click the word "equals" next to your criterion and choose an option.
Result: Your selection replaces the word "equals" in your condition.

7. Click the final word in the condition and choose a value for the condition to be compared to.
Note: Click the Click here to add a new condition button to add additional filters.
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8. Click OK.
Result: The Filter name will display in the Condition area.
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Viewing/Managing Notifications
You can set an initial base query for your notifications for a particular day or date range, and optionally include
notifications that have been viewed. The base query can be changed at any time.

1. Click the Notifications button from the Main sidebar.
Result: A User Notifications Base Query window opens, where you can establish your default base
query.
Note: This window only appears the first time Notifications are accessed; however, you can easily
change your base query, if desired.

2. Set a date range for your query by choosing the option Less Than or Equal To, Greater Than or Equal
To, or Within Date Range, or choose a Relative Date Range for the query.

Tip: If you are an
Administrator, you
can establish which
users will be notified
for each one.

3. Click into the Viewed Notifications checkbox if you want to include viewed
notifications in your query.

4. [Optional] Click into the checkbox labeled Don't Show Window at the bottom
left of the tool to have this window open automatically as soon as your query
has been run.

5. Click OK.
Result: The User Notifications window opens.
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Note: Both panes of
this window are cus-
tomizable. For
example, you can col-
lapse theDetails
section by clicking
theDisplay Full
Grid button and
then clicking the
Show Change but-
ton. You can also
click theQuick
Column Cus-

tomizing button
to add additional
fields to the grid.
(See image below.)

6. To mark a notification as "Viewed," double-click a user name or click the Mark as Viewed button ,
located on the top right-hand side of the window.

Tip: To change your
base query, click the
SQL button, located
at the bottom right-
hand side of the win-
dow.
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Enabling/Disabling Notifications
Users will be notified of any new notifications as they occur. These notifications can be numerous; however, a
Notifications tab has been added in Global Settings, where you can enable/disable program notifications.
(Access from Administration > Settings > Global Settings > Notifications.)
Note: "Pings” have been phased out of Global Settings.
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Deleting Notifications Automatically
You can have Caterease automatically delete notifications after a specified period of time after the date of the
notification, via the Data tab in Global Settings. Simply click into the Automatically Delete Notifications check-
box. You can establish a deletion date by typing the number of days from Notification Date into the field
provided.

Note: This action will delete both Viewed and Un-Viewed Notifications.
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Using the Notifications Sidebar on the Backstage Tab
A Notifications pane has been added to the Backstage tab. This displays the current user’s notifications as they
occur. (Notification Details are located on the right-hand side, while a quick summary, grouped by date, is loc-
ated on the left-hand side of the screen.)
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In this section, you will learn:

Accessing Print Designer
Adding a New Print

Selecting a Print Layout
Editing the Header or Footer of a Print

Selecting Fields on the Print
Customizing and Suppressing General Information

Editing Top and Bottom Notes Sections
Changing Print Fonts
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Accessing the Print Designer
1. Click the Setup sidebar group on the left-hand side of your Caterease screen.

2. Click the Print Designer button.
Result: The Print Designer window opens.
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Adding a New Print
Tip: You can drag
and drop titles into
different positions
on the list, as well.
This will affect their
positions in your
Prints menu.

1. Click the Add Print button , located at the top left-hand side of the Print
Designer window.
Result: A confirmation message appears.

2. Click Yes to confirm your choice.
Result: The Add New (Print Layout) window opens.

3. Click into the Add A New Print checkbox (if it is not already selected).

4. Click on a Layout on the left-hand side of the window to select it.
Note: You can also create a sub-menu. See "Selecting a Print Layout."

5. Click OK.
Result: A new print is added to the bottom of your prints list, and “New Print" is highlighted for you to
type in a new print title.

6. Type a title for your new print.

7. Press [Enter] to save your changes.
Note: This is the title that will appear in your Prints drop-down menu. In other words, this is the title you
will select to generate this print.
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Selecting a Print Layout
In all Print Layouts (except Invoice), you can do the following:

l Customize the header, footer, and top and bottom notes sections, including logo, title, dynamic
merge fields, etc.

l Move or remove specific details within the confines of the print layout, e.g., move “Sales Rep” to
another spot, remove pricing information from the menu section, etc.

l Include or suppress details, such as allergy information; site location information; room and time
information; menu information; ingredients (not available in Layout 1); staffing; sub-event com-
ments; event notes; timeline; financial totals; payment details; future deposit schedule; and custom
notes, to act as terms and conditions.

l Filter the menu section, allowing you to create a print that only displays food, for example, or that
separates appetizers from entrees, etc.

Note: See Appendix A to view samples of the available layouts.

Layout Description Table

Layout Description
Layout 1 Shows the details of each sub-event of a party (times, venue, menu, comments/requests,

staffing) in separate boxes in the middle of the print. All other layouts group all ven-
ues/times together, all menu items together, all staffing together, etc. (Also, this layout
does not allow inclusion of ingredients.)

Layout 2 Shows general event information in two columns at the top of the print, as opposed to in
rows of boxes (as in all other layouts).

Layout 3 Separates menu items for all sub-events into two sides of the print: half on the left and
half on the right. Filters can be established to determine which items appear on which
side of the print.

Layout 4 Does not display details on the left and right sides of the print separately.
Layout 5 Separates menu items on the left and right sides of the print, as in Layout 3, above. Also,

shows sub-event venues/times on the right and sub-event comments on the left.
Layout 6 Separates menu items on the left and right sides of the print, as in Layout 3, above. Also,

shows sub-event venues/times on the right, sub-event comments on the left, bottom
notes (terms and conditions) on the bottom left, and financial details on the bottom right.

Invoice Lay-
out 1

Designed in an “invoice” format rather than in a detailed “contract” format. Lets you show
menu item details in a centered list or include a breakdown of general finances (food
totals, beverage totals, etc.), or both. Also, lets you decide whether or not to include
items without values from the event.
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Layout 1

Client

Schad Associates

Event Date

9/3/2016 (Sat)

Telephone

(612) 944-2153

Fax

(612) 944-0000

Event #

E00463

Address

10230 Tarn Circle

Booking Contact

Norma Schad

Site Contact

Norma Schad

Guests

50 (Pln)

ANY CHANGES TO GUARANTEED GUEST COUNT MUST BE MADE NO LATER THAN 72 HOURS BEFORE EVENT 
DATE.  CANCELLATION CHARGES MAY APPLY.

Venue

Description Type Start End Serving Room Setup Style

Meeting On-Premise 4:00 pm 5:00 pm NA Sea Classroom

Food/Service Items

Food/Service Items Price Qty Total

Wood Grain Podium $25.00 1 $25.00
Projection Screen $10.00 1 $10.00
Comments

Group to move to Sand room for dinner following meeting.

Venue

Description Type Start End Serving Room Setup Style

Dinner Served On-Premise 6:00 pm 7:30 pm 6:00 pm Sand Banquet

Food/Service Items

Food/Service Items Price Qty Total

Chilled Jumbo Shrimp Cocktail  - per 100 $80.00 2 $160.00

Filet with Balsamic Glaze
8 oz. filet browned and cooked in a red wine balsamic glaze for the 
perfect taste.

$31.95 50 $1,597.50

Comments

Client will arrive an hour early to help set-up decoration.

Subtotal Paid $1,000.00 Pay Method Credit Card Card Number$2,017.50

Tax $141.23 Balance $1,475.93 Card Type Expires

Service Charge $317.20 Card Holder

Total Value $2,475.93 Signature

A $200.00 cancellation fee will be incurred for any cancellation within 7 days of event. A $100.00 fee will be incurred for any 
additional setup on the day of the event. I have read the above contract and agree to the terms and conditions.

Client: _________________________________________________ Date:_____________

Sales Rep:______________________________________________ Date:_____________

8/16/2016 - 12:23:02 PM Page 1 of 1
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Layout 2

Client Schad Associates Event Date 9/3/2016 (Sat)
Party Name Schad Associates Event # E00463

Guests 50 (Pln)Address 10230 Tarn Circle
Telephone (612) 944-2153 Booking Contact Norma Schad

Site Contact Norma Schad(612) 944-0000Fax

Sales Rep John Smith Theme Banquet

ANY CHANGES TO GUARANTEED GUEST COUNT MUST BE MADE NO LATER THAN 72 HOURS BEFORE EVENT 
DATE.  CANCELLATION CHARGES MAY APPLY.

Venue
Description Type Start End Serving Room Setup Style

Meeting On-Premise 4:00 pm 5:00 pm NA Sea Classroom

Dinner Served On-Premise 6:00 pm 7:30 pm 6:00 pm Sand Banquet

Food/Service Items
TotalFood/Service Items Price Qty

Meeting - 9/3/2016 - 4:00 pm

$25.00$25.00 1Wood Grain Podium

$10.00$10.00 1Projection Screen

Dinner Served - 9/3/2016 - 6:00 pm

$160.00$80.00 2Chilled Jumbo Shrimp Cocktail  - per 100

$1,597.50$31.95 50Filet with Balsamic Glaze
8 oz. filet browned and cooked in a red wine balsamic glaze for the perfect 
taste.

Comments

Meeting - 9/3/2016 - 4:00 pm

Group to move to Sand room for dinner following meeting.

Dinner Served - 9/3/2016 - 6:00 pm

Client will arrive an hour early to help set-up decoration.

Subtotal Paid $1,000.00 Pay Method Credit Card Card Number$2,017.50

Tax $141.23 Balance $1,475.93 Card Type Expires

Service Charge $317.20 Card Holder

Total Value $2,475.93 Signature

A $200.00 cancellation fee will be incurred for any cancellation within 7 days of event. A $100.00 fee will be incurred for any 
additional setup on the day of the event. I have read the above contract and agree to the terms and conditions.

Client: _________________________________________________ Date:_____________

Sales Rep:______________________________________________ Date:_____________

8/16/2016 - 12:24:45 PM Page 1 of 1
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Layout 3

Client

Schad Associates

Event Date

9/3/2016 (Sat)

Telephone

(612) 944-2153

Fax

(612) 944-0000

Event #

E00463

Address

10230 Tarn Circle

Booking Contact

Norma Schad

Site Contact

Norma Schad

Guests

50 (Pln)

ANY CHANGES TO GUARANTEED GUEST COUNT MUST BE MADE NO LATER THAN 72 HOURS BEFORE EVENT 
DATE.  CANCELLATION CHARGES MAY APPLY.

Venue
Description Type Start End Serving Room Setup Style

Meeting On-Premise 4:00 pm 5:00 pm NA Sea Classroom

Dinner Served On-Premise 6:00 pm 7:30 pm 6:00 pm Sand Banquet

Food & Beverage
Food/Service Items Price Qty Total

Dinner Served - 9/3/2016 - 6:00 pm

$80.00 2 $160.00Chilled Jumbo Shrimp 
Cocktail  - per 100

$31.95 50 $1,597.50Filet with Balsamic Glaze
8 oz. filet browned and 
cooked in a red wine 
balsamic glaze for the 
perfect taste.

Equipment/Miscellaneous
Food/Service Items Price Qty Total

Meeting - 9/3/2016 - 4:00 pm

$25.00 1 $25.00Wood Grain Podium

$10.00 1 $10.00Projection Screen

Comments

Meeting - 9/3/2016 - 4:00 pm

Group to move to Sand room for dinner following meeting.

Dinner Served - 9/3/2016 - 6:00 pm

Client will arrive an hour early to help set-up decoration.

Subtotal Paid $1,000.00 Pay Method Credit Card Card Number$2,017.50

Tax $141.23 Balance $1,475.93 Card Type Expires

Service Charge $317.20 Card Holder

Total Value $2,475.93 Signature

A $200.00 cancellation fee will be incurred for any cancellation within 7 days of event. A $100.00 fee will be incurred for any 
additional setup on the day of the event. I have read the above contract and agree to the terms and conditions.

Client: _________________________________________________ Date:_____________

Sales Rep:______________________________________________ Date:_____________

8/16/2016 - 12:25:25 PM Page 1 of 1
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Layout 4

Client

Schad Associates

Event Date

9/3/2016 (Sat)

Telephone

(612) 944-2153

Fax

(612) 944-0000

Event #

E00463

Address

10230 Tarn Circle

Booking Contact

Norma Schad

Site Contact

Norma Schad

Guests

50 (Pln)

ANY CHANGES TO GUARANTEED GUEST COUNT MUST BE MADE NO LATER THAN 72 HOURS BEFORE EVENT 
DATE.  CANCELLATION CHARGES MAY APPLY.

Venue
Description Type Start End Serving Room Setup Style

Meeting On-Premise 4:00 pm 5:00 pm NA Sea Classroom

Dinner Served On-Premise 6:00 pm 7:30 pm 6:00 pm Sand Banquet

Food/Service Items
Food/Service Items Price Qty Total

Meeting - 9/3/2016 - 4:00 pm

$25.00 1 $25.00Wood Grain Podium

$10.00 1 $10.00Projection Screen

Dinner Served - 9/3/2016 - 6:00 pm

$80.00 2 $160.00Chilled Jumbo Shrimp Cocktail  - per 100

$31.95 50 $1,597.50Filet with Balsamic Glaze
8 oz. filet browned and cooked in a red wine balsamic glaze for the perfect 
taste.

Comments

Meeting - 9/3/2016 - 4:00 pm

Group to move to Sand room for dinner following meeting.

Dinner Served - 9/3/2016 - 6:00 pm

Client will arrive an hour early to help set-up decoration.

Subtotal Paid $1,000.00 Pay Method Credit Card Card Number$2,017.50

Tax $141.23 Balance $1,475.93 Card Type Expires

Service Charge $317.20 Card Holder

Total Value $2,475.93 Signature

A $200.00 cancellation fee will be incurred for any cancellation within 7 days of event. A $100.00 fee will be incurred for any 
additional setup on the day of the event. I have read the above contract and agree to the terms and conditions.

Client: _________________________________________________ Date:_____________

Sales Rep:______________________________________________ Date:_____________

8/16/2016 - 12:26:14 PM Page 1 of 1
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Layout 5

Client

Schad Associates

Event Date

9/3/2016 (Sat)

Telephone

(612) 944-2153

Fax

(612) 944-0000

Event #

E00463

Address

10230 Tarn Circle

Booking Contact

Norma Schad

Site Contact

Norma Schad

Guests

50 (Pln)

ANY CHANGES TO GUARANTEED GUEST COUNT MUST BE MADE NO LATER THAN 72 HOURS BEFORE EVENT 
DATE.  CANCELLATION CHARGES MAY APPLY.

Food & Beverage
Food/Service Items Price Qty Total

Dinner Served - 9/3/2016 - 6:00 pm

$80.00 2 $160.00Chilled Jumbo Shrimp 
Cocktail  - per 100

$31.95 50 $1,597.50Filet with Balsamic Glaze
8 oz. filet browned and 
cooked in a red wine 
balsamic glaze for the 
perfect taste.

Equipment/Miscellaneous
Food/Service Items Price Qty Total

Meeting - 9/3/2016 - 4:00 pm

$25.00 1 $25.00Wood Grain Podium

$10.00 1 $10.00Projection Screen

Venue
Start Serving EndRoom Setup Style

4:00 pm NA 5:00 pmSea Classroom

6:00 pm 6:00 pm 7:30 pmSand Banquet

Comments

Meeting - 9/3/2016 - 4:00 pm

Group to move to Sand room for dinner following meeting.

Dinner Served - 9/3/2016 - 6:00 pm

Client will arrive an hour early to help set-up decoration.

Subtotal Paid $1,000.00 Pay Method Credit Card Card Number$2,017.50

Tax $141.23 Balance $1,475.93 Card Type Expires

Service Charge $317.20 Card Holder

Total Value $2,475.93 Signature

A $200.00 cancellation fee will be incurred for any cancellation within 7 days of event. A $100.00 fee will be incurred for any 
additional setup on the day of the event. I have read the above contract and agree to the terms and conditions.

Client: _________________________________________________ Date:_____________

Sales Rep:______________________________________________ Date:_____________

8/16/2016 - 12:27:33 PM Page 1 of 1
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Layout 6

Client

Schad Associates

Event Date

9/3/2016 (Sat)

Telephone

(612) 944-2153

Fax

(612) 944-0000

Event #

E00463

Address

10230 Tarn Circle

Booking Contact

Norma Schad

Site Contact

Norma Schad

Guests

50 (Pln)

ANY CHANGES TO GUARANTEED GUEST COUNT MUST BE MADE NO LATER THAN 72 HOURS BEFORE EVENT 
DATE.  CANCELLATION CHARGES MAY APPLY.

Food & Beverage
Food/Service Items Price Qty Total

Dinner Served - 9/3/2016 - 6:00 pm

$80.00 2 $160.00Chilled Jumbo Shrimp 
Cocktail  - per 100

$31.95 50 $1,597.50Filet with Balsamic Glaze
8 oz. filet browned and 
cooked in a red wine 
balsamic glaze for the 
perfect taste.

Equipment/Miscellaneous
Food/Service Items Price Qty Total

Meeting - 9/3/2016 - 4:00 pm

$25.00 1 $25.00Wood Grain Podium

$10.00 1 $10.00Projection Screen

Venue
Start Serving EndRoom Setup Style

4:00 pm NA 5:00 pmSea Classroom

6:00 pm 6:00 pm 7:30 pmSand Banquet

Comments

Meeting - 9/3/2016 - 4:00 pm

Group to move to Sand room for dinner following meeting.

Dinner Served - 9/3/2016 - 6:00 pm

Client will arrive an hour early to help set-up decoration.

Financial Information

Subtotal Paid $1,000.00$2,017.50

Tax $141.23 Balance $1,475.93

Service Charge $317.20

Total Value $2,475.93

Terms & Conditions

A $200.00 cancellation fee will be incurred for any 
cancellation within 7 days of event. A $100.00 fee will be 
incurred for any additional setup on the day of the event. I 
have read the above contract and agree to the terms and 
conditions.

Client: ______________________   Date:_____________

Sales Rep:___________________   Date:_____________

8/16/2016 - 3:04:49 PM Page 1 of 1
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Editing the Header or Footer of a Print
Tip: You can copy an
entire header or
even individual sec-
tions to all your
other Print Designer
prints by clicking
the down arrow to
the right of the Edit
Header button on
the Print Designer
screen and selecting
the specific part
(Entire Header, Left,
Center, or Right) you
want to copy. Also,
be sure to use the
Print Type field at
the bottom right of
Print Designer to
identify this print as
a "Con-
tract,""Invoice," or
"BEO." This way,
Caterease can auto-
matically keep track
of the date you gen-
erate each print.

1. In Print Designer, click the Edit Header (top right) or Edit Footer (bottom left)
button.
Result: The Header or Footer window opens, with three panes to optionally sep-
arate information.

2. [Optional] Stretch or shrink any pane by holding your left mouse button down
on the inside frame and dragging left or right.
Note: You can also set all three panes to equal widths by clicking the Tools but-
ton at the top of the Header/Footer window and choosing Set Equal Widths.

3. Click into any pane and type as desired, using the toolbar at the top of the window to format text, cen-
ter, or right-justify, etc.

4. [Optional] Insert images (logos, pictures, etc.), by clicking the Insert button at the top of the window
and choosing Image, then browsing to the image you want to insert.
Note: Images can be placed into any pane in the Header/Footer, and can be justified (left, center, right)
just like text. Previously placed images can be saved to your hard drive by right-clicking and choosing
Save to File.

5. [Optional] Insert merge fields (to dynamically merge information from the event, such as the event

number, revised date, etc.), by clicking the Fields button , located at the top of the window, expand-
ing a category of fields, then double-clicking a specific field.

6. [Optional] Click in the Hyperlink field at the bottom of the Header/Footer window and enter a URL
(web address) to attach to this areas of the print.
Note: When you e-mail this print, the recipient can click any part of this header or footer and be sent to
the designated web address.

7. [Optional] Adjust the desired height for your Footer by clicking the up-and-down arrows to increase or
decrease the height, respectively.
Note: Footer heights can range from .5" through 3" (or 1 cm through 8 cm if Metric has been enabled
in your Global Settings).
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Adding an Image/Logo to the Header
A logo is the identifying element for the brand of a company, and is designed to create immediate recognition.
Adding your company logo to a print could not be easier.

1. From a print in Print Designer or Miscellaneous Print Designer, click the Edit Header button.

2. Click on the pane within the header where you would like your logo/image to appear.

3. Click the Insert button, located at the top of the Header window, and select Image.
Note: Alternatively, you may right-click inside the pane and choose Insert > Image.

4. Browse to the image you want to insert.

5. Double-click the image to insert it into the pane.
Note: Images can be justified (left, right) or centered, just like text.

6. Click the Close button to close the window.
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Inserting Merge Fields into the Header
Merge fields are dynamic fields that automatically merge specific information from a particular customer or
event. For example, you could type the words “Last Revised On:” followed by a merge field that pulls an
event’s revision date. Then, when you generate that print from any event, the merge field will automatically
insert the specific revision date of that particular party. It’s a great way to make your various prints look cus-
tom-created each time you generate them.

1. In Print Designer, click the Edit Header button.
Result: The Header window opens.

2. Click on the pane within the header where you would like your merge fields to appear.

3. Type any text you want to precede your merge field.
Note: You may want to identify the merge field for the person reading the print; for example, "Revised
Date," "Party Name," etc.

4. Click the Fields button , located towards the top right-hand side of the text window.
Result: The Fields Explorer window opens.

5. Click the expand button (triangle) to the left of the group of merge fields you want to access.
Result: The selected group expands, showing all related merge fields.

Note: As an option, click the Full Expand button , located at the top of the Fields Explorer window,
to expand all categories of merge fields at once.
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6. Select the field you want to insert, and either double-click it or drag and drop it into the text window.
Result: Double-clicking a merge field inserts it where the cursor currently resides, whereas dragging
and dropping a field allows you to place it anywhere.

7. Continue this process until you have entered all of your desired merge fields.

8. Close the window, and then click the Save Changes icon on the subsequent screen.
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Customizing and Suppressing General Information
Tip: Be sure to use
the Print Type field
at the bottom right
of Print Designer to
identify this print as
a "Con-
tract,""Invoice," or
"BEO." This way,
Caterease can auto-
matically keep track
of the date you gen-
erate each print. For
more information,
see "Identifying the
Print Type for the
Program," in Unit 5.

1. In the Print Designer window, click the down arrow to the right of any field in a
print to choose a different detail to appear there.
Note: General event details, site location information, venue and time details,
etc., can be removed or rearranged in this way.

2. Choose to suppress various sections of the print by clicking the corresponding checkbox, most of which
are located along the right-hand side of the Print Designer window, next to a specific section of a print.
Note: Float your mouse pointer over any checkbox for a tool tip identifying its corresponding section; in
most cases, a check in a box causes a section to be suppressed on the print.

3. [Optional] Click into the gray "heading" box of any section and type a different heading, if desired.
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Editing Top and Bottom Notes Sections
1. In Print Designer, click the Edit Top Notes (top left) or Edit Bottom Notes (bottom left) button.

Result: The text block for the selected section appears, with two panes to optionally separate inform-
ation.

2. [Optional] Stretch or shrink either pane by holding your left mouse button down on the inside frame
and dragging left or right.
Note: You can drag this frame all the way to one side if you only want one pane of information. You
can also set the panes to equal widths by clicking the Tools button at the top of the window and choos-
ing Set Equal Widths.

3. Click into either pane and type as desired, using the toolbar at the top of the window to format text,
center or right-justify, etc.

4. [Optional] Insert images (logos, etc.) by clicking the Insert button at the top of the window and choos-
ing Image, then browsing to the image you want to insert.
Note: Images can be placed into either pane, and can be justified (left, center, right) just like text. Pre-
viously placed images can be saved to your hard drive by right-clicking and choosing Save to File.

5. [Optional] Insert merge fields (to dynamically merge information from the event, such as the event

number, revised date, etc.), by clicking the Fields button at the top of the window, expanding a cat-
egory of fields and then double-clicking a specific field.
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Changing Print Fonts
1. Click the Tools button at the top of the Print Designer window and choose Print Fonts.

Result: The Fonts window opens.

2. Choose a different font style and/or size for various areas of the print.
Note: The Font Preview section at the bottom of the window will update to reflect your changes.

3. When finished, click OK.
Result: The Font window changes, but the preview in Print Designer will NOT reflect your new font selec-
tions.
Note: To review your new fonts, save the print and click the Preview button at the top of the Print
Designer window. (Remember, you must have an event open in Event Manager in order to preview a
print.)
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In this section, you will learn:

Adding a NewMerge Document
Adding Merge Fields to a Document

Using Formatted Date Fields
Inserting a Table into a Document

Using Merge Tables to Insert Menu Items, Payments, Etc.
Using Nested Tables to Arrange Information in a Document





Unit 23: Creating Merge Documents in Marketing Tools

Adding a New Document or Envelope
Tip: For long lists of
merge documents,
see "Organizing
Documents into
Groups."

1. Click the Setup sidebar on the left-hand side of your screen and choose Mar-
keting Tools.
Result: TheMarketing Tools window opens.
Note: As an option, you can click the Administration ribbon tab at the top of
your screen and choose Prints > Marketing Tools.

2. Click the Add Record button , located in the Home ribbon tab at the top of your screen.
Result: A confirmation prompt appears.

3. Click Yes to confirm your choice.
Result: A new blank document is added to the bottom of your Documents list, with your cursor posi-
tioned in the "New Document" field.

4. Type a name for your new document and press your [Enter] key.
Result: Your new document name is saved.

5. Click into the blank document and type as desired, inserting merge fields as described in subsequent
topics.

6. [Optional] Click the Setup button in the Home ribbon tab at the top of your screen and choose Page
Setup to change paper size, margins, and orientation (for envelopes or other custom documents).
Note: "Landscape" orientation is typically preferable for envelopes.
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Adding Merge Fields to a Document
1. Click into aMarketing Tools document.

2. Click the Insert Merge Fields button , located on the upper left-hand side of the window. (Or you
may access this button from the Toolsmenu at the top of your screen, in the Home ribbon tab.)
Result: The Fields Explorer window opens.
Note: If you plan to insert several merge fields, you may want to leave this window open and even drag
it out of the way so you can see your print underneath.

3. Click the expand button to the left of a particular category of fields, e.g., Event Fields, Financial Fields,
etc., to expand the fields.
Result: The selected category opens to show all related fields.

Note: As an option, click the Full Expand button , located at the top of the Fields Explorer window,
to expand all categories of merge fields at once.

4. Select a merge field, and insert in one of the following ways:

l Hold your left mouse button down on the field, drag it into any position on your document, envel-
ope, or comments/notes section, and release.

l Double-click the selected field to drop it in the current cursor position (where your cursor is cur-
rently positioned).

l Click the Select button to drop the field in the current cursor position.
Note: Comments and notes that have been typed into text blocks within your Event Manager can
also be included as merge fields, by selecting Comments (Unformatted), Event Notes (Unformatted),
Site Directions (Unformatted), etc.
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Using Formatted Date Fields
1. Click inside the document to place your cursor where you want the merge field to be inserted.

2. Click the Insert Merge Fields button , located on the upper left-hand side of your screen. (Or you
may access this button from the Toolsmenu at the top of your screen, in the Home ribbon tab.)

3. Click the expand button to the left of Event Fields (for Event Date Formatted or Booked Date For-
matted) or Special Fields (for Current Date Formatted).

4. Select the desired merge field, and insert it in one of the following ways:

l Double-click the selected merge field to drop it into the current cursor position (where your cursor
currently resides).

l Hold your left mouse button down on the field, drag it into any position on your document, envel-
ope, or comments/notes section, and release.

l Click the Select button to drop the merge field into the current cursor position.

5. Format the date field by editing the “mmmm,” “d,” “y,” and number within the brackets, using the
options listed in the table below.

Symbol Description
d Displays the date as a number without a leading zero (1-31).
dd Displays the date as a number with a leading zero (01-31).
ddd Displays the day as an abbreviation (Sun-Sat).
dddd Displays the day as a full word (Sunday-Saturday).
m Displays the month as a number without a leading zero (1-12).
mm Displays the month as a number with a leading zero (01-12).
mmm Displays the month as an abbreviation (Jan-Dec).
mmmm Displays the month as a full name (January-December).
y Displays the year as a four-digit number.
(0) Change this number to add or subtract days from the merged date. (A positive number will add

days; a negative number will subtract days.)
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Available Merge Fields
The following fields are available to be inserted anywhere in merge documents (created in Marketing Tools),
or in various text boxes available on prints created in Print Designer and Miscellaneous Print Designer.

Account Merge Fields

Use the following merge fields to pull information pertaining to your customers:

Field Description
Client/Organization Merges in the name of customer holding the currently selected event.
Address Merges in the selected customer’s address.
Address 2 Merges in the selected customer’s secondary address, if one has been added to the

Address (Other) field. Note: This field is not displayed on your screen by default, but
you can easily add it to your screen.

City Merges in the selected customer’s city.
St/Prov Merges in the state or province the selected customer is from.
Postal Merges in the selected customer’s postal/ZIP code.
City, St/Prov Postal Merges in these three details in City, State/Province, ZIP Code order. This field elim-

inates the need to select each field sepa-rately when they are commonly used in con-
junction with one another (in letters and such).

Telephone Merges in the selected customer's telephone number.
Fax Merges in the selected customer's fax number.
Reference Merges in the reference that is attached to the customer. Note: This is different from

the reference that is attached to an event reference; this reference is entered into the
account details, and indicates how this customer originally heard of your company.

Sales Rep Merges in the sales representative who is associated with this account. See note under
Refer-ence, above.

Sales Rep Tele-
phone

Merges in the telephone number associated with the sales representative who
is associated with this account. See note under Reference, above.

Sales Rep Cellular Merges in the cell phone number associated with the selected account's sales rep-
resentative. See note under Reference, above.

Sales Rep Email Merges in the e-mail address associated with the selected account's sales rep-
resentative. See note under Reference, above.

Category Merges in the category (e.g., "Corporate," "Educational," "Government," etc.), that is
associated with the selected account. This is a quickpick list you can customize for
tracking your customers. See note under Reference, above.

Description Merges in this customer’s description (e.g., "Association Member," "Chamber Mem-
ber," etc.). This is a quickpick list you can customize for tracking your customers.

Email Merges in the customer’s e-mail address. Note: This is the address attached to the cus-
tomer itself, such as info@acme.com, not to a particular contact person.

Website Merges in the customer’s web address. Note: This field is not displayed on your screen
by default, but you can easily add it to your screen.

Cellular Merges in the cell phone number on file for this customer.
Group Merges in the group of this customer. This is a quickpick list you can customize and

use to group related customers together. Note: This field is not displayed on your
screen by default, but you can easily add it to your screen.

Account # Merges in the account number automatically assigned to this customer by the program.
Note: This field is not displayed on your screen by default, but you can easily add it to
your screen. You can establish a unique prefix for these numbers up to three char-
acters long (through Administration > Settings > Global Settings > Managers).

Account ID # Merges in this customer’s Account ID #. This is a field you can customize. Note: This
field is not displayed on your screen by default, but you can easily add it to your screen.

Loyalty # Merges in the loyalty number associated with the client. Note: This field is not displayed
on your screen by default, but you can easily add it to your screen.

- 350 -



Unit 23: Creating Merge Documents in Marketing Tools

Contact Merge Fields

Use the following merge fields to pull information pertaining to the primary (first) contact person listed for a
customer:
Note: To include information pertaining to the contact person of an event, use the Booking/Site Contact merge
details under "Event Fields."

Field Description
Name Merges in the first name and last name of the primary (first) contact associated with the client.
Last Merges in the last name only of the primary contact associated with the client.
First Merges in the first name only of the primary contact associated with the client.
Title Merges in the title of the primary (first) contact associated with the client; e.g., “Owner,” “General

Manager,” etc. This is a quickpick list you can customize.
Salutation Merges in the salutation of the primary (first) contact associated with the client; e.g., “Tom,” “Mr.

Smith,” “Mrs. Johnson,” etc. Note:  Salutations are generally created to come at the beginning of a
merge letter, between the word “Dear” and the comma.

Address Merges in the address of the primary (first) contact associated with the client.
Address 2 Merges in the second address of the primary (first) contact associated with the client, if a second

address has been entered into the Address (Other) field.
City,
St/Prov
Postal

Merges in these three details of the primary (first) contact in this order; meant to eliminate the
need to select each field separately when they are commonly used in combination (in letters and
such).

Event Merge Fields

Use the following merge fields to pull information pertaining to an event:

Field Description
Event Date (Long) Merges in the date the event is being held in the format established by your computer’s

Regional Settings, usually set up as “Saturday, August 29, 2015.”
Event Date (Short) Merges in the date the event is being held in the format established by your computer’s

Regional Settings, usually set up as “August 29, 2015.”
Event Date Merges in the date the event is being held, in the format “8/29/2015.”
Event Date For-
matted

Merges in the date of the event and allows you to format it any way you want.

Event Weekday Merges in the full name of the day of the week that the event takes place, in the format
“Sunday,” “Monday,” etc.

Event Weekday
(Abbr)

Merges in the first three letters of the day of the week that the event takes place, in the
format “Sun,” “Mon," etc.

Event Month Merges in the full month name that the event takes place, in the format “August,”
“September,” etc.

Event Month (Abbr) Merges in the first three letters of the month that the event takes place, in the format
“Aug,” “Sep,” etc.

Event Begin Date Merges in the date of the event's earliest sub-event.
Event End Date Merges in the date of the event's latest sub-event.
Event Begin Time Merges in the overall event's start time.
Event End Time Merges in the overall event's end time.
Event Status Merges in the status of the event, e.g., Prospective, Tentative, Definite, etc.
Planned Guests Merges in the planned guest count of the event.
Actual Guests Merges in the actual guest count of the event.
Guaranteed Guests Merges in the guaranteed guest count of the event.
Party Name Merges in the party name of the event. e.g., "Smith Wedding Reception," "Jones Birth-

day Party," etc.
Booking Contact Merges in the first name and last name of the booking contact of the event.
Booking Contact
First

Merges in the first name of the booking contact of the event.
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Field Description
Booking Contact
Last

Merges in the last name of the booking contact of the event.

Booking Contact
Title

Merges in the title of the booking contact of the event; e.g., “Owner,” “General Man-
ager,” etc. This is a field you can customize.

Booking Contact
Salutation

Merges in the salutation of the booking contact of the event; e.g., “Tom,” “Mr. Smith,”
“Mrs. Johnson,” etc. Note: Salutations are generally created to come at the beginning
of a merge letter, between the word “Dear” and the comma.

Booking Contact
Telephone

Merges in the specific telephone number belonging to the booking contact of the event.
Note: This will likely be different from the general phone number belonging to the cus-
tomer.

Booking Contact Fax Merges in the specific fax number belonging to the booking contact of the event. See
note under Booking Contact Salutation, above.

Booking Contact Cel-
lular

Merges in the specific cell phone number belonging to the booking contact of the
event. See note under Booking Contact Salutation, above.

Booking Contact
Email

Merges in the specific e-mail address belonging to the booking contact of the event.
See note under Booking Contact Salutation, above.

Booking Contact
Address

Merges in the specific address belonging to the booking contact of the event. See note
under Booking Contact Salutation, above.

Booking Contact
City, St/Prov,
Postal

Merges in these three details in City, State/Province, ZIP Code order. See note under
Booking Contact Salutation, above.

Site Contact Merges in the first name and last name of the site contact of the event.
Site Contact First Merges in the first name only of the site contact.
Site Contact Last Merges in the last name only of the site contact.
Site Contact Title Merges in the title of the site contact of the event; e.g., “Owner,” “General Manager,"

etc. This is a quickpick list you can customize.
Site Contact Saluta-
tion

Merges in the salutation of the site contact of the event; e.g., “Tom,” “Mr. Smith,”
“Mrs. Johnson,” etc. Note: Salutations are generally created to come at the beginning
of a merge letter, between the word “Dear” and the comma.

Site Contact Tele-
phone

Merges in the specific telephone number belonging to the site contact of the event.
Note: This will likely be different from the general phone number belonging to the cus-
tomer.

Site Contact Fax Merges in the specific fax number belonging to the site contact of the event. See note
under Site Contact Salutation, above.

Site Contact Cel-
lular

Merges in the specific cell phone number belonging to the site contact of the event. See
note under Site Contact Salutation, above.

Site Contact Email Merges in the specific email address belonging to the site contact of the event. See
note under Site Contact Salutation, above.

Sales Rep Merges in the name of the sales representative who is attached to this event.
Sales Rep Tele-
phone

Merges in the telephone number associated with the sales representative who
is attached to this event.

Sales Rep Cellular Merges in the cellular phone number associated with the sales representative who
is attached to the selected event.

Sales Rep Email Merges in the specific e-mail address belonging to the sales representative of the selec-
ted event.

Event Category Merges in the category of the event, which is a customizable quickpick list you can use
to track your events. Note: This category is different from the Category associated
with the account. Each event might have its own category.

Event Theme Merges in the theme of the event.
Event Reference Merges in the reference of the event. Note: This reference is different from the Refer-

ence associated with the account. Each event might have its own reference, while the
Account Reference is entered into the account details, and indicates how this customer
originally heard of your company.

Event Pay Method Merges in the pay method of the event, as entered on the Miscellaneous tab in Event
Manager. Note: This is the general pay method of the event, not the pay method of an
individual payment.

Event Credit Card
Number

Merges in the Credit Card number that will be used to pay for the event.

Business Type Merges in the business type of the event, e.g., "Full Service, " "Delivery," etc. This is a
customizable quickpick list.

Operation Merges in the operation of the event. This is a quickpick list you can use to track mul-
tiple locations.
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Field Description
Event Number Merges in the event number automatically assigned to this event by the program.

Note:  You can establish a unique prefix for these numbers up to three-characters
long (through Administration > Settings> Global Settings).

PO Number Merges in the purchase order number for the event, if you have entered one.
Note: This field is not displayed on your screen by default, but you can easily add it to
your screen.

Folio Number Merges in the folio number (unique number identifying your account, for record-keep-
ing purposes) for the event. Note: This field is not displayed on your screen by
default, but you can easily add it to your screen.

Billing Client If you have entered alternative details in the Optional Billing Information tool in Event
Manager, this field will merge in that billing client’s name; if you have not, this field will
merge in the name of the customer holding the event.

Billing Address If you have entered alternative details in the Optional Billing Information tool in Event
Manager, this field will merge in that billing client’s address; if you have not, this field
will merge in the address of the customer holding the event.

Billing City If you have entered alternative details in the Optional Billing Information tool in Event
Manager, this field will merge in that billing client’s city; if you have not, this field will
merge in the city of the customer holding the event.

Billing St/Prov If you have entered alternative details in the Optional Billing Information tool in Event
Manager, this field will merge in that billing client’s state or province; if you have not,
this field will merge in the state or province of the customer holding the event.

Billing Postal If you have entered alternative details in the Optional Billing Information tool in Event
Manager, this field will merge in that billing client’s postal/ZIP code; if you have not,
this field will merge in the postal/ZIP code of the customer holding the event.

Booked Date Merges in the date on which this event was originally entered into Caterease. This date
is auto-matically assigned by the program, but you can edit the date, if necessary.

Booked Date For-
matted

Merges in the booked date, using formatting.

Revised Date/Time Merges in the date and time on which this event was last revised Caterease. This date
is automatically assigned by the program.

Adults Merges in the adult guest count of the event. Note: This field is not usually displayed
on your screen by default, but you can easily add it to your screen. You can rename
this field.

Children Merges in the children guest count of the event. Note: This field is not displayed on
your screen by default, but you can easily add it to your screen. You can rename this
field.

Loyalty Number Merges in the loyalty number associated with the event; usually defaults from the cli-
ent or con-tact person. Note: This field is not displayed on your screen by default, but
you can easily add it to your screen. You can rename this field.

Discount Comment Merges in the discount comment entered in the Comment field on the Event Discounts
window (Home > Tools > Default Discounts) in Event Manager.

Event Notes Merges in all text in the Event Notes text block, complete with rich-text formatting.
Event Notes
(Unformatted)

Merges in all text in the Event Notes text block, without any formatting (so it adopts the
format-ting of the merge document).

Allergy Alert Merges in all text in the Allergy Information text block (Home > Tools > Allergy
Information), complete with rich-text formatting.

Allergy Alert
(Unformatted)

Merges in all text in the Allergy Information text block (Home > Tools > Allergy
Information), without any formatting (so it adopts the format-ting of the merge doc-
ument).

Sub-Event Merge Fields

Use the following merge fields to pull information pertaining to the currently selected sub-event of a party
(the first sub-event is selected by default):
Note: To include information from multiple sub-events, use a sub-event merge table.
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Field Description
Description Merges in the description of the event’s first sub-event; e.g., “Dinner Buffet,” “Meeting,”

“Break-fast,” etc.
Type Merges in the type of the event’s first sub-event, e.g., "On Premise," Off Premise," etc.
Time: Start Merges in the start time of the event’s first sub-event.
Time: End Merges in the end time of the event’s first sub-event.
Time: Delivery Merges in the delivery time of the event’s first sub-event.
Time: Serving Merges in the serving time of the event’s first sub-event. Note:  You can rename this field

in Administration > General > Customize Names > Times.
Time: Bar Merges in the bar time of the event’s first sub-event. Note:  You can rename this field in

Administration > General > Customize Names > Times
Time: Arrival Merges in the arrival time of the event’s first sub-event. Note:  You can rename this field

in Administration > General > Customize Names > Times
Time: Departure Merges in the departure time of the event’s first sub-event. Note:  You can rename this

field in Administration > General > Customize Names > Times.
Time: NA These two fields represent two extra time fields that you can make up yourself. They will

each merge in the respective time information from the event’s first sub-event.
Time: Staff In Merges in the staff arrival time of the event's first sub-event. Note:  You can rename this

field in Administration > General > Customize Names > Times.
Time: Setup Merges in the setup time of the event’s first sub-event. Note:  This field, which displays

as Hours and Minutes (not as a time), is set up in Administration > New Booking
Defaults > Sub-Events.

Time: Tear Down Merges in the tear down time of the event’s first sub-event. Note:  This field, which is set
up in Administration > New Booking Defaults > Sub-Events, displays as Hours and
Minutes, not as a time.

Date Merges in the date of the event’s first sub-event.
Room Merges in the name of the room of the event’s first sub-event.
Room Chg Merges in the room charge of the event’s first sub-event.
Room Category Merges in the room category of the event's first sub-event.
Setup Style Merges in the setup style of the event’s first sub-event.
Site Name Merges in the name of the off-premise site location of the event’s first sub-event.
Site Address Merges in the address of the off-premise site location of the event’s first sub-event.
Site City Merges in the city of the off-premise site location of the event’s first sub-event.
Site St/Prov Merges in the state or province of the off-premise site location of the event’s first sub-

event.
Site Postal Merges in the postal/zip code of the off-premise site location of the event’s first sub-event.
Site Telephone Merges in the telephone number of the off-premise site location of the event’s first sub-

event.
Site Directions Merges in all text in the Directions text block of the event’s first sub-event, complete with

rich-text formatting.
Site Directions
(Unformatted)

Merges in all text in the Directions text block of the event’s first sub-event,without any
format-ting (so it adopts the formatting of the merge document).

Site Notes Merges in all text in theNotes text block of the Site Location Database (Setup
> Site Locations), complete with rich-text formatting.

Site Notes
(Unformatted)

Merges in all text in theNotes text block of the Site Location Database (Setup> Site
Locations) without any format-ting (so it adopts the formatting of the merge document).

Site Description Merges in all text in theDescription text block of the Site Location Database (Setup
> Site Locations), complete with rich-text formatting.

Site Description
(Unformatted)

Merges in all text in theDescription text block of the Site Location Database (Setup
> Site Locations) without any format-ting (so it adopts the formatting of the merge doc-
ument).

Site Category Merges in the name of the site category. This is a customizable quickpick list.
Site Website Merges in the website address of the off-premise site location of the event’s first sub-

event.
Setup Notes Merges in all text contained within the Setup Notes area of the event’s first sub-event,

complete with rich text for-matting.
Setup Notes
(Unformatted)

Merges in all text contained within the Setup Notes area, without any formatting (so it
adopts the formatting of the merge document).

Setup Person Merges in the name of the setup person. This is a customizable quickpick list.
Delivery Charge Merges in the delivery charge, if applicable,
Delivery Cat-
egory

Merges in the delivery category. This is a customizable quickpick list.
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Field Description
Delivery Person Merges in the name of the delivery person. This is a customizable quickpick list.
Delivery Notes Merges in all text contained within theDelivery Notes area of the event’s first sub-event,

complete with rich text for-matting.
Delivery Notes 
(Unformatted)

Merges in all text contained within theDelivery Notes area, without any formatting (so it
adopts the formatting of the merge document).

Comments Merges in all text on the Comments tab of the event’s first sub-event, complete with rich
text for-matting.

Comments
(Unformatted)

Merges in all text on the Comments tab of the event’s first sub-event,without any
formatting (so it adopts the formatting of the merge document).

Planned Guests Merges in the planned guest count of the event's first sub-event.
Actual Guests Merges in the actual guest count of the event's firstsub-event.
Guaranteed
Guests

Merges in the guaranteed guest count of event's first sub-event.

Sub-Event Num-
ber

Merges in the sub-event number of the event's first sub-event.

Staffing Merge Fields

Use the following merge fields to pull information pertaining to the staff working a party:
Note: The Staffing Merge Fields listed below are designed to be used to create e-mails that can be sent in batch
to several employees from the Staffing Activity Query results screen. Thus, each merge field merges data spe-
cific to one individual employee and one shift.

Field Description
Employee
Name

Merges in the first and last name of the employee.

Start Indicates the time this specific shift begins; can be set to default to any time associated with the
event, and can be edited when necessary.

End Indicates the time this specific shift ends; can be set to default to any time associated with the
event, and can be edited when necessary.

Position Indicates the specific shift or position needed for this sub-event (Waiter, Bartender, etc.).
Uniform Merges in the uniform the employee will wear when working a particular shift; offers a custom

quickpick list of choices.

Financial Merge Fields

Use the following merge fields to pull information pertaining to the finances of an event:

Field Description
Subtotal Merges in the subtotal for the entire event.
Gratuity Merges in the total gratuity for the entire event.
Service Charge Merges in the total service charge for the event.
Tax Merges in the total tax for the event.
Total Merges in the total of the event, including tax and service charge.
Paid Merges in the total amount paid to day for the event.
Balance Merges in the currently outstanding balance for the event.
Cost Merges in the total cost (to you) of the event; includes cumulative costs of menu items,

as well as staffing and any additional cost adjustments you might have made using the
Event Costing Sum-mary tool.

Profit Merges in the total profit for the event.
Discount Merges in the total discount that has been applied to the event using the Event Dis-
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Field Description
counts tool.

Value Merges in the Event Value based on parameters you can establish in your Global Set-
tings.

Next Deposit Merges in the amount of the next deposit scheduled for the event. Note: Deposits are
sched-uled using the Deposits Due tool in Event Manager.

Next Deposit Due
Date

Merges in the due date of the next deposit scheduled for the event (see note above).

Cost Per Guest Merges in the cost per guest for the event that is automatically calculated by dividing
the TOTAL of the event by the guest count.

Cost Per Guest
(from Subtotal)

Merges in the cost per guest automatically calculated by dividing the SUBTOTAL by the
guest count.

Cancel Charge Merges in the cancellation charge for the event, as entered into theMiscellaneous tab
in Event Manager.

Cancel Date Merges in the date on which the selected event was cancelled. This date is auto-
matically assigned by the program, but you can edit this, if necessary.

Room Chg Merges in the amount entered in the Room Charge field on the Venue tab of the Sub-
Event win-dow.

Delivery Charge Merges in the amount entered in the Delivery Charge field on theDelivery tab of the
Sub-Event window.

Food Subtotal Merges in the sum total of all menu items with a type of “Food” ordered for the entire
event.

Beverage Subtotal Merges in the sum total of all menu items with a type of “Beverage” ordered for the
entire event.

Liquor Subtotal Merges in the sum total of all menu items with a type of “Liquor” ordered for the entire
event.

Equipment Subtotal Merges in the sum total of all menu items with a type of “Equipment” ordered for the
entire event.

Labor Subtotal Merges in the sum total of all menu items with a type of “Labor” ordered for the entire
event.

Room Subtotal Merges in the sum total of all menu items with a type of “Room” ordered for the entire
event.

Other Subtotal Merges in the sum total of all menu items with a type of “Other” ordered for the entire
event.

Food Gratuity Merges in only the food gratuity for the event.
Beverage Gratuity Merges in only the beverage gratuity for the event.
Liquor Gratuity Merges in only the liquor gratuity for the event.
Equipment Gratuity Merges in only the equipment gratuity for the event.
Labor Gratuity Merges in only the labor gratuity for the event.
Room Gratuity Merges in only the room gratuity for the event.
Other Gratuity Merges in only the gratuity for items that have been established as "Other" in your

Default Tax & Service Charge Rates.
Food Service Charge Merges in only the food service charge for the event.
Beverage Service
Charge

Merges in only the beverage service charge for the event.

Liquor Service
Charge

Merges in only the liquor service charge for the event.

Equipment Service
Charge

Merges in only the equipment service charge for the event.

Labor Service
Charge

Merges in only the labor service charge for the event.

Room Service
Charge

Merges in only the room service charge for the event.

Other Service
Charge

Merges in only the service charge for items that have been established as "Other" in
your Default Tax & Service Charge Rates.

Food Tax Merges in only the food tax for the event.
Beverage Tax Merges in only the beverage tax for the event.
Liquor Tax Merges in only the liquor tax for the event.
Equipment Tax Merges in only the equipment tax for the event.
Labor Tax Merges in only the labor tax for the event.
Room Tax Merges in only the room tax for the event.
Other Tax Merges in only the tax for items that have been established as "Other" in your Default
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Field Description
Tax & Service Charge Rates.

Food Total Merges in only the food total for the event.
Beverage Total Merges in only the beverage total for the event.
Liquor Total Merges in only the liquor total for the event.
Equipment Total Merges in only the equipment total for the event.
Labor Total Merges in only the labor total for the event.
Room Total Merges in the room total for the event.
Other Total Merges in the total for items that have been established as "Other" in your Default Tax

& Service Charge Rates.
Taxes: First Merges in the total First Tax (from the first tax column) for the event. Note: Many com-

panies will only use this first column, and thus do not need this breakdown. Those com-
panies can simply use the “Tax” merge field, above.

Taxes: Second Merges in the total Second Tax (from the second tax column) for the event. See note
above.

Taxes: Third Merges in the total Third Tax (from the third tax column) for the event. See note above.

Sub-Event Financial Merge Fields

Use the following merge fields to pull information pertaining to the finances of a sub-event.

Field Description
Subtotal Merges in the subtotal for the sub-event.
Gratuity Merges in the total gratuity for sub-event.
Service Charge Merges in the total service charge for the sub-event.
Total Merges in the total of the sub-event, including tax and service charge.
Cost Per Guest Merges in the cost per guest for the sub-event that is automatically calculated by dividing the

TOTAL of the event by the guest count.
Cost Per Guest
(Subtotal)

Merges in the cost per guest automatically calculated by dividing the SUBTOTAL by the guest
count.

Proposal Merge Fields

Use the following merge fields to pull information pertaining to proposals created in Prospect Manager:

Field Description
Party Name Merges in the Party Name of the proposal.
Sales Rep Merges in the sales representative of the proposal.
Sales Rep Telephone Merges in the specific telephone number belonging to the sales representative of the

proposal.
Sales Rep Cellular Merges in the specific cell phone number belonging to the sales representative of the

proposal.
Sales Rep Email Merges in the specific e-mail address belonging to the sales representative of the pro-

posal.
Proposal Category Merges in the category of the proposal, which is a customizable quickpick list you can

use to track your prospects. Note: This field can be renamed.
Theme Merges in the theme of the proposal.
Reference Merges in the reference of the proposal.
Booking Contact Merges in the first name and last name of the booking contact of the proposal.
Booking Contact Title Merges in the title of the booking contact of the proposal; e.g., “Owner,” “General

Manager,” etc.
Booking Contact
Salutation

Merges in the salutation of the booking contact of the proposal; e.g., “Tom,” “Mr.
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Field Description
Smith,” “Mrs. Johnson,” etc. Note:  Salutations are generally created to come at the
beginning of a merge letter, between the word “Dear” and the comma.

Booking Contact Tele-
phone

Merges in the specific telephone number belonging to the booking contact associated
with the proposal.

Booking Contact
Email

Merges in the specific e-mail address belonging to the booking contact associated
with the proposal.

Planned Guests Merges in the planned guest count of the proposal.
Actual Guests Merges in the actual guest count of the proposal.
Date Merges in the date on which the proposed event would take place.
Start Time Merges in the start time established in the proposal.
End Time Merges in the end time established in the proposal.
Subtotal Merges in the subtotal established in the proposal.
Gratuity Merges in the gratuity established in the proposal.
Serv Charge Merges in the service charge established in the proposal.
Tax Merges in the tax established in the proposal.
Total Merges in the total established in the proposal.
Cost Per Guest Merges in the cost per guest for the proposal (automatically calculated by dividing

the TOTAL by the guest count).
Cost Per Guest (from
Subtotal)

Merges in the cost per guest for the proposal (automatically calculated by dividing
the SUBTOTAL by the guest count).

Notes Merges in all text in the Notes text block in Prospect Manager, complete with rich-text
formatting.

Notes (Unformatted) Merges in all text in the Notes text block in Prospect Manager, without any formatting
(so it adopts the format-ting of the merge document).

Comments Merges in all text on the Comments tab in Prospect Manager (Details area of the Pro-
posal), complete with rich-text formatting.

Comments (Unformat-
ted)

Merges in all text in the Comments tab in Prospect Manager (Details area of the Pro-
posal), without any formatting (so it adopts the format-ting of the merge document).

EmployeeMerge Fields

Use the following merge fields to pull information pertaining to your employees, as established in Employee
Manager:

Field Description
Name Merges in the first name and last name of the employee.
Last Merges in the last name only of the employee.
First Merges in the first name only of the employee.
Agency Merges in an Employment Agency. Note: This field is not displayed on your screen by

default, but you can easily add it to your screen.
Employee # Merges in the Employee #. This number is auto-assigned by Caterease. Note: You can

establish a unique prefix for these numbers up to three characters long (through
Administration > Settings > Global Settings > Managers).

Email Merges in the specific email address belonging to the employee for the selected event.
Home Address Merges in the employee's home address.
City, St/Prov
Postal

Merges in these three details of employee; meant to eliminate the need to select each
field separately when they are commonly used in combination (in letters and such).

Telephone Merges in the telephone number for the employee.
Cellular Merges in the cellular phone number for the employee.
Notes Merges in all text contained within the Notes area on the main screen in Employee Man-

ager, complete with rich text for-matting.
Notes (Unformat-
ted)

Merges in all text contained within the Notes area on the main screen in Employee Man-
ager, without any formatting (so it adopts the formatting of the merge document).
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GuestroomsMerge Fields

Use the following merge fields to pull information pertaining to group rooms contracts created in Guestrooms
Manager:

Field Description
Arrival Date Merges in the arrival date of the group rooms booking.
Departure Date Merges in the departure date of the group rooms booking.
Group Name Merges in the group name of the group rooms booking.
Status Merges in the status of the group rooms booking.
Booking Contact Merges in the first name and last name of the booking contact of the group rooms

booking.
Booking Contact Title Merges in the title of the booking contact of the group rooms booking; e.g., “Owner,”

“General Manager,” etc.
Booking Contact
Salutation

Merges in the salutation of the booking contact of the group rooms booking; e.g.,
“Tom,” “Mr. Smith,” “Mrs. Johnson,” etc. Note:  Salutations are generally created to
come at the beginning of a merge letter, between the word “Dear” and the comma.

Booking Contact Tele-
phone

Merges in the telephone number for the group rooms booking contact.

Booking Contact Cel-
lular

Merges in the cellular number for the group rooms booking contact.

Booking Contact
Email

Merges in the e-mail address for the group rooms booking contact.

Site Contact Merges in the first name and last name of the site contact of the group rooms book-
ing.

Site Contact Title Merges in the title of the site contact of the group rooms booking; e.g., “Owner,”
“General Man-ager,” etc.

Site Contact Saluta-
tion

Merges in the salutation of the site contact of the group rooms booking; e.g., “Tom”,
“Mr. Smith”, “Mrs. Johnson”, etc. Note:  Salutations are generally created to come at
the beginning of a merge letter, between the word “Dear” and the comma.

Site Contact Tele-
phone

Merges in the telephone number for the group rooms site contact.

Site Contact Cellular Merges in the cellular number for the group rooms site contact.
Site Contact Email Merges in the e-mail address for the group rooms site contact.
Sales Rep Merges in the sales representative of the group rooms booking.
Method of Reser-
vation

Merges in the method of reservation of the group rooms booking.

Reservation Cut-Off Merges in the reservation cut-off date of the group rooms booking.
Pay Method Merges in the payment method of the group rooms booking.
Contract Return Date Merges in the contract return date of the group rooms booking.
Log # Merges in the log # (automatically assigned by the program) of the group rooms

booking.
Folio # Merges in the folio # of the group rooms booking.
Room Count Merges in the total number of rooms blocked for the group rooms booking.
Tax Merges in the total taxes of the group rooms booking.
Total Merges in the total of the group rooms booking.
Next Deposit Merges in the amount of the next deposit due for the group rooms booking.
Next Deposit Due
Date

Merges in the due date of the next deposit due for the group rooms booking.

Notes Merges in all text in the Notes text block in Guestrooms Manager, complete with rich-
text formatting.

Notes (Unformatted) Merges in all text contained within the Notes area on the main screen in Guestrooms
Manager, without any formatting (so it adopts the formatting of the merge doc-
ument).

Comments Merges in all text on the Comments tab in Guestrooms Manager (Details area of the
Proposal), complete with rich-text formatting.

Comments (Unformat-
ted)

Merges in all text in the Comments tab in Guestrooms Manager, without any format-
ting (so it adopts the format-ting of the merge document).

- 359 -



Unit 23: Creating Merge Documents in Marketing Tools

User Defined Merge Fields

Use the following merge fields to pull information entered into your custom user-defined fields:

Field Description
Account User
Defined Fields

Lists all custom fields you may have created for your accounts (customers).

Event User Defined
Fields

Lists all custom fields you may have created for your events.

Sub-Event User
Defined Fields

Lists all custom fields you may have created for your sub-events (meals).

Site User Defined
Fields

Lists all custom fields you may have created for your site locations.

Proposal User
Defined Fields

Lists all custom fields you may have created for your proposals in Prospect Manager.

Guestrooms User
Defined Fields

Lists all custom fields you may have created for your group rooms bookings.

Special Merge Fields

Use the following merge fields to put miscellaneous information on your document:

Field Description
Current Date
(Long)

Merges in the current date, including day, in the format “Saturday, August 29, 2015.”

Current Date Merges in the current date, in the format “8/29/2015.”
Current Date For-
matted

Merges in the current date, which can be formatted as desired.

Current Time Merges in the current time, in the format “05:35 pm.”
Tax Exempt Merges in the words “Tax Exempt” if the event is tax exempt; if not, remains blank.
Exempt Number Merges in the word “Number:” followed by the event’s tax exempt number, if one exists;

if not, remains blank.
Current Date
& Time

Merges in the current date and time.
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Inserting a Table into a Document
Tip: As an altern-
ative, you can use
the Create Table tool
to "draw" a table by
dragging over the
desired number of
columns and rows.

1. Click the Setup sidebar on the left-hand side of your screen, and clickMar-
keting Tools.
Result: TheMarketing Tools window opens.
Note: As an option, you can click the Administration ribbon tab at the top of
your screen and choose Prints > Marketing Tools.

2. Select a document from the Documents list on the left-hand pane of the win-
dow.

3. Click into the document where you would like the table to be inserted.

4. Click the Tables button, located in the Home ribbon tab at the top of your screen, and choose Create
Table.
Result: The Insert Table window opens.

5. Create a table by setting the following options:

l Number of Columns
Set the number of columns you want to include in your table.
Note: Additional columns and rows can be added later, if necessary.

l Number of Rows
Set the number of rows you want to include in your table.

l Alignment
Select whether you want the table to appear on the left side of the page, in the center, or on the
right.
Note: If the width of your table is 100% (see "Width," below), then the table will take up the entire
width of the page.

l Border
Choose whether or not you want borders around the cells of your table.
Note: Borders can be removed after the table has been inserted, if necessary.

l Width
Set the width for your table as a percentage of the page you are placing it on.

6. When finished, click OK.
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Modifying a Table
1. Click into a cell or highlight multiple cells of a table.

2. Choose from the options described below, which are available in the Extended Text Editing group on
the Home ribbon tab at the top of your screen:

Symbol Description
Split Cell: (Found by clicking the Tables button) Splits the cell or cells you have highlighted in
half (i.e., splits each individual cell into two).
Combine Cells: (Found by clicking the Tables button) Combines the currently highlighted
cells into one cell. Note: To use, first highlight two or more cells in the table.
Insert Row: Inserts a row below the current cursor position.

Delete Row: Deletes the row where the cursor currently resides.

Insert Column: Inserts a column to the right of the current cursor position.

Delete Column: Deletes the column where the cursor currently resides.

3. The following options are found by clicking the Borders button :

Symbol Description
Left Borders: Adds borders to the left-hand side of the currently highlighted cell(s).

Right Borders: Adds borders to the right-hand side of the currently highlighted cell(s).

Top Borders: Adds borders across the top of the currently highlighted cell(s).

Bottom Borders: Adds borders across the bottom of the currently highlighted cell(s).

Switch Borders On: Adds borders to all sides of the currently highlighted cell(s).

Switch Borders Off:  Removes all borders from the currently highlighted cell(s).

Inner Borders: Adds inside borders (vertical and/or horizontal) to the currently highlighted
cell(s).
Outer Borders: Adds borders to the outside edges of the currently highlighted cell(s).
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Using Merge Tables to Insert Menu Items, Payments,
Etc.
In addition to inserting merge fields into a document, you can use "merge tables" to insert entire groups of
information, such as menu items, staffing, details of multiple sub-events, and more. You can even "nest" these
merge tables in the cells of other tables to arrange them neatly on the left- or right-hand side of a document.

Inserting a Merge Table into a Document
Tip: Merge tables
can be edited after
they have been cre-
ated, inserting addi-
tional fields, editing
filter rules, etc. See
"Editing an Existing
Merge Table."

1. Click the Setup sidebar on the left-hand side of your screen and clickMar-
keting Tools.
Result: TheMarketing Tools window opens.
Note: As an option, you can click the Administration ribbon tab at the top of
your screen and choose Prints > Marketing Tools.

2. Select a document from the Documents pane, located on the left-hand side of
your screen.

3. Click into the document where you would like the merge table to be inserted.

4. Click the Tools button, located in the Home ribbon tab at the top of your screen, and choose Insert
Merge Tables.
Result: A list of available merge table options displays.
Note: The settings on this window (field selections, options, and filters, discussed below, default from
the previous merge table you have created of this type.

Available Merge Tables

Merge Table Description
Food/Service Items Insert all menu items for the event, or choose to insert groups of menu

items based on item Type, Category, Prep Area, Vendor, or Hidden Status.
Proposal Items Insert all menu items selected for a proposal in Prospect Manager or option-

ally separate them based on item Type, Category, Prep Area, Vendor, or Hid-
den Status.
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Merge Table Description
Menu Items Insert all menu items listed in your default menus in Menu Manager, or

optionally separate them based on the menu they are in, or item Type, Cat-
egory, or Prep Area.

Ingredients This merge table produces a summary of similar ingredients, in which all
event ingredients have the same Item Name, Unit, Prep Area, Category,
Vendor, Comment, and Conversion.

Required Items Insert a summary of similar required items, in which all event required
items have the same Item Name, Unit, Category, Vendor, and Comment.

Payments Made Insert all payments made for the event, or choose to insert only payments of
a particular payment method.

Deposits Due Insert all future deposits due for this event, or choose to insert only those
deposits that have been paid or that remain unpaid.

Event Times Insert all Event times and timeline items for the event, or separate them
based on Category or Type.

Scheduled Items Insert all Scheduled Items for the event, or separate them based on Cat-
egory or Type. ("Items" can be changed to Tables, Lanes, etc.).

Shifts Insert all shifts scheduled for an event, or choose to insert groups of shifts
based on Position or Shift Category.

Staffing Insert all employees scheduled to work an event, or choose to insert groups
of staff based on Position, Staff Category, or whether they have confirmed
they will work the event.

Sub-Events Insert details from all sub-events, including times and venue details - or
choose to insert groups of sub-events based on sub-event Description or
Type.

Financial Summaries Insert summary totals of groups of menu items based on item Type or Cat-
egory, or general event financial totals such as the event Subtotal, Tax, Ser-
vice Charge, Gratuity, Total, Cost, Profit, etc.

5. Under Select Fields (the large white pane on the left side of the window), check into the checkboxes
next to any details you want to include in the document.
Note: "Unformatted" fields (Food/Service Item Descriptions, Sub-Event Comments, Sub-Event Site Dir-
ections) merge in text only (        without formatting), and inherit the rich-text formatting you apply here in
the document.
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6. [Optional] Hold your left mouse button down on any field you have selected in the Select Fields pane
and drag that field up or down in the list, to rearrange the order fields will appear in the print.

7. Under Display Options on the right-hand side of the window, select any or all of the following options:

l Show Header
Shows a header row across the top of the table, labeling each column you have chosen to include
("Description," "Price," "Qty," etc.).
Note: Optionally apply a background color to the header row using the color palette to the right of
the field.

l Insert at Bottom of Page
Inserts the table at the bottom-most line of your document, regardless of where your cursor cur-
rently resides.
Note: This may not necessarily be the bottom of the page; it's the lowest "carriage return" spot.

l Show Borders
Choose to show borders around each cell of the merge table - between each row and column.

l Show Filter Comment
Displays a comment below the merge table describing the specific filter you apply to this table (see
topic below).
Note: This comment will not print on the final document; it is visible in this design mode only.
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l Suppress Table When Empty
Suppresses the table from the printed document when it is empty, meaning that no empty table or
blank space will display when there are no items to merge.

l Odd/Even Data Rows
Displays data in Odd Row/Even Row format, in order to neatly separate/organize the displayed data.

l Group By Sub-Event (Food/Service Items, Shifts and Staffing Only)
When printed for an event with multiple sub-events, items in this table will be separated based on
the sub-event they belong to.

8. Under Filter Options on the lower right-hand side of the window, determine which specific items to
include in this table as described under "Merge Table Filter Options" at the bottom of this topic.
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Using Nested Tables to Arrange Information in a Docu-
ment
You can control the layout of a particular merge document using tables within tables, or “nested” tables. For
example, imagine you want to design a contract that shows food items on the left side of the print and bever-
age items on the right. You can accomplish this by creating a standard, two-column table to split the page in
half, and then inserting one merge table (for food items) in the left column and a second merge table (for
beverage items) in the column on the right.

1. Click into the document where you would like the nested tables to be inserted.

2. Click the Tables button, located in the Home ribbon tab at the top of your screen, and choose Create
Table.
Result: The Insert Table window opens.

3. Enter properties (number of rows/columns, borders, etc.), for a new table, and click OK.
Result: The table is inserted into the document at the current cursor location.
Important: Most often, tables used for nesting do not contain borders; they serve as "invisible" ways to
split the printed page. If you include borders here, refer to the important note on the following page
regarding how to remove them after you have nested your tables.

4. Click into a particular cell (left, right, first row, second row, etc.), of the new table.

5. Click the Tools button, located in the Home ribbon tab at the top of your screen, and choose Insert
Merge Tables.
Result: A list of available merge table options displays.
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6. Choose a specific type of merge table (Food/Service Items, Payments, Deposits, etc.), to insert.
Result: A confirmation message appears, informing you that you are inserting a "nested" merge table.

7. Click Yes to confirm.
Result: TheMerge Table window opens.

8. Establish merge table settings as explained in topics above.
Important: Be sure the merge table option Insert at the Bottom of Page is unchecked to properly nest
the table.

IMPORTANT: If you want to remove borders from the original table you added in Steps 4 & 5, above,
AFTER you have nested other tables, here's how to accomplish that:

1. Click BELOW the table and hold your left mouse button down.
2. Drag to a point ABOVE the table to highlight the original table (this will include the nested tables
within).
3. Click the Switch Borders Off button, located in the Extended Text Editing area in the Home ribbon
tab.
Result: This may remove all borders, including those in the nested table; you may therefore want to
highlight individual nested tables and switch borders back on as desired.
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In this section, you will learn:

Adding a NewMenu or Sub-Menu
Copying an Existing Menu

Adding Items to a Menu or Sub-Menu
Creating a Description, Label, Notes or Image for an Item

Editing AdditionalMenu Item Details
Creating an Automatic Menu Item Package
Making Changes to Menu Items in Batch
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Adding a New Menu or Sub-Menu
Tip: If you click on
the title of a "sub-
menu" before
adding a new menu
in Step 2, the new
menu will be added
on the same "sub-
menu" level. You can
also drag and drop
menu titles into dif-
ferent positions in
the title pane, option-
ally making them
sub-menus of other
menus. As you drag,
pay attention to your
mouse pointer for
the indicators
described below.

1. Access Menu Manager (Setup sidebar > MenuManager).
Result: TheMenu Manager window opens.
Note: As an option, you can click the Administration ribbon tab at the top of
your screen and chooseMenus > Menu Manager.

2. Click the Add New Menu button , located along the left pane of the window.
Result: A confirmation prompt appears.

3. Click Yes.
Result: A new menu is added to your menu list, with your cursor ready to type a new title.
Note: This button is identical to the Add Menu Item button at the top of the Menu Manager window
(as well as the Add Record button in the Home ribbon tab at the top of the screen); be careful not to
confuse them.

4. Type a name for your new menu, and then press your [Enter] key.
Result: Your new menu name is saved.

5. [Optional] Create a sub-menu of another menu by first selecting a title in the left pane of the window

and then clicking the Add Sub-Menu button .

6. Add new menus to your new menu as desired.
Note: It is recommended, when adding items to a new menu, that you take care to set the first item up
with the appropriate "Type,""Category," "Prep Area," etc., because each additional item you create will
mirror the first item in these settings.
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l Drop Above : Indicates that the menu you are dragging will be dropped above another menu.

l Drop Below : Indicates that the menu you are dragging will be dropped below another menu.

l Drop As Child : Indicates that the menu you are dragging will become a sub-menu of another
menu.
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Copying an Existing Menu
Tip: Once you copy a
menu, you can drag
and drop its title into
a different position
in the title pane,
optionally making it
a sub-menu of
another menu. As
you drag, pay atten-
tion to your mouse
pointer for the indic-
ators described
below.

1. On the left-hand side of the Menu Manager window, right-click on the title of
the menu you want to copy.
Result: A pop-up list of options appears.

2. Choose CopyMenu.
Result: A Copy Menu window opens, offering certain options.

3. Click into the checkbox next to any options you want to include in the copy, and then click OK.
Result: A copy of the menu is added to your menu list, with the cursor in the Title field, ready for you to
type a new title.
Note: Options include the choice to include ingredients or required items for items in the original menu,
as well as "sub-items" for any menu package items.

4. Type a name for the new copy, and then press your [Enter] key.
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Adding Items to a Menu or Sub-Menu
Tip: It is strongly
recommended that
you establish the
Item Type, Prep
Area, and Category
(as desired) appro-
priately for the first
item in a new menu
PRIOR to adding addi-
tional items. New
menu items default
this information
from the line that is
highlighted when
you click the Add
Record button.

1. Access Menu Manager (Setup sidebar > MenuManager).
Result: TheMenu Manager window opens.
Note: As an option, you can click the Administration ribbon tab at the top of
your screen and chooseMenus > Menu Manager.

2. In the left pane of Menu Manager, click on the title of the menu or sub-menu
you want to add an item to.
Note: Click the expand button to the left of a menu title to access its "sub-
menus."

3. Click the Add Menu Item button , located at the top of the Menu Man-
ager window.
Result: A new blank line is added to the bottom of this menu.
Note: This button is identical to the Add New Menu button near the left pane
of your Menu Manager, so take care not to confuse them. You can also use the Add Record button

in the Home ribbon tab at the top of your screen.

4. Type a Item Name for the new menu item into the Item Name field.
Note: As a default, Menu Manager uses the Item Name of your new item as its Description (see "Creat-
ing a Description ...," below). This allows you to include this text on your printed documents with any
font formatting you want.

5. Press your [Enter] key.
Result: Your cursor is moved one column to the right, most likely to the Price column.

6. Type a Price for the new item into the Price field.
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7. Press your [Tab] or [Enter] key.
Result: Your cursor is moved one column to the right, most likely to the Prep Area field.

8. [Optional] Enter a Prep Area for the item, by typing directly into the field or by choosing an option
from your quickpick list. "Prep Area" can be displayed on your custom prints and/or used to track your
menu items.
Note: This field offers a custom quickpick list you can customize. See the tip for important information
about setting defaults for these fields.

9. Press your [Tab] or [Enter] key.
Result: Your cursor is moved one column to the right, most likely to the Category column.

10. Enter a Category for the item, which can be displayed on your custom prints and/or used to track your
menu items.
Note: This field, too, offers options from a customizable quickpick list.

11. Press your [Tab] or [Enter] key.
Result: Your cursor is moved one column to the right, most likely to the Comment column.

12. [Optional] Enter a Comment for the item, which can optionally be displayed on your various custom
prints and reports, or choose an option from the drop-down quickpick list.

13. Click the down arrow next to the Item Type column (far right column) and choose an appropriate Item
Type for the menu item.
Note: Your available options, depending upon what you have set up, include Food, Beverage, Liquor,
Equipment, Labor, Room, Delivery, Floral, Beer, Wine, or Other.

Important: Each event might have different tax, service charge, or gratuity rates for each type of
menu item, so it is extremely important that the appropriate Item Type be chosen for each item. See
the tip for important information about default settings for this field.

14. See "Editing Additional Menu Item Details," below, for more information you can customize about this
item.
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Creating a Description, Label, Notes, or Image for an
Item

1. Click into the Description text box at the bottom of the Menu Manager window and type as desired.
Note: Descriptions can be included on custom prints in lieu of Item Names to allow for more detail and
more flexibility in font formatting. The Item Name of your new menu item will be entered here as a
default.

2. [Optional] Click on the Label, Notes, or Recipe tabs and enter text into the respective text boxes as
desired.
Note: Event Manager offers special prints for both menu item Labels and Recipes (or place cards for
buffet lines); "Notes" can be included on custom event prints.

3. [Optional] Use the font-formatting tools on the Home ribbon tab at the top of your screen to format
the text you have entered.

4. [Optional] Click on the Picture tab. Right-click within the text box and choose Load From File to browse
to an image to use for the menu item.
Note: Images can be included on custom event prints, if desired.
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Editing Additional Menu Item Details
Tip: If you want the
new columns you've
selected to be dis-
played in the Menu
Manager grid as a
default, click the
Save Current Win-
dow Settings but-
ton at the top right
of the window.

1. Click the Quick Column Customizing button , located at the top left of the
menu item grid in Menu Manager.
Result: A drop-down list of optional columns appears.
Note: See "Fields Available in the Menu Items Grid," below, for a list of available
columns for this grid.

2. Click into the checkbox next to any column heading to have that column appear
in the grid.
Result: Any columns with checks next to them appear in the grid.

Note: The Automatically Set Column Widths button on the top right-hand side of the Menu Man-
ager window is selected by default, meaning that any selected columns will automatically shrink to fit in
this window without the need to scroll horizontally.

3. [Optional] Hold your left mouse button down on a column heading in the list and drag up and down to
reposition that column in the grid.
Note: You can also drag column headings left and right in the grid itself.

4. Enter information into the new fields as outlined in "Fields Available in the Menu Items Grid," below.
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Fields Available in the Menu Items Grid
The following fields are available for display in the menu item grid in Menu Manager:

Field Description
Item
Name*

Identifies the menu item; can be printed on event prints in lieu of or in addition to description (see
below).

Cost Indicates the cost of the menu item; can be directly typed into the field, or can be automatically
calculated as a sum of ingredient item costs.

Markup Multiplies times the item cost (above) to automatically calculate the Price (below); a "10%"
markup would be entered as "1.1" (Cost X 1.1 = Price).

Price* Indicates the price of the menu item.
No Tax Offers a checkbox to make the menu item non-taxable as a default.
No SC Offers a checkbox to remove service charge from the menu item as a default.
No Grat Offers a checkbox to allow you to make this individual item exempt from any gratuity normally

assigned to items of this Type.
Prep
Area*

Indicates the area or personnel responsible for preparing the menu item; e.g., “Kitchen,”, “Bar,”
“Cold Prep”; can be used for tracking purposes or optionally included on prints; event menus are
separated based on this field on the Production Sheet event sub-print.

Category* Allows you to categorize menu items for tracking purposes; offers a customiz-able quickpick list of
options, while "Type" (see below) is a hard-coded field (e.g., items with a Type of "Liquor" can be
separated into categories of "Beer,""Wine,""Liquor,"etc.); can be optionally included on custom
prints.

Comment* Allows up to 50 characters of general comment about a menu item; can be optionally included on
prints.

Menu Title Lists the title of the menu the item is located in; helpful when reviewing all items from all menus
simultaneously.

Hide Offers a checkbox allowing you to hide this menu item by default on event prints that are set to
allow item hiding; achieves the purpose of “passing notes” to the kitchen or other back-of-house
staff.

Inactive Designates this item as being temporarily inactive; it will appear grayed out here in Menu Man-
ager, and will not be visible at all when selecting items for an event.

Default
Qty

Allows you to establish a default quantity for the item when pulled into an event; can be used in
conjunction with "Linked" below to calculate a quantity per guest (e.g., a Default Quantity of "3"
for each guest attending the event").

Linked Offers a checkbox allowing you to link the quantity of this menu item to the guest count of an
event as a default.

Rounding Used in conjunction with the two options above to avoid partial quantities; e.g., a pastry with the
Default Quantity of "1.5" which is also Linked to the guest count for a party of 25, will default a
quantity of "37.5" pastries. In this case you might round it "Up."

Min Qty Allows you to establish a minimum quantity for an item when it is selected into an event.
Delivery Offers a checkbox allowing you to designate a menu item as deliverable as a default; items must

have this box checked to appear on delivery prints and reports.
Acct Code Offers a unique identifier for the menu item; used in interfaces with third-party software.
Item ID Offers a unique identifier for the menu item; used in interfaces with third-party software.
Vendor Identifies a vendor responsible for providing the menu item.
Inventory Offers a checkbox for you to designate a menu item as inventoried.
Inv Min Allows you to establish a minimum quantity for an item in inventory when it is selected into an

event.
Rental Offers a checkbox for you to designate an item (such as AV Equipment, Chairs, Tables, etc.), as

rental items.
Servings Allows you to designate the number of servings for a particular menu item.
URL Allows you to enter a website address.
Item Unit Allows you to track a unit of purchase for each item and its associated unit.
Packing
Unit

This field relates to Required Items. Allows you to tracking the quantity of the packing unit and its
associated unit.

Qty/Unit This field relates to Required Items/Packing Unit, above. Pertains to how many items (or servings)
a packing unit can hold.

Unit
Rounding

This field relates to Required Items/Packing Unit, above. Pertains to how you would like the
Qty/Unit to be rounded.
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Field Description
Bar Code You can enter a bar code number into this field. Bar codes can be printed as part of any contract,

and will print in classic bar code format. Additionally, bar code labels can be generated from the
Food/Service Activity Query.

Required
Item

Allows you to designate a food/service item as "required."

Type* Allows you to categorize items as being "Food,""Beverage,""Liquor,""Equipment,""Labor,""Room"
or "Other"; list is hard-coded; THIS DETAIL IS IMPERATIVE, AS IT DETERMINES TAX, SERVICE
CHARGE AND GRATUITY RATES FOR INDIVIDUAL ITEMS.

Usage Var An item's Usage is the number of the particular item that was booked in any active event.
Booked Allows you to track a day or date range on which a particular menu item was booked.
Revised Allows you to track a day or date range on which a particular menu item was booked.
User
Defined
Fields

You can make up your own custom fields pertaining to menu items and display them in this grid
as well.

* Displayed on the grid by default.
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Creating an Automatic Menu Item Package
If you have menu items you often sell together, you can combine them into a menu "package." This way, you
simply select the package itself, and Caterease will automatically locate and compile all of the various items in
their separate menus.

Adding Package Items to a Menu Item

1. Access Menu Manager (Setup sidebar > MenuManager).
Result: TheMenu Manager window opens.
Note: As an option, you can click the Administration ribbon tab at the top of your screen and choose
Menus > Menu Manager.

2. Select the menu item you want to use as your package, or add a new item.
Note: You must first choose an item to act as your package, then connect associated items to it.

3. Click on the Package Items tab, located toward the bottom of the Menu Manager.

4. Click the Select Items button , located at the right-hand side of the Package Items grid.
Result: The Select Menu Items For Current Event window opens.

5. In the left pane of the Select Menu Items For Current Event window, click on the title of a menu where
your package items are stored.

6. Highlight and select items in one of the following ways:
Note: All selected items will be inserted at the bottom of the Package Items grid by default, but can be
dragged and dropped to any position.
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l Double-click a single item.
Result: That item is inserted into the Package Items grid, and the Select Menu Items For Current
Event window remains open.

l Hold your mouse button down on one individual item (without moving) and drag that item from the
Select Menu Items For Current Event window into the Package Items grid.
Result: The item is inserted into the Package Items grid.

l Select a group of items by dragging over them, or using your [Shift] or [Ctrl] keys, and then hold
your left mouse button down and drag and drop them into the Package Items grid.
Result: The items are inserted into the Package Items grid.

l Click the Select Items button at the top left of the Select Menu Items For Current Event window.
Result: Any highlighted items are inserted into the Package Items grid, and the Select Menu Items
window For Current Event window remains open.

l Click OK.
Result: Any highlighted items are inserted in the Package Items grid, and the Select Menu Items For
Current Event window closes.

7. [Optional] Add or remove a price to be associated with the package item by typing into the Price
column.
Note: This price will be retrieved with the package when it is selected into an event, and will default to
the price applied when the package item was added to your menus.

8. Press your [Tab] or [Enter] key to move to the next field, most likely the Selection Comment field.

9. [Optional] Enter a Selection Comment for your package items.
Note: This comment can be used as a hint when selecting items for an event; examples might include
"Package Portion," "Per Person," etc.
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Making Changes to Menu Items in Batch
You can make changes to multiple menu items in your default menus simultaneously. Change such details as
menu Item Type, Category, whether the item is published to your online ordering website, whether an item is
inventoried, or a host of other options - including basic font formatting of menu item Descriptions, Recipes,
Labels or Notes.

Batch Processing Menu Items

1. In the left pane of the Menu Manager window, click the title of the menu containing items you want to
edit (or click All Menus to select items from multiple menus simultaneously).

2. In the main pane of the window, select multiple items by either holding your [Shift] key down to select
a group of contiguous items or by holding your [Ctrl] key down to select individual items.

3. Click your right mouse button over any one of the selected items.
Result: A pop-up menu of options appears.
Note: If you right-click on an item that's not currently selected, all selected items become deselected.

4. Choose Special Editing > Batch Processing.
Result: The Batch Processing window opens.
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5. On the General tab of the Batch Processing window, click into the checkbox next to any field you would
like to change for all of your selected menu items.

6. In the field itself, enter the new value you would like for all selected menu items.
Note: Most fields have for your convenience. Some, such as No Tax, No SC, Linked, Hide, etc., have
checkboxes that you can enable or disable for all selected menu items.

7. [Optional] Click the Formatting tab and establish formatting changes (font style, font size, and align-
ment), then click into the checkboxes at the bottom of the tab to indicate which detail of all selected
menu items you want reformatted (Description, Instructions, Label, or Notes).

8. When finished, click OK.
Result: Your changes are applied to all selected menu items and a confirmation message appears.
Note: Depending on the number of changes/items, this process could take a few minutes.

9. Click OK to close the confirmation message window.
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In this section, you will learn:

Enabling System Security
Adding a NewUser

Establishing User Security Settings
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Enabling System Security
It is recommended that you enable system security, which will require users to login to the program. Although
the most common use of this tool is to establish specific user access settings, it also allows Caterease to track
changes made and tasks performed by each individual user.

Enabling System Security
Tip:With security
now enabled, each
user will be required
to login when open-
ing the program.

1. Click the Administration ribbon tab at the top of your screen and choose Secur-
ity.
Result: The Caterease Security window opens.

2. Click into the checkbox next to Enable System Security at the top left of the
window.

3. Click on the Users tab, and then double-click on the Default Administrator's User Name.
Result: The User Security Details window opens.

4. Click the Assign Password button to the right of the Main Password field.
Result: A confirmation message appears.
Note: If the main password is already assigned, you can skip to Step 10, below.

5. Click Yes at the prompt to confirm your choice.
Result: The User Password window opens, prompting you to create your password and type it a second
time to confirm.
Note: If there is already a main password assigned, you will need to enter that password now to con-
tinue.
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6. Carefully type a password to serve as your main system (administrative) password (minimum of four
characters, not case-sensitive).

7. Press your [Tab] key.
Result: Your cursor moves to the next field, labeled Again, for you to retype the password for veri-
fication.

8. Retype the password to verify.

9. Click OK, or press [Enter].
Result: The User Password window closes, saving your new password.

10. [Optional] Click on the Notes tab, located at the bottom of the window, and type any desired notes into
the Notes text box.

11. [Optional] Click on the Pictures tab, located at the bottom of the window. Right-click within the text
box and choose Load From File to include a digital image of the administrator.
Note: This picture will appear next to any instant messages sent from this user in Caterease.
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12. Click on the Security tab, located on the left-hand side of the User Security Details window, and estab-
lish security settings for the user.

13. Click OK to close the User Security Details window.

14. [Optional] Click into the checkboxes next to any of the options to enable or disable features.

15. Click OK to close the window.
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Adding a New User
1. Click the Administration ribbon tab at the top of your screen and choose Security.

Result: The Caterease Security window opens.

2. Verify that Enable System Security (top left of the window) is selected.
Note: Users will not be required to log into Caterease if this option is not selected.

3. Click on the Users tab, located on the left-hand side of the window.
Result: A list of currently established users displays.

4. Click the Add User button on the right -hand side of the window.
Result: The User Security Details window opens.
Note: By default, every new user you add is a member of the user group "Caterease Users," and there-
fore automatically inherits the permissions established in that group. Any setting listed with a red font
indicates a setting that is disabled for this user because of a group (such as "Caterease Users) he
belongs to.

5. Enter a User Name for the new user into the User Name field.
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6. Click the ellipsis button , located on the right-hand side of the Password field, to assign a password
to the user.
Result: A confirmation message appears.

7. Click Yes to confirm.

8. Enter a password for the user.
Note: Passwords must be a minimum of four characters, numbers and/or letters, and they are not
case-sensitive.

9. Enter the same password into the field labeled Again for verification.

10. Click OK.
Result: The password has been assigned to this user.

11. [Optional] Click into the Active Directory Name field and enter the username this user uses to log into
Windows (or Citrix, for Caterease Connect).
Note: Users with Active Directory names will not need to log into Caterease separately; after they log
into Windows (or Citrix), they will be automatically recognized when loading Caterease and their spe-
cific program permissions will be established. (See "Using Active Directory" for more information.)

12. Enter the user's contact information into the contact fields: Telephone, Cellular, Email.

13. [Optional] Click into the checkbox labeled Is a Sales Rep and enter a Sales Rep Name if you would like
this user's name included on the program's list of Sales Representatives.
Note: You can also choose a color to be associated with this sales rep when color-coding within the pro-
gram.

14. [Optional] Click into the Notes text box and enter any notes pertinent to this user or his program
access level.

15. [Optional] Click on the Picture tab. Click into the Picture text box to load a picture of this user (for use
in user-to-user messaging within the program).
Note: Load an image by right-clicking within the Picture tab area and choosing Load From File.

16. Click on the Security tab on the left-hand side of User Security Details window and establish security set-
tings for the user.
Note: See topics below for more information.

17. [Optional] Click on the Groups tab and select the security groups to which this user belongs.
Note: See topic below for more information. You can also select users into groups, as opposed to
selecting groups for users.
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Establishing User Security Settings
1. From the Caterease Security window, double-click on a user's name to open the User Security Details

window.
Result: The User Security Details window opens.

2. Click on the Security tab, located on the left-hand side of the window.

3. If necessary, click the expand button next to any group of settings to open that group.

4. Click into the checkbox next to any security setting to establish permissions, using the following
guidelines:

l Yellow Dash
This indicates that a user's group settings take priority. In other words, if a group that the user
belongs to prohibits this function, then the user will be prohibited.

l Green Check
This indicates that the user's personal settings specifically allow a function. Even if the user belongs
to a group which prohibits the function, he will nonetheless be permitted based on this setting.

l Red X
This indicates that a user's personal settings specifically prohibit a function. Even if the user belongs
to a group that allows the function, he will nonetheless be prohibited based on this setting.

5. When finished, click OK to close the window and save the changes.
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In this section, you will learn:

Adding a Master List of Setup Styles
Adding Banquet Rooms

Establishing Setup Styles and Capacities for a Room
Establishing Breakout Rooms for a Room

Entering Site Locations into the Site Locations Database
Displaying Additional Site Location Fields
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Adding a Master List of Setup Styles
1. Click the Administration ribbon tab at the top of the screen.

2. Click Venues > Setup Styles.
Result: The Setup Style Details window opens.

3. At the top right of the Setup Style Details window, click the Add New Setup Style button .
Result: A new blank line is added to your list of setup styles.

4. Type a name for the new setup style.

5. [Optional] Click into the text box at the bottom of the Setup Styles Details window, and type any Notes
that pertain to your new setup style.
Note: These notes do not print anywhere, and serve only as an on-screen reference.

6. [Optional] Click on the Picture tab at the bottom of the window and right-click into the text box to load
a digital image of the setup style.

7. Repeat steps 3 through 6 as necessary to add further setup styles.
Note: If you are using the Social Tables or Room Viewer interface to diagram your banquet rooms, you

might consider using the Add Social Tables or Add Room Viewer Setup Styles button in Step
3, above. These buttons populates the setup style list with styles Social Tables/Room Viewer will recog-
nize, so banquet rooms can be automatically set up for you in that third-party program.

- 395 -



Unit 26: Setting Up Banquet Rooms and Site Locations

Adding Banquet Rooms
1. Click the Administration ribbon tab at the top of the screen and choose Venues > Banquet Rooms

Setup.
Result: The Banquet Rooms Setup window opens.

2. In the left pane of the window, select the location you want to add a new room to or create a new one
as described above.

3. At the top center of the window, click the Add Room button .
Result: A new blank line is added to your list of room names.
Note: This button is identical to the Add Location button next to it. Be careful to choose the correct one.

4. Type a name for your new room.
Note: If you change the name of an existing room, you will be prompted if this will affect any existing
events.

5. [Optional] Click the ellipsis button to the right of the room name and enter the optional details lis-
ted in the table below.

Note: As an option, you can click theQuick Column Customizing button at the top left of this list of
rooms to have most of these additional details display as columns in the list.

6. Add appropriate setup styles, guest capacities, and breakout rooms as described below.
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Available Fields

Field Description
Room Identifies the name of the banquet room.
Room
Category

Can be used to track a banquet room (e.g., "Ballroom," "Meeting Space," etc.). Click the down arrow
to select from the custom quickpick list.

Room
Chg

Will be automatically retrieved into an event with this room, and can be overridden on-the-fly within
the event.

Room
Size

Indicates the square footage of a room; used for on screen reference only.

Color Will act as the background color for this room when viewed in the Event Scheduler; if no color is
chosen, the program will automatically assign light pastels for your various rooms.

Diagram Links this room to its default diagram when interfacing with Room Viewer or Social Tables software.
If you have not created any diagrams using your room diagramming software, this drop- down list
will be empty.

Notes Notes in this text box (bottom of screen) can be used for on-screen reference only, and do not print
on any Caterease prints.

Picture Right-click anywhere inside the Picture text box and browse to load a digital image of a room.

- 397 -



Unit 26: Setting Up Banquet Rooms and Site Locations

Establishing Setup Styles and Capacities for a Room
1. In the left pane of the Banquet Rooms Setup window, click on a banquet room to select it.

2. At the top right of the display (in the Setup Styles area), click the Select Setup Style button .
Result: The Select Setup Styles window opens.
Note: You can customize this list. See "Adding a Master List of Setup Styles," above, for more inform-
ation.

3. Highlight any setup style(s) that apply to the selected room.
Note: Select multiple setup styles on the list by holding your left mouse button down and dragging over
any number of styles, or by holding your control [Ctrl] key down and clicking on as many styles as you
wish.

4. Click the Select button at the top left of the Select Setup Styles window to add the highlighted setup
styles to your banquet room.
Result: The highlighted setup styles are added to the Setup Styles pane of the window.
Note: As an option, you can double-click on any individual setup style in the Select Setup Styles window
to select it. Also, you can "drag and drop" - selecting one or more setup styles, holding your left mouse
button down, dragging them to the Banquet Rooms Setup window and then releasing the mouse but-
ton.

5. Click into the Capacity column beside each setup style (in the Banquet Rooms Setup window) and type
a maximum capacity for that style in the currently selected room.
Note: If you prefer, you can click the down arrow at the right of the Capacity column and use the avail-
able calculator to determine a maximum capacity.
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6. Click another banquet room name and repeat Steps 3-5 as desired to add setup styles and capacities to
other rooms.

7. When finished, click the at the top right of the Select Setup Styles window to close it.
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Establishing Breakout Rooms for a Room
1. In the left pane of the Banquet Rooms Setup window, click a banquet room to select it.

2. At the lower right of the display (in the Breakout Rooms area), click the Select New Breakout Room(s)

button .
Result: The Select Breakout Rooms window opens.

3. Highlight any banquet room(s) that are "breakouts" of the selected room. (For example, if you have
"Ballroom ABC," then its breakout rooms might be "Ballroom A," "Ballroom B," "Ballroom C," "Ballroom
A-B," and "Ballroom B-C" (all possible rooms that can be formed by "breaking" the large ballroom
apart).
Note: Select multiple rooms on the list by holding your left mouse button down and dragging over any
number of rooms, or by holding your [Ctrl] key down and clicking on as many rooms as you wish.

4. Click the Select button at the top left of the Select Breakout Rooms window to add the highlighted
breakout rooms to your selected room.
Result: The highlighted room names are added to the Breakout Rooms pane.
Note: As an option, you can double-click on any individual room in the Select Breakout Rooms window
to select it. Also, you can "drag and drop" - selecting one or more breakout rooms, holding your left
mouse button down, dragging them to the Banquet Rooms Setup window and then releasing the mouse
button.

5. Click another banquet room name and repeat Steps 3-4 as desired to add breakout rooms to other
rooms.

6. When finished, click the at the top right of the Select Breakout Rooms window to close it.
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Blocking Banquet Rooms
The steps below show how you can block banquet rooms at your company (for staff meetings, room cleanings,
etc.), without actually booking events.

Note: You can also close your entire business on a specific date - or limit the number of events you can book -
using the Restrict Events feature.

Creating a New Room Blocking

1. Click the Administration ribbon tab at the top of the screen.

2. Click Venues > Banquet Rooms Blocking.
Result: The Banquet Room Blocking Summary window opens.

3. Click the Add New Room Blocking button , located on the upper right-hand side of the window.
Result: The Banquet Room Blocking Details window opens.
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4. Choose Day of Week and select a specific day to have the room blocking recur every week on that day,
or choose Specific Date and enter or select a date for a one-time blocking.

5. [Optional] If you are creating a Day of Week blocking, click into the checkbox labeled Range and
choose a Start Date and Finish Date of the blocking.

6. Choose All Day if you want the room to be blocked for the entire day, or choose Within Times and
enter a From and To time to block the room for a specific time range.

7. Choose All Rooms to block your entire facility for the day, or choose Specific Room and select a room
from the list to block one room only.

8. [Optional] Enter a comment in the Comments field to describe this blocking.
Note: This comment will be displayed on your venue graph in the Scheduler along with the blocking.

9. [Optional] Click the down arrow next to Color and select a color for this room blocking to appear in on
your venue graph.
Note: The color will default to white; you can also click the ellipsis button to the right of the Color
field and create a custom color.

10. Click OK to close the Banquet Rooms Blocking Details window.

11. Click OK to close the Banquet Rooms Blocking Summary window.
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Establishing Daily Event Limits
Perhaps your company has a policy that it only does one off-premise party per day. Or, perhaps you limit the
number of events you hold each day with a certain theme. Or, maybe you just have a fixed limit - you can only
do so many events per day. In any case, you can set these limits easily and let Caterease keep track of it all for
you.

Limiting the Daily Number of Events

1. Click the Administration ribbon tab at the top of your screen and selectOptions.

2. Click Restrict Events.
Result: The Limit Events window opens.

3. Click into the checkbox labeled Limit Daily # Of Events, located on the Limit Daily # tab.

4. Select an option under Limit By ... .
Result: With any choice other than All Events, the quickpick list that corresponds to your choice is dis-
played on the right-hand side of the window.
Note: If you select All Events, simply enter a daily maximum number by clicking into the field and typ-
ing or using the up-and-down arrows to adjust the number.
Important Note: A zero value in the Max # field means there is no limit to the number of daily events.

5. Click into each row on the right-hand side of the window and enter a maximum number (Max #) for
each selection.
Note: Skip this step if you chose All Events in Step 4, above.

6. When finished, click OK.
Result: The Limit Events window closes, saving your changes.
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Setting Closed-For-Business Dates
Tip: Click the
View/Edit Current
Closed Datebutton
to edit the closed
dates; click the Pre-
view Comments
button to be able to
view the comments
from the Limit
Events screen
without having to
open the Details win-
dow.

1. Click the Administration ribbon tab at the top of your screen and select
Options.

2. Click Restrict Events.
Result: The Limit Events window opens.

3. Click the Closed Dates tab.

4. Click the Add Record button , located on the upper right-hand side of the
window.
Result: The Closed Date Details window opens.

5. Click the radio button to the left of Day of Week if you would like to indicate unavailability for a certain
day of the week, and choose the desired day from the drop-down list at the right-hand side of the win-
dow.
Result: The Range option becomes available. Click into the Range checkbox. Access the drop-down cal-
endar tool to the right of the Start and Finish fields to set a closed-for-business date range.

6. If you did not choose Day of Week, click the radio button to the left of Specific Date and access the
drop-down calendar to the right of the field to select one specific closed-for-business date.
Note: "Range" is unavailable if Specific Date is selected.
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7. [Optional] Type a reason for the closure into the Reason field.

8. [Optional] Type a comment for the closure into the Comment text box.

9. When finished, click OK.
Result: The Closed Date Details window closes, and the user will be prompted if he/she attempts to book
an event in Event Manager on a day designated as "Closed."
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Entering Site Locations into the Site Locations Database
In order to select site locations for each of your off-premise locations, you must first create a master list of site
locations from which to choose.

Adding a New Site Location

1. Click the Setup sidebar on the left-hand side of your screen, and click Site Locations.
Result: The Site Location Database window opens.
Note: As an option, you can click the Administration ribbon tab at the top of your screen and choose
Venues > Site Location Database.

2. In the Home ribbon tab at the top of your screen, click the Add Record button .
Result: A confirmation prompt appears.

3. Click Yes.
Result: A New Site Location field is added to the list, with your cursor ready to type a new name.

4. Type a name for your new site location, and press your [Enter] key.
Result: Your cursor moves the next field (Address).

5. Continue to enter additional information into each field, using your [Enter] key to move from one field
to the next.
Note: See "Entering Advanced Information," below, for information about additional site location
details.

6. [Optional] Click your right mouse button anywhere in the Picture text box and choose Load From File
to associate a digital image with this site location.
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7. [Optional] Click on the Description tab at the top right of the window and enter a brief description of
this location into the text box (this information is used as on-screen reference only).

8. [Optional] Click on the Notes tab at the bottom of the window and enter some general notes about the
location into the text box (this information is used as on-screen reference only).

9. Click on the Directions tab at the bottom of the window and enter directions to the location into the
text box.
Note: These directions will default for each even using this site location, and can be included on event
prints.

10. Click the Required Items tab to associate any required items with the selected site location.

11. Repeat Steps 2-10 as desired to add additional site locations.
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Displaying an Additional Field
Tip: As an altern-
ative, you could drag
and drop the field
beneath another
field on the in the
left ("Layout Tree
View") frame of the
customize window to
have it appear below
that field on the
screen.

1. On the Site Location Database window, click your right mouse button over one
of the field names in the General area and choose Customize.
Result: The Customize window opens.
Note: Do not right-click inside of fields, but rather on the tab form itself. You
can also right-click elsewhere in the window, excluding within text blocks or
within the detail grid at the left.

2. On the right-hand side of the Customize window, hold your left mouse button
down on one of the available fields.
Note: See "Available Site Location Fields" (below) for details about such fields as
Tax Name, Delivery Charge, Base Price Markup, and Inactive.

3. Drag the field into the General area of the Site Locations Database window, and place it beneath one of
the existing fields.
Note: It is important to note your cursor's position as you drag this field, as it will be easier to place this
field beneath another field rather than to the right of a field. If you make a mistake, click the Undo but-

ton at the top left of the Customize window and try again.

4. Once the field is in the desired position on the window, release your mouse button.
Result: The new field has been placed on the window.

5. Repeat Steps 2-4 as desired to add other fields to the window, or click Close on the Customize window
to close the window.

6. Click the Save Current Window Settings button at the top right of the Site Locations Database win-
dow to save this arrangement as the new default look for that window.
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Advanced Fields Available on the Site Locations DatabaseWindow

In addition to the general site information ("Name," "Address," "City," etc.), shown by default, the following
fields are also available for display on the Site Locations Database window:

Field Description
Tax
Name*

Allows you to choose a unique tax/service charge schedule (see "Creating Multiple Tax Schedules"
under Establishing Default Tax Rates) to apply to this location, to be used as a default for each new
event using this location.

Delivery
Charge

Lets you enter a default delivery charge to be pulled into events automatically when this site location
is used.

Base
Price
Markup

Allows you to select from your default list of markup schedules to have a specific price markup apply
to each new event that uses this location.

Inactive Allows you to designate (by clicking into a checkbox) this location as temporarily inactive, so it will
not be an option to select into new events (removing the check will cause the location to become "act-
ive" again).

Site ID Lets you enter a site ID as a unique identifier.
* Displayed on the screen by default.
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In this section, you will learn:

Enabling Tablet View
Setting Up the Tablet View
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Using the Tablet View
If you are using Caterease on a tablet or even a small laptop screen, you might want to try our “Tablet View” to
make the most of your limited screen real estate.

1. Click the Display ribbon tab at the top of your Caterease screen.

2. Choose the Tablet option on the far right-hand side.
Result: Instantly, ribbon tabs are condensed to save space.

3. Click the down arrow to the right of the Navigation Bar field at the top left-hand side of your screen.
Result: A drop-down menu opens.

4. Choose to move the Navigation Bar to the left side or the right side of the screen. Remove the Nav-
igation Bar from the screen altogether by choosing None.

5. Click the down arrow to the right of the Windows Tabs field at the top of the screen.
Result: A drop-down menu opens.

6. Choose to move the Windows Tabs to the top, bottom, or right side of the screen. Remove the Window
Tabs from the screen altogether by choosing None.

7. Click the Status Bar button at the top of the screen to make the status bar disappear or reappear.
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8. Open various Managers and tools by clicking the Select ribbon tab at the top of your Caterease screen
and choosing either the Select button or the Basic button.
Result: The Select drop-down menu lists the various managers, the EventWizard, and the Scheduler
tools. The Basic drop-down menu gives you access to various queries.

9. Control the Customizable Quick Access Toolbar by clicking the More Buttons button at the top left-
hand side of your screen.
Result: A drop-down menu with options appears.

10. Choose to show the quick-click icons for Event Manager, Account Manager, or the EventWizard. You
can also choose Minimize the Ribbon to increase screen space even more.

11. Once you open a window, click the Windows ribbon tab.

12. Click the Perfect Fit button , located on the left-hand side of your screen, to stretch the window
out as large as it can be, to facilitate easier use on a tablet or other small screen.
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13. After you have finished configuring your new settings, save them by clicking the Save Current Windows

Settings button to the left of the Windows button.

14. Exit out of all windows, and then click the Windows ribbon tab. Click the Save Current Windows Set-

tings button so the desktop defaults to this tablet view.
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